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INTRODUCTION 

Ventura Publisher for. Windows provides desktop publishing tools that 
are powerful, fast and flexible. 

In the past, documents were normally published using a process that 
began with typing the text. After the text was proofed and edited into its 
final form, it was taken to a photo-typesetting machine where the words 
were given a fancy typeset appearance. The typeset text was then hand­
pasted on pages, along with any artwork, ruling lines, or other drawn 
components to produce the final page layout. 

U sing Ventura Publisher, you can now 
give text a typeset appearance, combine it 
with pictures and drawings on your 
computer's screen, and then rearrange the 
page to achieve just the look you want be­
fore sending it to the printer. 

Ventura Publisher provides the flexibility 
you need by accepting text and pictures 
from a variety of word processing and 
graphic software packages. Even last-min­
ute changes are easy to make when you 
use the built-in text editing and drawing 
features. 

1 
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Learning Ventura Publisher 

This Training Guide is intended as an introduction to Ventura Publisher. 
It is designed to illustrate selected features of Ventura Publisher and to 
help you understand how the application works. It contains practice ex­
ercises so you can try features as you learn about them. To minimize 
your training time, the exercises cover the most commonly used features 
of Ventura Publisher. 

• The first exercise introduces the main screen and steps you through 
loading a text file, formatting it, saving it, and then printing it. 

• Exercises 2 through 5 cover additional basic Ventura features such 
as editing text, drawing frames and graphics, and customizing the 
look of your documents using Ventura style sheets. 

• Optional Exercises, 6 through 10, cover additional Ventura features 
such as working with multiple files, table of contents and index 
generation, and using Ventura's cross referencing, variable inser­
tion, and table features. 

For your convenience, the exercises use prerecorded example files located 
in the Typeset subdirectory which was created when the software was 
installed. As you work through the exercises, keep in mind that although 
Ventura Publisher may seem complex at first, the additional power and 
capabilities it has over other desktop publishing products makes it easier 
and faster to use in the long run. . 

In the Reference Guide, you will find detailed explanations for each fea­
ture, and examples of how to get the most out of Ventura Publisher. 

Before you begin ... 

If Ventura Publisher has not been installed on your computer, please 
install it before continuing. (Refer to the "Setup and Installation" section 
of the Reference Guide.) 

Before you start using Ventura Publisher, 

• You should have a good working knowledge of your computer and 
its operating system. Refer to your computer user's guide and DOS 
manual for this information. 

• You should be familiar with Microsoft Windows and basic Windows 
operations (using the mouse to open files, double-clicking, using 
drop-down men~s, and accessing drives and directories). Refer to 
your Windows manual for more information on Microsoft Windows. 
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How Ventura Publisher works 

Understanding the following concepts and terms will help you 
learn and use Ventura Publisher. 

Ventura Publisher is a WYSIWYG page layout system. This means that 
What You See (on the screen) Is What You Get (on a printed page). Of 
course, there are some technological differences between screens and 
printers, so you may notice some slight variations between the display 
on your screen and your printed copy. 

Starting out 

Normally you'll begin laying out a document by loading a text file into 
Ventura Publisher. Text files are files created by word processing pack­
ages such as WordStar® and WordPerfeceM

• Any ASCII file can also be 
used as a text file. You can also create a new text file in Ventura Pub­
lisher by typing directly in the application window. 

The Ventura Publisher style sheet will format the text on the screen, 
hyphenating and paginating as necessary. A style sheet is a file contain­
ing page layout information (margins, column widths, ruling lines, etc.). 
Style sheets also contain typographic attributes called Tags which 
define the size and type style for headlines, subheadlines, regular (body) 
text, etc. 

After you load a text file, you can apply tags individually to paragraphs 
of text. To expedite your efforts, you may want to include the tags as 
part of your word-processed document. Then, when you load the text file 
into Ventura Publisher, the layout and typographic attributes will be ap­
plied automatically. 

The use of style sheets simplifies the process of laying out a document. 
The same style sheet can be used over and over, making it easy for you 
to achieve uniform, consistent page layouts. Ventura comes with many 
predefined style sheets in its Typeset directory. These style sheets cover 
a wide range of functional documents including reports, books, and pro­
posals. You can usually find a style sheet that will fit your particular 
application. By renaming and customizing the selected style sheet, you 
can achieve the exact design you want. 

For even greater choices, the Ventura Publisher Design Gallery provides 
additional ready-to-use style sheets that can be used as is, or with mini­
mum modification. 

3 
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Tagging text 

Ha:d1g Tagging is the process of applying typographic attributes to text. For 
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example, when you tag a title in your document as a headline, the tag 
picks up the predefined headline attributes from the style sheet and ap­
plies those attributes to the selected text. The attributes might center 
the title and give it a large, bold type style. Each paragraph that has the 
same tag will also have the same appearance. 

Ventura Publisher uses your original text file (not a copy) when you load 
the text and format it. Any text editing changes you make while using 
Ventura Publisher will be added to the original text file. Tag names and 
typographic attribute codes (such as <I> for italics) will also be added to 
the original text file. If you save the file and then open it with your word 
processor, you'll see this information included with the text. 

If you do not want these attribute codes added to your original text file, 
simply make a copy of your original file and load the copy into Ventura 
Publisher for formatting. 

Frames 

Frames are used to hold text or pictures. A page frame, which is the 
size of one full page, is automatically created for each page of a Ventura 

. Publisher document. You have the option of adding other smaller frames 
to hold pictures or additional text from other files, or of merging two or 
more text files on the same page or within one frame. 

Any time you add or move a frame on a page, the text adjusts automati­
cally to fit around the. frame. If adding a frame to a page pushes text off 
the page, Ventura Publisher will automatically create new pages to hold 
the text. (This feature can be turned off so that text will not rearrange 
when a frame is added or moved on a page.) 

Pictures and graphics 

You can add a picture by creating a frame at any location on a page and 
loading a picture file into it. Picture files can contain line art, images or 
graphics. 

Line art refers to pictures generated by drawing packages such as 
Lotus 1_2_3™, GEM Draw™, GEM GraphTM, AutoCAD™, etc. The only re­
quirement is that the file be in one of the formats compatible with Ven­
tura Publisher. 
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Images refer to art that is scanned in through an optical scanner or 
created using a PC Paintbrush™ type program. Scanned images must be 
in one of the file formats supported by Ventura Publisher. The Reference 
Guide will give details. 

Graphics are created using one of Ventura Publisher's drawing tools. 
You can draw lines and arrows, circles, rectangles, and squares. Use the 
drawing tools to create callouts, boxes, forms, tables, and ruling lines. 

Putting the pieces together 

Normally you'll create the text file for a document using your favorite 
word processing software program. You may also want to create picture 
files using a draw or paint program. Then you'll format the document in 
Ventura Publisher as follows: 

• load a text file into Ventura Publisher 

• select and load a style sheet 

• tag the text with typographic attributes 

• draw small frames and load picture files in them, if desired 

• use the graphic drawing tools as needed 

If you know in advance which style sheet you will be using, you can 
include the tags used in that style sheet as part of your text. Then, when 
you load the text file into Ventura Publisher, your text will be formatted 
automatically. 

When you've finished laying out the document, you'll save the layout 
information in a chapter file. 

Chapter files 

Your original text and picture files are used to format a document. 

When you save your document, Ventura Publisher creates a chapter 
file containing the information on how you combined the text and pic­
tures with the style sheet to create the formatted document. When you 
open the chapter file again, the text and pictures appear in the format 
you defined. 

The chapter file actually contains pointers to the files used to layout a 
document. These pointers are the instructions that tell the software how 
the text files, picture files, and style sheet relate to each other in the 
finished layout. The chapter file itself does not contain any of your origi­
nal files. 

5 
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The illustration below shows how files become related to form a chapter. [ 

[DO 
text file style sheet file picture file 

\ I 

chapter 

'Wmtura Publisher creates a chapter file which contains the directions on how the 
text, style sheet, and picture files are to be combined to produce the final composed 

document. 
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Combining chapter files into publications 

You may want to divide large documents, such as books or technical 
manuals, into several smaller text files. Large documents usually have 
logical breaking points such as chapters or sections. You can format each 
text file as a separate chapter file and combine all chapter files into a 
publication file. You can then perform the following operations on the 
publication file: 

• Generate a table of contents 

• Generate an index (based on author-inserted entries) 

• Print the entire publication 

• Copy. the publication 

• Renumber the pages for the entire publication 

If you work with publications that have many chapters, it is recom­
mended that you dedicate an entire directory for each publication. This 
will make the publication easy to work with, especially when using the 
Manage Publication command in the File menu to perform Multi-Chapter 
Operations activities (these activities are described later in this Guide). 

XYZ 
Chapterl 

XYZ 
Chapter 2 

XYZ 
Chapter 3 

XYZ 
Publication 

! 
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How file extensions are used 

File extensions (the three letters to the right of the period in the file 
name) are automatically assigned to files created by Ventura Publisher. 

Chapter files are assigned .CHP extensions, publication files use .PUB 
extensions, style sheet files use .STY extensions, and OLE object files 
use . VPO extensions. In addition, when a table of contents or index is 
generated by Ventura Publisher, the extension .GEN is used. Ventura 
Publisher also assumes that certain file extensions are used by files cre­
ated by other programs. These include: 

Text files 
any ASCII file 
DCA 
Lotus PRN to Table 
Lotus Ami Pro 
MS Word 
MultiMate 
Word for Windows (WinWord 1.x & 2.x) 
WordPerfect (4.x and 5.x) 
WordStar 3 
WS 4.0/5.0 
XyWrite 

Line Art 

AutoCAD .SLD 
CGM 
GEM Draw 
HPGL 
Lotus .PIC 
Mac PICT 
PostScript Encapsulated 
VideoShow files 
Windows Metafile 

Image Art 

DCS Imagefile 
GEM PaintIHALO DPE 
PC Paintbrush, PC Paintbrush Plus, 
and Publishers Paintbrush 
Mac Paint 
TIFF 

Extension 
. TXT 
.RFT 
.PRN 
. SAM 
.DOC 
.DOC 
.DOC 
.WP 
.WS 
.WS 
. TXT 

Extension 

.SLD 

.CGM 

. GEM 

.HPG 

.PIC 

.PCT 

.EPS 

.PIC 

.WMF 

Extension 
.MAS 
.IMG 
.PCX 

.PNT 

.TIF 

Make a note of the file extensions that your software programs use. (If 
your word processing software package is not in the text files list, you'll 
need to convert your text files to ASCII format before loading them into 
Ventura Publisher. 
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What to do next 

Now that you've finished the introduction, you're ready to begin using 
Ventura Publisher. Complete Exercises 1 through 5 to learn the basics of 
Ventura Publisher. You can then decide if you want to complete the other 
exercises or begin working with your own documents. 

As you proceed through each exercise, you will encounter italicized 
words (for example, style sheet). If you are not familiar with these words, 
you can refer to the glossary at the beginning of that exercise for their 
definitions. 

At the back of this guide, you will find a questionnaire you can use to 
evaluate each training exercise. Please remember to fill it out after you 
have completed your training. Your comments help us in our continuing 
efforts to improve our training materials. 

9 



EXERCISE 1 GLOSSARY 

The following terms can be found in Exercise 1. 

.:. Chapter 
A combination of text and picture files, formatted with a style sheet. A chapter file 
consists of pointers to each of these files, along with instructions on how to combine 
them on the computer screen or printer. All Ventura Publisher documents are saved 
as chapters . 

• :. Interline spacing 
The space between lines in a paragraph . 

• :. Page Frame 
Also known as the application window, the page frame is the frame defined by the 
Page Size & Layout option in the Chapter menu. Additional frames, drawn with the 
Add Frame tool, are placed on top of this page . 

• :. Point 
A typographic unit of measurement equal to l!72 of an inch . 

• :. Ruling line 
A horizontal or vertical line used to separate text or frames from the surrounding 
layout. You can define ruling lines as part of a paragraph tag, or draw them using 
the Line tool. 

.:. Style sheet 
A file that defines the appearance of the paragraphs in your document. When you 
create a style sheet, you give each set of typographic attributes a name (or "tag") . 

• :. Tag 
The format applied to a paragraph. Tags are stored in the style sheet. The Tags list 
window shows all of the available tags in the currently loaded style sheet . 

• :. Typeface 
The style of type, such as Bookman, Palatino, Avant Garde, and Zap! Chancery. 

10 



EXERCISE 1 

Learning the basics 

In this exercise you'll learn about: 

• Starting Ventura Publisher 

• U sing the mouse 
• Selecting and loading a text file 

• Applying style sheets 

• Tagging text 
• Moving between pages of a document 

• Saving the document as a chapter 

• Printing 
• Clearing the screen 

Approximate time to complete: 45 minutes. 

Note: Instructions for steps that you are to perform will be preceded by 
the symbol >. If the action you perform causes an immediate result, the 
result is described in italics. For example: 

~ Turn on your computer. 

The DOS prompt or Windows Program Manager displays on the 
screen. 

If someone has previously used Ventura Publisher on your computer, you 
may want to re-install the Example files in the Typeset directory. If so, 
read and perform the steps below. If not, tum to the next page. 

~ Follow the software installation instructions in the Setup and Instal­
lation section of the Reference Guide up to when the Ventura Pub­
lisher Installation dialog box is displaying. 

~ With the Installation dialog box displaying, disable the Install Ven­
tura Publisher and the Create icon and set user preferences location 
check boxes. 

~ Select the destination drive where Ventura Publisher and the Exam­
ple files are installed. Select the Install button, and then follow the 
screen instructions. 

11 
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Starting Ventura Publisher 

> If Microsoft Window version 3.0 or above is not already running, type 
WIN at the command prompt, and press the Enter (return) key. 

> If not already opened, open the Ventura Software group window by 
double-clicking the Ventura Software icon within the Program 
Manager. 

> Double-click the Ventura Publisher icon 
ware group window. 

in the Ventura Soft-

Ventura Publisher loads. Once loaded, the main screen (similar to the 
following illustration) displays. 

Ventura Publisher's main screen is where you'll begin publishing your 
Ventura documents. Everything you need to produce professionally de­
signed documents is either on this screen or a few mouse clicks away. 

menu bar Help 

vertical ruler 

application window/page frame 

scroll bars ----_ 

1 j 
e buttons __ 

zoom controls 

current selection indicatori page number indicator i 

[ 

[ 

[ 
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The illustration on the previous page points out important areas of Ven­
tura Publisher's main screen. A brief description for each of these areas 
begins below. 

The application window, or page frame, is the large blank area you'll 
use to layout your documents. 

The title bar displays ''Ventura Publisher" and the names of the active 
disk drive, directory, and Ventura chapter and style sheet files. 

The menu bar holds all of Ventura's "pull down" menus. Each menu 
opens to reveal a list of options that will help you create that just-right 
look for your documents. Options that carry out similar actions are 
grouped in a menu. For example, the File menu, illustrated below, con­
tains the menu options you would use to open, save, and print files. 

And if you need help while using Ventura, there is online help that is 
always available. For help, select Help with the mouse, or press your 
keyboard's Fl key. 

If you've installed any of Ventura's Color Extension programs, your 
menu bar will also display an Extensions menu. You'll find information 
about the Extensions menu in the Color Extensions documentation . 

.chapter Frar 

.save 
Save As ... 
Revert to Saved ... 

.Load Text/Picture ... 
Loa!!. Diff. Style ... 
Saye Style As ... 

Manage Width Table .. . 
Manage Pu.!!lication .. . 

Print Setyp ... 

Ctrl+S 

frint... Ctrl+H 

13 
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Look at the illustration of the File menu and note the following points: 

• Options are listed in gray and black. Gray options are not currently 
available for selection, black options are available. 

• Some options execute as soon as you select them. New, Save, and 
Exit are examples of this type of option. Many options, however, 
require you to specify additional information before executing. 
Whenever you select an option of this type (indicated by three peri­
ods after the option name), a dialog box displays on the screen. 
Open Chapter, Load TexVPicture, and Print are examples of this type 
of option. 

• Some options have keyboard shortcuts. In the File menu, the Save 
and Print options have keyboard shortcuts. A keyboard shortcut is a 
keyboard key which can be used to activate a menu option. You 
could use the Save option without displaying the File menu by hold­
ing down the Ctrl key and pressing the S key at the same time. (A 
complete list of all keyboard shortcuts can be found in both the 
Reference Guide and the Quick Reference Guide.) 

• You can cancel a menu by either moving the mouse cursor to an­
other point on the screen and clicking the mouse button, or by 
pressing the Esc key. 

The button bar, (shown below) located just below the menu bar, is two 
rows of buttons (icons) each representing a tool, function, or "pull down" 
menu option. Choosing options is easy with the button bar. With just a 
click of the mouse, you can have a dialog box opened and ready to use. 
By not having to hunt through menus for options, you'll be able to com­
plete tasks with greater efficiency. For example, with just a "click" of the 
mouse, you can open a chapter, "click" "click", change its look, "click", 
save the changes, and "click", print the chapter. 

function buttons tool buttons 

I file .Edit ~iew ,!;.hapter
l 

Frame Earagraph I Iext 

function buttons tool option buttons 

The button bar is customizable, with the exception of the Tool buttons. 
The Reference Guide gives detailed instruction on how to customize the 
button bar. 

[ 

[ 
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The Tool buttons (shown below) are central to the creation and modifi­
cation of Ventura documents. A brief summary for each tool is given, 
following the illustration. 

The Frame Tool (also known as the Selector) is used to select, draw, 
move, re-size, copy, and delete frames and graphics. You'll also use the 
Frame Tool to place text or pictures (or both) onto the page frame, or 
into drawn frames. 

The Add New Frame tool is used to draw new frames. Once a frame is 
drawn, the Frame tool (or Selector) automatically becomes enabled. You 
can then use the Frame tool to place text or pictures (or both) into the 
drawn frame. 

The Paragraph Tool is used to change the way text looks on the page. 

The Text Tool is used to edit existing text (add, delete, copy, move), or 
to type new text. It is also used to change text attributes (bold, italic, 
point size, etc.). 

The Table Tool lets you create and edit tables. 

The Graphic Tools (shown below) are used to draw square-edged rec­
tangles and squares, rounded-edge rectangles and squares, circles and 
ellipses, lines, and boxes in which you can type text. Once a graphic is 
drawn, the Frame tool (or Selector) automatically becomes enabled. 

15 
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Just below the Tool buttons are the tool option buttons (shown below). 
Depending on the tool that is selected, this row of buttons will change to 
duplicate menu options in either the Frame, Paragraph, Text, Graphic, 
or Table "pull down" menus. For example, in the illustration below, the 
Paragraph tool is currently selected. Therefore, the tool option buttons 
are duplicating the menu options in the Paragraph "pull down" menu. 

paragraph tool option buttons 

The function buttons (shown below) reside on the left side of the but­
ton bar, and duplicate frequently used File, Edit, and Chapter menu op­
tions. These buttons are always available regardless of the currently se­
lected tool. 

file fdit ~iew 

function buttons 

The Files list (shown below) displays, alphabetically, the names of all 
files available for placement or already placed in the current chapter. 

The Tags list (shown below) displays, alphabetically, the names of all 
tags available for assigning to paragraphs (when the Paragraph tool is 
selected), or frames (when the Frame tool is selectd) in the current style 
sheet. 

When a paragraph is selected, the tag currently assigned to that para­
graph will display in the Tags list. When a frame is selected, the tag 
currently assigned to that frame will display in the Tags list. 

Paragraph tool is selected 

r Frame Earagrap/ 

Files list - book_ txt 
~========i 

Tags list _ Body Text 
t:::::=====~~ 

Frame tool is selected 

r Frame 

nozzle_gem Files list 

<No Tag> Tags list 
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Scroll bars and scroll arrows are located on the bottom and right side 
of the screen. They are used to move different areas of the page into the 
viewing area. The bottom scroll bar controls movement horizontally; the 
side scroll bar controls movement vertically. The scroll arrows are used 
when you want to move the page by small increments of approximately 
one line. Only the horizontal scroll bar is shown below. 

scroll arrow scroll box 

The position of the scroll box in the scroll bar corresponds to the gen­
eral location of the page in the viewing area. To use the scroll bar, "drag" 
the scroll box to a position in the scroll bar that corresponds to the gen­
eral location you want on the page. Then release the mouse button. To 
use the scroll arrows, click once on the arrow to scroll one line at a time 
in the direction of the arrow, or click and hold on the arrow to scroll 
continuously in the direction of the arrow. 

Using the horizontal ruler bar (shown below) and the mouse, you have 
a quick and convenient way to change first-line indent/outdent, adjust 
left and right margins, and specify type and position of tabs for the cur­
rently selected paragraph, in either Paragraph or Text mode. 

first-line indent/outdent marker (top arrow) 

t t t t t t 

I left margin marker (bottom arrow) 

default left tab markers 
(every 1/2 inch) 

right margin marker I 
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The page buttons allow you to move through a chapter with a click of 
the mouse. Clicking once on the buttons moves you through the chapter 
one page at a time as do the PgUp and PgDn keys on your keyboard. 
Double clicking on the buttons. moves all the way through the document 
either to the beginning (the upper button) or end of the document (the 
lower button) as do the Home and End keys on the keyboard. 

_ page up button 
- page down button 

The zoom controls (shown below) consist of five buttons which control 
how your document is displayed on the screen. 

The direct access page scaling buttons 

normal view I I reduced view 

enlarged view I lfit window 

The % button displays the current zoom factor. If you click on the % 
button, a zoom menu will display which will allow you to select other 
zoom factors from a range of custom percentages, select the pre-set zoom 
factors for Normal, Enlarged, Fit Sides, and Fit Page views, or Custom­
ize the zoom factor for both Normal and Enlarged views. For more infor­
mation about the zoom menu, refer to "Menu Bar" in the User Interface 
section of the Reference Guide. 

The four direct access page scaling buttons have the default zoom factors 
of: 

• Enlarged view (default 200%, customizable) 

• Normal view (default 100%, customizable) 

• Fit Sides (scales to window width) 

• Fit Page (default reduced view) 
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The current selection indicator (shown below) displays information 
about what is currently selected. It will also display a brief description of 
the tasks that can be accomplished by a button in the button bar, should 
you forget. 

current selection indicator 

To view the tasks that can be accomplished by a particular button, you 
position the mouse cursor over the button and hold down the left mouse 
button. Continue holding down the left mouse button while you read the 
description in the current selection indicator. To avoid activating the but­
ton, drag the mouse cursor away from the button before releasing the 
mouse button. The illustration above shows the description for the Text 
Tool. 

The page number indicator (shown below) shows your location within 
a multi-page document and indicates if the page is left or right. 

i!!!r!!t1~~~i!mt--page number indicator 
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Using the mouse 

N ow that you know the parts of the screen, you only need to know how 
to move the mouse to start selecting functions and laying out a docu­
ment. 

Just slide the mouse until the cursor is positioned over the item you 
want to select and then press (click) the mouse button. 

When clicking the mouse button, use only the left button on a multi-but­
ton mouse. The other buttons are not used in Ventura Publisher. The 
drawing of frames and graphics is accomplished by holding down the 
mouse button and "dragging" the cursor across the screen to the desired 
location. 

The mouse cursor will change shape depending on the tool selected or 
when the cursor is in different areas of the screen. This gives you a 
visual key of the action to be taken. 
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Loading a text file 

You're ready to start working on a document. First you'll select the 
frame where you want the text file to appear. In this case, you'll use the 
page frame that is automatically set up in the application window. Re­
member, the Frame Tool is used to select a frame. 

~ If it's not already selected, select [!!§l the Frame Tool by moving 
the mouse cursor over the icon and clicking the mouse button. (Re­
member, click the left button on a multi-button mouse.) 

The Frame Tool icon is outlined in black indicating it has been en­
abled (selected). Small handles (black boxes) will appear on the out­
side edges of the application window to indicate that the page frame 
has been selected. Your screen should look similar to the following 
illustration. 

Load Text/Picture button Frame Tool 

\ Handle I Handle 

You can quickly load any file into Ventura Publisher using the Load 
Text/Picture button. 

~ From the function buttons, select the Load Text/Picture button 
by moving the cursor over the icon and clicking the mouse button. 

The Load Text / Picture dialog box, similar to the following illustra­
tion, displays. 

21 
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Ventura Publisher uses dialog boxes to give you messages and to ask you 
for any additional information. The Load TextlPicture dialog box is used 
to identify the type and format of text and picture files before you load 
them. You also have the option of loading several files of the same type. 

You'll be loading one text file in ASCII format. If this is the first time the 
software has been used, the following options will already be highlighted 
(selected). If they are not, you'll need to: 

~ Select for File Type: the Text option button. 

~ Select for the file Format: ASCII. 

~ Select for Destination: the List of Files option button. This option will 
place the text file into the Files list. 

Whenever Text is selected for File Type, Ventura Publisher also provides 
the following selections. 

Clipboard - to place a copy of the entire file on the clipboard. See the 
Reference Guide for more information. 

Cursor - to place a copy of the entire file at the current location of the 
text cursor. See the Reference Guide for more information. 

~ Make sure the check box for Several is not selected. 
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The OK button tells the software to act on your selections. 

~ Select it by placing the mouse cursor on OK and then clicking the 
left mouse button. 

File Name box 

The Open File dialog box, similar to the following illustration, dis­
plays. 

Move the dialog box by dragging the title bar 
The current 

-~i~::::;~I~I~~~~~lllf{~irrrrrf~l.drive and directory 
----f1B~~~~rtDirectories 

The Open File dialog box is used to locate and select file names to be 
loaded into Ventura. 

The File Name box lists all the ASCII files (files with a .txt extension) in 
the current directory, and provides a box for you to type or select a 
filename. You can type the name of the file you want to open in this box, 
or you can select the file name from the list. The scroll bar beside the 
box lets you scroll up and down through the file names in the list. 

The Directories box lists the directories available on the current drive. 

The Drives box lists the drives available on your system. 

The text file you will load resides in "c: \ typeset". This should already be 
the current drive and directory, unless someone changed the setting be­
fore you began this exercise. To determine the current drive and direc­
tory, look directly under the word Directories: in the Open File dialog box. 
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If "c: \ typeset" is not the current drive and directory, you'll need to: 

~ Select the arrow in the Drives box, and then select the c: drive letter. 

The root directory of c:\ displays in the Directories box. 

~ Double-click on the typeset directory in the Directories box. 

The File Name box lists all the ASCII files (files with a .txt extension) 
in the Typeset directory. 

Note: The directory last used for each option in the Load/Text Picture 
dialog box is always remembered. For example, if you have WordS tar 
files in a WORDSTAR directory, you would only need to go to that direc­
tory the first time you used a WordStar file. After that, the WORDSTAR 
directory will automatically display when you load a WordStar file. 

~ Select the abook. txt file in the list box by moving the mouse cursor to 
it and clicking. 

abook.txt is selected in the list box and is added to the File Name text 
box, as shown in the following illustration. 

~ . To indicate that this is the file you want, select the OK button. 

Messages display indicating the abook. txt file is being loaded and hy­
phenated. Then the text file loads into the page frame, as shown in 
the following illustration. 

If no text displays, go to the next page for help. 
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Chapter I, 
The Adventure Begins' 

This trip really began in September last year when Gerry won first prize in a raffle at the fashion 
show which Rush-Presbyterian-St. Luke's Medical Center holds every year, The prize was two 
round trip tickets to Hong Kong on United Airlines. and ten nights in the Hong Kong Hyatt Hotel. 
Analyzing our good fortune, we concluded that we wanted to do more than spend ten days in Hong 
Kong and return, but at the same time, United, having just gotten itsroutes and equipment from Pan 
American, had not yet received authority to fly to other destinations or between points in the Far 
East" 

On February I ath. United acquired this authority, and on February II th Debbie began putting our 
trip together, We left on March 2nd and returned on March 26th, We entered seven countries, 
traveled over 25,000 miles on four airlines, made over 500 Kodachromel1l slides, almost 200 
Kodacolorl1l prints, and 5 112 hours of color and sound videotape,~ 

When a text file is placed directly on the page, any text that does not fit 
on the current page automatically flows to succeeding pages. 

Notice that the text file name appears in the Files list, the title bar, and 
the current selection indicator. 

The Files list displays, alphabetically, the names of all files available for 
placement in the document's layout. The current selection indicator dis­
plays the name of the file that is in the currently selected (active) frame. 
The title bar temporarily displays the file name as the chapter name 
until the file is saved as a new chapter. 

The Tags list displays, alphabetically, the names of all tags available to 
be assigned to paragraphs in the document. 

If your text is not displayed on the screen 

If you have text on the screen, proceed to "Applying a style sheet." 

If text does not appear in the page frame (application window), it may 
be because the Frame Tool was not enabled (selected) when the file was 
loaded. 

Make sure the Frame Tool is selected. (Handles will appear along 
the top of the page frame.) 
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To' place the contents of a text file into a frame after the text file has 
been loaded into the Files list, follow the steps below. 

~ Select the down-arrow to the right of the Files list. 

The Files list opens to displays its contents. 

~ Position the cursor on the abook.txt file in the Files list and click the 
mouse button. 

The text file loads into the page frame and looks similar to the 
illustration on the previous page. 

Applying a style sheet 

Now you can load a style sheet (a file containing the page layout informa­
tion) and watch it automatically format the text. 

The style sheet contains the page layout (margin and column settings) 
and tags that describe the typographic attributes for every paragraph of 
a document. 

For example, the tag for a chapter heading might define the text as 
being centered and appearing in large 24 point Helvetica type. 

Tag attributes include typeface, point size, and interline spacing. They 
can also include information about ruling lines used to set off a block of 
text and special effects (such as a large first character), as well as col­
umn and page breaks. 

Ventura Publisher provides style sheets designed to fit the most common 
document formats. The prerecorded style sheet names start with an am­
persand (&). These are shown in Appendix L of the Reference Guide. 

Style sheets, like text, are files, so you'll load a new style sheet using a 
dialog box. 

~ Select the Load Different Style button. (Use the mouse to select 
the button.) 

The Select Style Sheet dialog box, as shown in the following illustra­
tion, displays. 
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&book-p1.st1' 
&book-p2. st1' 
&bro·12.st1' 
&bro-p3.st1' 
&inv-p 1. st1' 
&lstg-p2.st1' 
&ltr1-p 1. st1' 
&mag-p3.st1' 

... .. 

~ 12:7 c:\ 
e t1'peset 

I 

+ l­

'*" 

Cancel 

rlie1p 

Notice that the \typeset directory is displayed again (unless someone 
has previously used the software and changed directories). However, this 
time, only files with a .STY extension (for style sheet) are displayed. 

~ Select &book-p2.sty 

&book-p2.sty is selected In the list box and lS added to the File Name 
text box. 

~ Select the OK button. 

The style sheet is loaded and the text file is reformatted according to 
the settings in the style sheet. The style sheet you selected formats the 
text into a two-column format, similar to the following illustration. 
The new style sheet name appears in the title bar at the top of the 
screen. 

file Edit ~Iew ~hapter Frame earagraph Iext yraphlc TJlbie Help 
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Chepter1l1 
The Advenillre B. ~ns1J 
Tbi.trip r.0I1yb.ganin September lasty.ar when 

o erry won first prize in aroffl. at tho fashion chow 
which Ruch.Pr.sbyterian.SL Luk.', M.dical C.n­
ter holds .very y.ar. The prize wa, bNo round trip 
ticket. to Hong Kong on Unite d Airline~ and ten 
niglisintho HongKongHyattH ote1. Anolyo:ingour 
good fortune, w. concluded that w. warted to do 
more than sp end ten day.inHongKong andretum 
but. at tho sam. tim., Uritet\ having just gotten its 
rout .. and .quipment from Pan Arneric"" hednot 
yet.teceived~uthoritytof1yto other destinations CI' 

betw.en poirt, in tho Far East.' 
On Februery 10Lh Uritedaccriredthi. authority, 

and onF.bruaryllthDebbi. began putting OUltrip 
togothor. W. leR on March 2nd and relllrned on 
March 26th. W. entered .even cO\lltrie~ traveled 
over 23,000 mil .. on four oirline .. made aver 300 

w.ather, 8Cc«npori.d by \Ilderlying cloud. much 
of tho way. O~ 3400 mil.'!Iiittfr«n Lo. Angele. 
took u.north oImostto the Kurilelslonds andthon 
down into Tokyo. L.tling down through tho c1 ouds 
aver a rough .. a we .aw many fi sbing bo at. and 
othor v .... l. all headed into Tokyo. Our opproach 
irto tho N ante Airport involv.d along slow de .cent 
whlcl1. lIf\.r pa.sing tho shor.line (s1%angely rorni. 
riscentofth. W.st ohor. ofLak. Michigan oIthough 
with .«n •• anclyb.ach.s), gevo us an opportunity 
to ••• marq small patches of cultivat.d g:ound. Tiny 
hous.~ and.vensmall factori ••. Everything •• orn.d 
miriature. At 4:25 PM.'ih. NnW" still fairly high 
in tho sky, but. w. to what opp.".d to b. smog 
visibilitywasprobablynotmor. than3 mil ••. Quar. 
artin. and customs proved no probl.m, but. immi· 
g: ation wa' sl ow with much attention to detail. Our 
3:13 PM.lirnousine-r.ally a rather l"ge bus de· 
part.d promptly and corri.d u. on 0Ul hour and 
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All of the text has the typographic attributes of body text (the main text 
in the document). The next step is to tag the text that you want to look 
different from the body text (e.g., the chapter title and major headings). 

Tagging text 

You may want the headings to appear larger and bolder than body text 
so they stand out. Moreover, if your document has more than one level of 
headings, you may want to have different tags for each level so they can 
be easily differentiated. 

Before you can apply tags, you'll need to change to the Paragraph Tool. 
Remember, the Paragraph Tool is used to change the way text looks on 
the page. 

~ From the tool buttons, select the Paragraph Tool. 

Tags are applied to paragraphs, rather than to single words or letters. 
Look at the text on your screen and notice that a 'II symbol marks the 
end of each paragraph. Notice that the title, Chapter 1, is considered a 
paragraph. 

A paragraph symbol will appear in the text at each location where a 
required (hard) return or double return was typed in the original docu­
ment. 

Follow the steps below to see how paragraph tags are used to apply the 
typographic attributes set in the style sheet. 

~ Move the mouse cursor to the text: Chapter 

The cursor takes the shape of the paragraph tag icon. ~ 

~ Click the mouse button to select the paragraph" Chapter l'II ". 
The text and W symbol, as shown in the following illustration, are 
highlighted. Body Text displays in the current selection indicator to 
slfow that the text currently selected is tagged as Body Text. 
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Tho Adventur. Se&ns1I 
This trip reallyb.ganin September last y.ar whon 

o erry won first fl'iz, in .,.m, 01 tho fashion show 
wlich Rush-Presbylerion-Sl LuI<,'. Medico! Cen­
ter holds every year. Tho fl'iz. was two round trip 
tickets to Hong Kong on UnitedAirline~ and ten 
nights in tho HongKongHyoltH ote!. Analyzingour 
good fortune, w. concluded that w. warted to do 
morethonspendtendaysinHongKong andrelum, 
btt at tho sam. time, Unitec\ having just gotten its 
rott .. and e<rJipment from Pan Arneric"" had not 
yet received attha:ilylofly to other destination. or 
betweenpoirJlsintho FarEast.~ 

On Februory IOU. Unitedacqtiredtbi. atthorily, 
and on Fe1xuary I Ith Debbie began putting our trip 
logothor. W, left on March 2nd and returned on 
Morell 26th. W. entered .even countrie~ travel.d 
over 2.l,OOO mil .. onfour oirline~ made over .lOO 

w.ather, accompanied by underlying cloud. much 
of tho way. Our .l4O0 mil.'fiittfrom Los Angeles 
look u. north almost 10 th, Kuril.lslands and thon 
down into Tokyo. L.lling down tbiough tho clouds 
aver a roU!1> sea w, .aw many fishing bolll. and 
other v .... 1s all hoad.d into Tokyo. Our "I'fl'oach 
irllo tho N ari to Airport involved along slow de sc enl 
which, after passing tho shoreline (strangely rerni. 
ni.cenloftheWestfhor, of Lake Michigon although 
with som •• andy b.aches), gave us on opporturlity 
to see mar;r om all pat.cho s of cultivllled ground. Tiny 
house~ andevenomallfactori ... Everything.eerned 
minialure. At 4: 2.l P.M .'\h, sun was still fairly high 
in tho sky, btt due 10 whlll "I'p.ar.d to b. ""og 
visiWitywo.probably nolmore thon.l miles. QUat. 
arlIin. and custom. p'oved no fl'oblern, btt irnrni· 
gr otion was sI ow with much attention to detail. 0 ur 
.l:I.l P.M. limousine-really a rather large bus de· 
parted p'omptly and corried u. on our hour and 

........................................... 

~ Use the mouse to select the down-arrow to the right of the Tags list. 

~ Move the cursor to the tag: Chapter Title and click the mouse to apply 
the Chapter Title tag to the highlighted text. 

Chapter 1 is changed to a large size type, and white space is added 
below it. These are the attributes set for the Chapter Title tag in the 
&book-p2.sty style sheet. Your screen should look similar to the follow­
ing illustration. 

Tho Adventure Se&ns1I 
Tli. trip re ally be gan in September last ye .. whon 

o erry won first fl'ize in .,aff1e III tho fashion show 
which Rush.Presbylerion.St LuI<e's Medico! Cen­
ter holds every ye ... Tho p'ize was two round trip 
tickel. 10 Hong Kong on UniledAirline .. and len 
nights in tho HongKongHyllltH ote!. Analyzingour 
good fortune, w. concluded that we warted 10 do 
more thon spendlen day.inHong Kong ondrelum, 
but altho same time, Unilec\ gotten its 
r ott .. and e from had nol 

weather, accompani.d by underlying clouds much 
of tho way. Our .l4O0 mile'flitt from Los Angeles 
took us north alm ost to the Kurile lsi onde and thon 
down into Tokyo. Letling down tbiough tho clouds 
over aroU!1> sea w. saw mony fishing bollls and 
other vessel. all hoaded into Tokyo. Our 'l'P'oach 
irllo tho N arito Airport involved along slow de scent 
which, after passing tho shoreline (str ongely remi· 
niscentofth.W.stfhore of Lake Michigllrl although 
with some 
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Apply the Major Heading tag to the next paragraph. 

~ Select: The Adventure Begins by moving the cursor to it and clicking. 

~ Click on the down-arrow to the right of the Tags list. 

~ Apply the tag: Major heading by moving the cursor to it and clicking. 

The highlighted text changes size. A ruling line is added below it. A 
portion of the ruling line may be hidden by the highlighting. However, 
you will be able to see the ruling line when the text is not highlighted. [ 

30 

~ Move the cursor away from the highlighted text and click. 

The highlighting is removed, as shown in the following illustration. 

Chapter 1~ 

The Adventure Begins' 
above, OU' !rip yesterday wos a good 0110 with fin. 
w .. ther, occompenied by underlying cloud. much 
of the way. OU' 5400 mile'fligbt from Lo. Angel,. 

Thi. !ripreollybegenin September last year when took u.north olmost to the KU'il. Islands and then 
o errywonfirst txizein aroffle ot the fashion show down into Tokyo. Letting clown through the clouds 
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EXERCISE 1 - LEARNING THE BASICS 

Looking at a reduced view layout 

When you work with documents, you may not see the entire page. By 
reducing the view layout, however, you can see a miniaturized version of 
the page. 

> Select the Reduced View button, or Reduced View from the View 
menu. 

The page is redrawn so that all of it displays and looks similar to the 
following illustration. Most of the text will be greeked . 

. ;.. . ,;., . 
[lie Edit 'ilcw !;haptcr Frame Earagraph lcxt .Graphic Tllblc Hclp 

Chapter 111 

Greeking refers to text that is represented by a line of the appropriate 
height and length rather than the actual characters. Greeking decreases 
the time needed to redraw the page on the screen. You can set the size of 
the text to be greeked (or turn it off) using the Text to Greek feature in 
the Set Preferences option of the Edit menu. 

Note: If you have a full page display, your text may not be greeked. 
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Applying a different style sheet 

One of the outstanding features of Ventura Publisher is the ability to 
reformat your document using style sheets. With style sheets, you can 
reformat a document in seconds, using minimal keystrokes. 

To change the current layout to a one-column format, simply load the 
one-column style sheet. 

~ From the function buttons, select 
ton. 

the Load Different Style but-

The Select Style Sheet dialog box displays. Only .STY files in the 
Typeset directory are displayed. 

~ Select &book-p1.sty 

&book-p1.sty is selected in the list box and is added to the File Name 
text box. 

~ Select the OK button. 

The text on the screen is reformatted into one column and looks sim­
ilar to the following illustration. 
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Moving between pages 

New pages are created automatically to hold any text that is moved 
(paginated) from the preceding page. To move between pages, you can 
use either the Page buttons or the PgUp and PgDn keys (make sure 
Num Lock is off). 

~ Either select the page down button, or press the PgDn key. 

L Page 2 displays in the page number indicator. 

Double-clicking on the Page buttons moves you either to the beginning 
(the page up button) or the end (the page down button) of the document. 
The Home and End keys on the keyboard will perform the same tasks. 

~ Either double-click on the page up button, or press the Home key. 

R Page 1 is displayed again. 

To go to a specific page in a long document, use the Go to Page option in 
the Chapter menu. (For details, see "Chapter Menu" in the Reference 
Guide.) 

The following steps will give you practice in viewing different areas of a 
document. 

~ Practice using the PgUp, PgDn, Home and End keys, and the Page 
buttons to look at the other pages in the·document. 

~ Practice using the zoom control buttons to change between Normal 
and Enlarged views. Select the Normal view before going to the next 
step. (You can also use the keyboard shortcut Ctrl Key + N to return 
to normal view.) 

~ Practice using the scroll bars and scroll arrows to move the docu­
ment vertically and horizontally. 

~ Practice tagging additional text in the document, if you want. 

Note: If you will be applying the same tag to more than one paragraph 
on the page, you can select the first paragraph as you normally would. 
Then hold down the Shift key while you select the other paragraphs. (If 
you need to de-select one of the paragraphs, hold down either Shift key 
and select the paragraph.) With the paragraphs selected, select the ap­
propriate tag. 

~ When you feel comfortable moving within the document, continue 
with this exercise. 
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Saving a chapter 

A chapter is a combination of text and picture files, formatted with a 
style sheet. A chapter file consists of pointers to each of these files, along 
with instructions on how to combine them on the computer screen or at 
the printer. All Ventura Publisher documents are saved as chapter files. 

To save a chapter file, 

~ From the function buttons, select. Save As button. 

The Save File As dialog box displays, as shown in the following 
illustration. Only .CHP files in the Typeset directory are displayed. 
The cursor is positioned in the File Name text box. 

~ In the File Name text box, type: MYDOC 
(Use the Backspace key to correct any typing errors. It is not neces­
sary to type the CHP extension, because it will be added automati­
cally.) 

Up until now you have selected the OK button using the mouse. You can 
also press the Enter (return) key to act upon the option selected. Try this 
now. 

~ Press the Enter (return) key to say OK. 

The chapter file is stored on disk; however, the text remains on the 
screen. The chapter name MYDOC.CHP is entered in the title bar. 

Saving a chapter file does not remove the document from the screen. 
(Remember, the chapter file contains only the pointers that tell how the 
text file, style sheet, and pictures are related.) 
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The text can be cleared from the screen by opening a new chapter file or 
by selecting the New Chapter button in the button bar. The following 
pages will show you how to print the document and then clear it from 
the screen. 

Printing a chapter 

When you print a chapter or page, the formatted document must be dis­
played on the screen. To print the page currently on your screen, 

[~ 
> From the function buttons, select ... . the Print button. 

The Print dialog box, similar to the following illustration, displays. 

The default Print Range is set to print the Current page. You can also 
print only the left pages, only the right pages, all pages, or a selected 
range of pages. 

For this exercise, you'll leave the Current option selected. When printing 
your own chapters, you may want to change several of the other print 
options. Other options in the Print dialog box include specifying the 
print quality, number of copies, collating copies, and printing to a file 
name. Selecting the Option button will open the Ventura Print Options 
dialog box with options you can select for reversing the printing order, 
placing camera crop marks at the edge of each page, printing hidden 
pictures, tiling, and printing color separations with an additional option 
for printing empty plates. Refer to "Print" in the File Menu section of the 
Reference Guide for more information on all of the Print dialog box op­
tions. 
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> To close the dialog box and begin to print, press the Enter (return) 
key, or .select the OK button. 

The Print Status window showing that the document is being sent to 
the printer displays, as shown in the following illustration. 

Clearing the screen 

Printing 
Ventura - MYDOC.CHP 

Text remains on the screen until you clear it or open a new chapter file. 
Mter you've saved the chapter, you can clear the text from the screen as 
follows. 

> From the function buttons, select the New Chapter button. 

The Select Style Sheet dialog box displays. 

At this time, you could either load a different style sheet, or by selecting 
Cancel, clear the screen. 

> Select the Cancel button. 

The text on the screen clears. 

For more practice ... 

If you'd like more practice tagging text, you can load the SAMPLE.TXT 
file and the SAMPLE 1. STY style sheet. The text in the file contains in­
structions for using the tags in the style sheet. 

When finished, use the instructions on page 34 to save the document as 
a chapter using the new file name: MYDOC2. 
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How to quit 

When you've finished working with Ventura Publisher, use the Exit op­
tion in the File menu to close the application window. 

If you quit before saving the chapter file currently on the screen, a mes­
sage displays asking whether you want to save changes to the chapter, 
abandon changes to the chapter, or not quit. Choosing to save the chap­
ter will allow you to save the chapter before quitting. Choosing to aban­
don the chapter will delete any work done on the chapter since it was 
last saved. (Note that this does not erase the original text file or any 
other files used in the chapter.) Choosing not to quit lets you continue 
the Ventura Publisher session. 

Since you already saved the chapter in this exercise, you will not see the 
save and abandon messages. To exit Ventura Publisher, 

~ Select the File menu. 

~ Select the Exit option. 

The Ventura Publisher software is exited. 

When you Exit from Ventura Publisher, the current View and Prefer­
ence settings are all saved. The next time you use Ventura Publisher, 
you will resume with the same settings that were in effect at the end 
of the previous session. 

Points to remember 

• The steps for laying out a document are: 

Load a text file 
Load a style sheet 
Select and tag text as desired 
Add pictures (this is covered in exercise 3) 
Save the format information in a chapter file 
Print the document while it is on the screen 
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• The Tool buttons (illustrated below) consists of ten icons, each rep­
resenting a tool which you can use to create and modify your docu­
ment. The Tool buttons are, from left to right: the Frame Tool (or 
Selector), the Add New Frame tool, the Paragraph Tool, the Table 
Tool, and the graphic drawing tools. The graphic drawing tools are, 
from left to right: Add Box Text tool, Add Rectangle tool, Add Round 
Cornered Rectangle tool, Add Circle/Ellipse tool, and Add Line tool. 

• The OK button is used to tell Ventura Publisher to act upon the 
option selected. You can also use the Enter (return) key. 

• The Open Chapter button is used to open a previously saved chapter 
file. When you open a chapter file, the appropriate text style sheet, 
and picture files will load already formatted. 

You'll also need to know ... 

• When loading a text or picture file, be sure you choose the 
correct file type. If your word processing software package is not 
in the text files list, you'll need to convert your text files to ASCII 
format before loading them in Ventura Publisher. (Most word pro­
cessors have an ASCII convert option.) 

• Ventura Publisher uses your original text file to format a 
document. Tag names and attribute code information are recorded 
in the original text file. You will be able to see this information 
when you open the text file with your word processing software. In 
addition, changes made using Ventura Publisher's text editor are 
recorded in the text file when you save the chapter. 

If you don't want this information in your original text file, make a 
copy of the original text file and load the copy into Ventura Pub­
lisher for formatting. 

Should you forget to make a copy, you can retrieve the backup copy 
that is made each time a chapter is saved if you have pre-selected 
Keep Backup Files in Set Preferences under the Edit menu. The 
backup copy will have the same file name as the original file, ex­
cept that the first letter of the file extension will change to a dollar 
sign ($). To save backup copies: 
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• Select Set Preferences from the Edit menu. 
The Set Preferences dialog box displays. 

• Select the Yes option in the Keep Backup Files drop-down list box. 

• Select the OK button. 

• When using your word processing package to type docu­
ments, keep the format as simple as possible. Keep the use of 
tabs, indents, centering, etc., to an absolute minimum. (It's better 
not to use them at all). Formatting should be done after the text is 
typed by using Ventura Publisher's tagging feature. 

What to do next 

Exercise 1 covered the· basic steps for formatting a document. Exercises 
2 through 10 will acquaint you with additional Ventura Publisher fea­
tures. The first page of each exercise indicates approximately how much 
time to allow yourself to complete the exercise. 

All exercises use sample files located in the Typeset directory. These files 
were loaded when Ventura Publisher was installed. To maintain unal­
tered files for future training exercises, do not save changes made during 
training. Instructions for abandoning the changes made will be given at 
the end of several exercises. If you want to print a chapter created in an 
exercise, do so before abandoning the changes. If you want to save a 
chapter file for future reference, use the Save As button in the button 
bar and rename the chapter. Instructions for saving a chapter are given 
at the end of several exercises. 
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EXERCISE 2 GLOSSARY 

The following terms can be found in Exercise 2 . 

• :. Caption file 
Mter you draw a frame, you can use Anchors & Captions to create a caption for that 
frame. This is convenient for typing a figure number and/or figure title for the pic­
ture shown in the frame. The caption is automatically attached to the frame and can 
appear above the frame, below it, or to the left or right of it. Using Ventura 
Publisher's Spell Check feature, you can make sure the text in your frames' caption 
files does not have any typos. 

.:. Clipboard 
The Clipboard is a temporary storage area that holds information you cut or copy 
from Ventura Publisher. You can insert the Clipboard contents into your Ventura 
Publisher document using the Paste command in the Edit menu . 

• :. Text files 
The files that contain the actual text. Text files can originate in another word pro­
cessor or be entered using Ventura Publisher's built-in word processor. You can load 
text files onto the underlying frame and into any frames you draw. 

.:. Undo 

40 

Lets you reverse your most recent Cut or Copy action. For example, if you cut a 
frame, you can select Undo Frame Cut to return the deleted frame to the current 
page. You must perform the Undo immediately after performing the action you want 
to Undo. 
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EXERCISE 2 

Editing text 

In this exercise you'll learn about: 

• Opening a chapter 

• Showing tab and return symbols 

• Deleting text 

• Using Undo 

• Adding text 

• Working with paragraph and line break symbols 

• Moving text 

• Copying text 

• Using the spell checker 

• Searching for and replacing text 

Approximate time to complete: 30 minutes 

Text editing changes you make to' text while using Ventura Publisher 
will be added to the original text file. If you need to make major 
changes to text, you may find it easier to use your word processor. 

You can easily use the Text Tool to add, delete, copy or move single char­
acters or whole blocks of text. In this part of the exercise, you'll use the 
&tchd-p1.chp chapter to practice using the Text Tool and then use Ven­
tura Publisher's Spell Check feature to check for misspelled words in the 
practice chapter. 

Opening (recalling) a chapter 

The Open Chapter button is used to open (recall) an existing chapter file. 
The chapter file will automatically load all Ventura Publisher compo­
nents, including the appropriate text, style sheet, and picture files . 

> Select . the Open Chapter button. 
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~ Scroll the File Name list box until you see &tchd-p1.chp. 

~ Select &tchd-p1.chp and then select the OK button. 

The chapter, style sheet, and text file load and the document displays 
on the screen. 

Displaying tabs and returns 

You may find it easier to edit text when the tab and return symbols are 
displayed. Returns are indicated by a paragraph symbol ('II). Tabs are 
indicated by an arrow (~). This makes it easy to place your mouse cur­
sor at the exact location for editing. 

~ Select the View menu. 

~ Select the Show Tabs & Returns option. (If a check mark (V') is next 
to the option, then the Show option is currently active. Move the 
cursor into the document and click the mouse button to remove the 
menu.) 

Your screen should look similar to the following illustration. 

PUBLISHING CHAPTER" 

MENU COMMANDS1I 

M",. of Ven.ur. Publi.sher', fUllC..ioru m. con.rolled !hrough !h. 
menUS' at the top cl the screen. This section descri't:es lhe operation cl 
e&eh of these men'W lind the options within them. These ccmm ands m 
~sented in the order in which they lIPpe lIr on the screen. Use the 
index for m\ alphabeticlil referenCb to these ccmmancis.iJ[ 

Manu Ol.en, u'''"''Prion will be,howningr'y """connO! behighligh .. d. 
Conventlonsll Thi.s U,.ally indic ... , !h" 1M I"'p'r func.ion h" no. beon ,elec .. d. 
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Deleting text 

There are two ways to delete single characters of text in Ventura Pub­
lisher: 

• place the cursor to the right of the text to be deleted and press the 
Backspace key 

• place the cursor to the left of the text to be deleted and press the 
Del key 

To delete a block of text, you: 

• highlight the text and either select 
pre.ss the Del key. 

the Cut Item button, or 

Note: If you have a word processing keyboard, use the Delete key on the 
keypad, not on the top row of keys. Also, regardless of your keyboard 
type, make sure the Num Lock key is off, or the Delete key will not 
work. 

You will be deleting a block of text in this exercise. 

~ Move the cursor into the working area. 

The cursor changes to I (This is called the I-beam cursor and is 
used for editing text.) 

~ Move the cursor to the left of the first "M" in the heading "MENU 
COMMANDS" (second heading on the left). 

~ Select both words by holding down the mouse button as you drag the 
cursor across the words. 

OR 

Move the cursor to the left of the first "M" and click the mouse but­
ton. Hold down the Shift key. Move the cursor to the right of the "S" 
in the word "COMMANDS" and click the mouse button. 

~ When both words are highlighted, release the mouse button. (The 
paragraph symbol 'II will not be highlighted.) 
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~ Select the Cut Item button, or press the Del (delete) key. 

The words are deleted and the typing cursor is positioned at the be­
ginning of the line. 

Using Undo 

Undo lets you reverse the effects of the previous action. For example, if 
you accidentally delete text, you can select the Undo button to reverse 
the action and return the deleted text to the current page. Undo must be 
selected immediately before performing another action; otherwise, the 
button will not be available for selection. 

To return the deleted text to its original location, before deleting any 
other characters or words, 

~ Select the Undo button. 

The text is inserted again. 

To reverse an Undo action, select the Undo button again before perform­
ing another action. 

~ Select the Undo button to delete the text again. 

Undo is also available for frames, paragraph tagging, graphics, and ta­
bles. 

Adding text 

Text may be added to a document while the Text Tool is enabled (se­
lected). Just plant the cursor at the desired location and start typing. 
For this exercise, you'll leave the cursor at its current location (i.e., 
where "Menu Commands" was deleted). 

~ Type: Ventura Publisher Menus 

If you make a mistake while typing, use the Backspace key to correct 
it. 
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Working with paragraph and line break symbols 

You can add or delete paragraph symbols (II) to control where a para­
graph ends. You can add line breaks to control where a line ends. A line 
break is a return that will break the line but will not create a new 
paragraph. 

Paragraph symbols are added by typing a return. Line breaks are added 
by holding down the Ctrl key as you type the return. 

To see the difference between paragraph breaks and line breaks: 

~ Move the cursor to the left of the "P" in "Publisher" and click the 
mouse to position the typing cursor. 

~ Press the Enter (return) key. 

A 11 symbol divides the heading into two paragraphs. Both para­
graphs are tagged as headings and have the same associated ruling 
lines and line spacing. 

~ Press the Backspace key to delete the paragraph symbol ('II). 

The heading is again one paragraph. 

~ Hold down the Ctrl key and press Enter. 

The heading breaks into two lines separated by a line break symbol 
( il ), but both lines still remain in the same paragraph. The screen 
looks similar to the following illustration. 

PUBLISHING CHAPTERl1 

Most of Ventura Publisher's functions are controlled through th& 
menus at the top cl the screen. This section describes the operation a 
eac.hof these menus lind the options WIthin them. These commands are 
pesen\ed in the order in which they ~peM' on !he screen. Use the 
index for an alphabetic~ reference to these cornm ands.~ 

Menu or.en, .menuoptian will be,howningny aMconno. behighligh .. d 
Conventlonsll This indic.", mOl <he rune.ian h .. no. been .. Ioc .. d. 

Til> 
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M,oving text 

Traditionally, layout artists use a "cut and paste" method to move blocks 
of text within a document. This involves physically cutting the typeset 
material and repositioning it elsewhere. Moving text in Ventura Pub­
lisher is much easier, even though the terminology is the same. 

>- If necessary, use the vertical and horizontal scroll boxes or scroll ar­
rows to position the text on the screen so you can read it. 

>- Position the cursor to the left of the word "Often" in the sentence 
beginning "Often, a menu option ... " next to the heading "Menu Con­
ventions." 

>- Drag the mouse until you have highlighted the whole sentence, in­
cluding the space following it. (If you need to start over, just release 
the mouse button and begin again.) 

OR 

Move the cursor to the left of the word "Often" and click the mouse 
button. Move the cursor to the space following the word "high­
lighted," hold down the Shift key, and click the mouse button. 
The screen looks similar to the following illustration. 
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Select I~ the Cut Item button. 

The text is cut from the paragraph and temporarily stored ~n the 
Clipboard. 

Important Note: When text is cut or copied, it is temporarily held in 
the Clipboard. If you want to paste the same text in a new location, do 
so before performing another cut or copy operation. The Clipboard con­
tains only the last text that was cut or copied. 

The next step is to select a location for the cut text and then "paste" the 
text in place. 

~ Move the cursor between the period and the 'II symbol at the end of 
the paragraph directly above the paragraph from which you just cut 
text, and click the mouse to position the typing cursor. (The para­
graph begins with "Most of Ventura ... ") 

Q 1 ~ "" t···· .. 

PUBLISHING CHAPTERll 

Ventura +J 
Publisher Menus" 

Ma" of Ventura Publi.shor'. fUIlCtioru are cootrolled through the 
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eac.hofthesemenU.$lIndlheoption.s within them. The.secommands are 
pre.senled in !he o~r in which they ~pe1!lr on the SCI'!en. Use the 
inde."rorflIl.~pha1:eti.eol reference t()thesecc::cmm;uu:is.~ 

Click here -----t+------~------
M~nu Thi.unally ooi:. .... that tho proper functioo h",not been .. J.c .. d 
Convenllons'll Tho table below indic .... tho.e dependoncie •. 1! .. 

~ Press the spacebar once, and then select 
ton. 
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the Paste Item but-

The text is inserted at the new location, as shown in the following 
illustration. 
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Monu 

Copying text 

PUBLISHING CHAPTERll 

Ventura ~ 
Publisher Menus'll 

Mo.sI of Ventura Pub!"h.r', functioN.,. controlled through the 
menus at the top t:i the screen. Th:i3 secticcn descrit:es 1M OJ:erarion a 
eachof these menus mld the options: within them. These commw.s are 
presen~d in the order :in which they ~pellI' on the sc~n. Use the 
index for lin &phabeticalreference 10 lhe$ecammand&.~ 
i-Jibi ii1lm, :p',;;";.}_.:, ."*'timHMHffl~ 

This usually ind~ate$ that the proper func,bon has not been selected. 

I 

Although you won't be copying text in this exercise, you should know 
how to do so. The copy procedure uses a similar procedure as the move 
procedure: 

• Select the text to copy. 

• Select the Copy Item button. 

• Move the cursor to the location where the text will be copied and 
click the mouse to select the position. 

• Select the Paste Item button. 
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EXERCISE 2 - EDITING TEXT 

Cut, copy, and paste keyboard shortcuts 

You can also use the following keyboard shortcuts for cut, copy, and 
paste instead of using the buttons. 

Action 

Cut 
Copy 
Paste 

Keyboard shortcut 

Del (delete) 
Shift + Del 
Ins 

(If you have a word processing keyboard, use the Del and Ins keys on the 
keypad, not on the top row of keys.) 

For a complete list of Ventura Publisher's keyboard shortcuts, refer to 
the Reference Guide or the Quick Reference Guide. 

Using the Spell Check feature 

Using Ventura Publisher's Spell Check feature, you can verify spelling 
and typographical errors in your documents. You can check the entire 
chapter, including caption files, headers and footers, one or more text 
files, or just the text that is currently highlighted. 

Ventura Publisher's Spell Check feature compares each word in the 
chapter against the words in its dictionary. It stops on words it does not 
recognize, such as misspelled words. Words that are not misspelled, but 
are also not in Spell Check's dictionary, such as specialized terms, acro­
nyms, abbreviations, or the names of people and companies you do busi­
ness with, can be added to a personal dictionary so that future occur­
rences of the word are not questioned. Spell Check can also call atten­
tion to errors in capitalization. 

To check the spelling in &TCHD-Pl.CHP, 

~ Select the Spell Check button. 

The Spell Check dialog box, similar to the following illustration, dis­
plays. 
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You can check the spelling of the entire chapter, only the caption files, a 
specific text file, a selected range of text, or selected files. For this exer­
cise, you'll check the spelling of the entire chapter. To do this, 

~ Make sure the Entire Chapter option button is selected, and then se­
lect the OK button. 

Context: 

Unknown Word: 
field 

Change To: 
field 

Ventura Publisher begins checking each word in the chapter against 
the words in its dictionary. When a match is found, the program goes 
to the next word in the chapter. When a questionable word is found, 
the program stops, and the following dialog box displays. 

Guess button 
[ 

[ 

[ 

[ 

[ 

r 
L 

In the upper left corner of the dialog box, the Unknown Word field dis- [ 
plays the questionable word, the Context field displays the part of the 
sentence that the questionable word was found in, and the Change To [ 
field displays the suggested replacement word. You can accept the sug-
gested replacement word, type another, or let the program Guess at an [ 
alternative replacement for the questionable word. 
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EXERCISE 2 - EDITING TEXT 

~ Review the unknown word as it appears in the Context field to verify 
that it is indeed misspelled. 

The first questionable word found in the practice chapter is "Info." "Info" 
is not misspelled, but an abbreviation for "Information." The program 
stopped on "Info" because it could not find a match for it in its dictio­
nary. Abbreviations, like "Info," can be skipped without being changed or 
added to the personal dictionary. 

To specify that Spell Check skip "Info" and continue searching for mis­
spelled words, 

~ Select the Skip ~utton at the bottom of the dialog box. 

The questionable word "Info" is skipped without being changed. Spell 
Check continues searching the chapter for the next misspelled word. 

Note: Select the Skip All button to skip all further occurrences of a word 
in the current session of Spell Check. 

The next questionable word found is "intoand." In the Change To field, 
Spell Check is suggesting the replacement word "intend," but check the 
Context field. If you read the part of the sentence where the questionable 
word was found, you'll see that a space was accidentally omitted between 
the two words "into" and "and." 

To correct the spelling error "into and" and continue searching for mis­
spelled words, 

~ In the Change To field, type: into and 

~ Select the Change button at the bottom of the dialog box to correct 
the spelling error. 

The questionable word "intoand" is changed to "into and." Spell 
Check continues searching the chapter for the next misspelled word. 

Note: Select the Change All button to change all further occurrences of 
the misspelled word in the current session of Spell Check. 

The next questionable word found in the practice chapter is "teh." This 
time, the questionable word is indeed misspelled. Check the Change To 
field to see if the correct word "the" is shown there. 

To accept the suggested replacement word and correct the spelling error, 
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~ Select the Change button at the bottom of the dialog box. 

Spell Check replaces the misspelled word with the correct word, and 
searches the chapter for the next misspelled word. 

The next questionable word found in the practice chapter is "CHP." 
When you check the Context field, you'll see that ".CHP" is not a mis­
spelled word, but a specialized term used in Ventura Publisher. Special­
ized terms, like "CHP," that Spell Check doesn't recognize can be added 
to the personal dictionary so that future occurrences are not questioned. 

To specify that Spell Check adds "CHP" to the personal dictionary and 
never question it again, 

~ Select the Add to personal dictionary check box. 

An X inside the check box indicates selection. 

~ Select the Skip button. 

Spell check adds "CHP" to the personal dictionary and continues 
searching the chapter for the next misspelled word. 

~ U sing the techniques you've just learned, finish checking the spelling 
in &TECH-P1.CHP. 

When spell checking is complete, the following dialog box displays. 

~ Select the OK button to remove the dialog box. 

If you have questions about portions of a dialog box not covered in this 
exercise, or for more information about Ventura Publisher's Spell Check 
feature, refer to "Spell Check" in the Edit Menu section of the Reference 
Guide. 
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EXERCISE 2 - EDITING TEXT 

Abandoning your changes 

To retain the original format of the &TCHD-P1.CHP files you've been 
working with, follow the steps below. 

~ Select the Revert to Saved option from the File menu. 

A warning box, similar to the following illustration, asks if you want 
to abandon your changes and revert to the previously saved version. 

~ Select the OK button 

The screen is redrawn with the document laid out In its original 
form. 

This concludes the first part of Exercise 3. In the second part of this 
exercise, you'll use the prerecorded chapter file, SCOOP.CHP in the 
Typeset directory, to learn about Ventura Publisher's Search and Replace 
feature. 
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Searching for and replacing text 

When several occurrences of a word or phrase need to be changed, it's 
much easier to let Ventura Publisher do the editing for you using its 
Search and Replace feature. 

To open the practice chapter file, 

~ Select the Open Chapter button. 

The Open File dialog box displays. 

~ Scroll the File Name list box until you see scoop.chp. 

~ Select scoop.chp and then select the OK button. 

The chapter, style sheet, and text file load and the document displays 
on the screen. [ 

When the page frame is selected, searching begins on the current page [ 
and proceeds through the chapter page by page until the last page of the 
chapter is reached. Refer to the Reference Guide for more information on [ 
starting a search. 

To ensure that the page frame is selected, [ 

~ Select the Frame Tool. 

Handles on the outside edges of the application window indicate the 
page frame is selected. 

[ 

[ 

[ 

[ 

The Search and Replace option will search for and replace text, text at- [ 
tributes, or paragraph tags in the currently loaded chapter. 

~ Select the Search and Replace button. 

[ 

[ 

The Search and Replace dialog box, similar to the following illustra- [ 
tion, displays. 
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Text Attributes 
option button __ ____ 

Search For 
entry field ---. J------,.,__,.,__-,.,__-,.,__~I-,.,__,.,__----,.,__,.,__,.,__.....,...,....,.,. 

COouble Underline 

CSbikethrl.l 

rOver.core 

CSmallText 

Replace Attributes::"::' 
r Bold CUntferline 
Chalic CDoubleUnderiine 

C Supe.script r St'iketh.u 
["Subscript rOve.sco.e 

C Normal CSmall Tellt 

F(m~J?",~faUIt I"tl .•• LuuE~~!~t~~r.~~'.~ __ u'.'~"'U~_.", ••. _.,","»uJ.:.~ 
pMat~h .Upp~~{~owe.Case 
CConfirm Replace 
rSea;chfromSlart ofChapte. 

II ieaich 

I Replace" 

Replace With 
entry field 

The Search and Replace dialog box is divided into two modes; search and 
replace text or text attributes, and search and replace tags. These modes 
are controlled by selecting either the Text/Attributes or the Tags option 
button at the top of the dialog box. 

For this exercise, you'll use the Text/Attributes mode to search the prac­
tice chapter for the text Ventura Publisher and replace it with the 
acronym VP, and also apply the replacement attribute of bold. . 

To search for all occurrences of ''Ventura Publisher," 

> Make sure the Text/Attributes option button is selected. 

> Press the tab key once. 

The text cursor blinks inside the Search For entry field. The Search 
For entry field is where you type the text you want to find (commonly 
referred to as the search string). 

> Type: Ventura Publisher in the Search For entry field. 

Note: You can refine your search further by asking Ventura Publisher to 
search for text with specific attributes or case. Refer to the Reference 
Guide for more information. 
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~ Press the tab key once to move the text cursor to the Replace With 
entry field. 

The text cursor blinks inside the Replace With entry field. The Re­
place With entry field is where you type the replacement text for the 
search string. 

~ Type: VP for the replacement text. 

Note: When replacing a word that may be part of another word, remem­
ber to type a space before and after the word. Otherwise, any occurrence 
of that word, even when it is found within other words, will be substi­
tuted with the replacement word. For example, type spaces before and 
after the word "in" to replace "in" only, and not when it appears in other 
words such as interesting, and minutes. 

Attributes for replacement text can be assigned by selecting the attri­
bute(s) from the Replace Attributes options in the Search and Replace 
dialog box. To assign the bold attribute for the replacement text, 

~ Select the Bold check box from the Replace Attributes options. 

An X inside the check box indicates selection. 

You can control the progress of the search and replace by having Ventura 
Publisher stop and pause at each occurrence of the search string. This 
lets you indicate whether or not you want to replace the word. Your 
other option is to allow Ventura Publisher to make all the replacements 
automatically. To control the progress of the search and replace, 

~ Select the Confirm Replace check box. 

An X inside the check box indicates selection. Your screen should look 
similar to the following illustration. 
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To begin the search and replace operation, 

~ Select the Replace button. 

Ventura Publisher begins searching the chapter for text matching the 
search string. When the first occurrence of 'Ventura Publisher" is 
found, the page containing the matching text is displayed, the text is 
highlighted, and the following dialog box is displayed. 

• Selecting Done instructs Ventura Publisher to stop the search and 
replace operation. Any replacements made up to the point the Done 
button is selected will not be undone. 

• Selecting Skip instructs Ventura Publisher not to make the change, 
but to leave ''Ventura Publisher" as is and proceed with the search 
for the next occurrence of ''Ventura Publisher." 

• Selecting the Replace button instructs Ventura Publisher to make 
the change and proceed with the search for the next occurrence of 
''Ventura Publisher." 

To leave this occurrence of ''Ventura Publisher" as is and proceed with 
the search, 
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~ Select the Skip button. 

The text "Ventura Publisher" is left as is. The next occurrence of ''Ven­
tura Publisher" is found and highlighted. 

To replace this occurrence of "Ventura Publisher" with ''VP'' and proceed 
with the search, 

~ Select the Replace button. 

The text ''Ventura Publisher" is replaced with the Replace With entry 
''VP'' and the next occurrence of ''Ventura Publisher" is found and 
highlighted. 

~ Continue searching for "Ventura Publisher" and replace it with "VP." 
Notice as you proceed with the search that Ventura Publisher is 
searching all frames containing text files as well as frames contain­
ing caption text and box text. 

When the search and replace is completed, the following message dis­
plays. 

~ Select the OK button to remove the message from the screen. 

[ 

[ 

This concludes the search and replace exercise. For more information 
about the power of Ventura Publisher's Search and Replace feature, refer [ 
to "Search and Replace" in the Edit Menu section of the Reference Guide. 
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EXERCISE 2 - EDITING TEXT 

Abandoning your changes 

To retain the original format of the SCOOP.CHP files you've been work­
ing with, follow the steps below. 

~ Select the Revert to Saved option from the File menu. 

A warning box, similar to the following illustration, asks if you want 
to abandon your changes and revert to the previously saved version. 

~ Select the OK button 

The screen is redrawn with the document laid out in its original 
form. 

You can now load another chapter in place of the one on the screen. You 
could also use the New Chapter button or option in the File menu to 
completely clear the screen. 
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EXERCISE 3 GLOSSARY 

The following terms can be found in Exercise 3. 

.:. Caption 
A caption is placed above, below, or to the left or right of a frame, and can be used to 
identify the picture in the frame. 

.:. Cropping 
Cropping means eliminating unwanted portions of a picture. The portions not dis­
played in the document remain stored in the original picture file. 

.:. Free frame 
A frame which does not have a frame tag assigned to it. When a free frame is 
selected, <No Tag> displays in the Tags list. This means the selected frame has 
default frame properties and is unaffected by changes made to other frames. 

.:. Scaling 
Increasing or decreasing the size of a picture. 
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EXERCISE 3 

Frames & pictures 

In this exercise you'll learn about: 

• Deleting a frame 

• Showing column guides 

• Drawing a frame 

• Loading a picture into a frame 

• Sizing and scaling a picture 

• Cropping a picture 

• Adding a caption to a frame 

• Moving a frame 

• Anchoring a frame to text 

• Adding a drawing to a frame 

• Drawing a box around a frame 

• Reducing a picture within a frame 

• Hiding pictures 

Approximate time to complete: 30 minutes 

Ventura Publisher uses frames to hold pictures, just as it uses frames to 
hold text. Using the Add New Frame Tool, you can draw a frame any­
where on the page - between paragraphs, within paragraphs, in one 
column, or stretching across several columns. For example, if you want 
to add a picture to a 3-column story on the front page of a newsletter, 
you can draw the frame for the picture across one, two, or three columns 
- depending on how much room you want allotted for the picture. 

When you add a frame to a page that contains text, Ventura Publisher 
automatically flows text around the frame. If you desire, you can have 
the text flow behind the frame to create a superimposed effect. 

Initially, frames are created without a tag assigned to them. A frame 
without a tag is known as a free frame. Frame tags, which are similar to 
paragraph tags in use, allow you to create frames very quickly and apply 
frame properties like size, ruling lines, background color, etc., in a single 
action. For more information about frame tags, refer to "Add New Frame 
Tag" in the Frame Menu section of the Reference Guide. 
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After you load a picture into a frame, you can increase or decrease the 
size of the picture, independent of the size of the frame (this is called 
scaling). You can also show only one portion of the picture and hide the 
rest (this is called cropping). 

In this exercise, you'll use the &MAG-P3.CHP chapter to practice adding 
frames and pictures. 

To open the practice chapter file, 

~ From the function buttons, select the Open Chapter button. 

The Open File dialog box displays only files with a .chp extension in 
the TYpeset directory. 

~ Select &mag-p3.chp from the filename list box, and then OK. 

The chapter, style sheet, and text files load and the document displays 
on the screen. 

~ Change to Reduced View. 

The screen looks similar to the following illustration. 
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EXERCISE 3 - FRAMES & PICTURES 

Deleting a frame 

The chapter displayed on your screen contains two frames: a large two­
column frame and a small one-column frame. You can use these frames 
to add pictures or text (either typed or from another text file). 

In this part of the exercise, you'll select and delete the one-column 
frame. (You'll redraw the frame later at the same location.) 

> Select the one-column frame (in the third column) by placing the 
cursor anywhere inside it and clicking the mouse button. 

Handles display on the outside edges of the frame, indicating that it 
is selected. Actions you take will affect this frame, rather than the 
page frame. The screen looks similar to the following illustration. 

You can now delete the frame. 

> From the function buttons, select 
the Del (delete) key. 

The frame and its caption are deleted. 

the Cut Item button, or press 
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Column guides 

64 

Notice how the third column is now filled with text. Text in the page 
frame is automatically rearranged whenever you delete, add, or change 
the size of a frame. 

Showing column guides 

When adding or moving frames, you may find it helpful to use the Show 
Column Guides option (in the View menu). Show Column Guides places a 
ghost box around each column defined in the style sheet so you can eas­
ily line up frames within the column. 

~ Select the Show Column Guides option in the View menu. (If a check 
mark (v) appears next to the option, then the Show option is cur­
rently active.) 

The screen is redrawn with ghost boxes around each column and 
looks similar to the following illustration. 

Drawing a frame 

Adding a picture in a chapter is a two-step process: 

1. Draw a frame to hold the picture. 

2. Select the picture file to load into the frame. 

The Add New Frame tool is used to draw a frame. When you start to 
draw a frame, you always place the cursor where the upper left corner 
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of the frame will be located. Then, press and hold the mouse button as 
you "drag" the mouse diagonally (down and to the right) until the frame 
outline is the size you want. 

> Select the Add New Frame tool. 

> Move the cursor into the page frame. 

The cursor changes to r indicating you're ready to draw a frame. 

> Position the cursor at the top left corner of the third column. (The 
location of the deleted frame.) 

> While holding down the mouse button, "drag" the cursor across and 
down to the right edge of the column. (Use the following illustration 
as a guide.) 

> Release the mouse button. 

End 
frame 
here 

A frame is inserted in the document. It's marked by handles on the 
edges to indicate it is currently selected (i.e., action will take effect on 
this frame). EMPTY displays in the current selection indicator, indi­
cating there is nothing in the frame. <No Tag> displays in the Tags 
list, indicating the frame has no tag assigned to it. 
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Note: If you need to resize the frame, move the cursor to one of the 
handles on the frame's edge, then hold down the mouse button as you 
"drag" the frame edge to a new location. 

Loading a picture into a frame 

When a frame is selected, any text or picture file you select will load into 
that frame. In this part of the exercise, you'll load the picture file, CHA­
NEL.IMG, into the frame you've just drawn. 

~ Be sure the frame you drew is still selected (i.e., has handles on the 
edges). If it isn't, move the cursor into it and click. 

~ From the function buttons, select the Load Text/Picture button. 

The Load Text / Picture dialog box displays. 

~ Select for File Type the Image option button. 

The image options display in the Format list box so you can identify 
the file format. 

~ Because CHANEL.IMG is in GEM format, make sure GEM/HALO 
DPE is selected for the file Format. 

~ Select the OK button .. 

The Open File dialog box displays with the last directory used (Type­
set) active and with the .img files displaying in the File Name list 
box. 

~ Select chaneLimg from the File Name list box. 

~ Select the OK button. 

After several seconds, chaneLimg is loaded into the frame. The file 
name displays in both the Files list and the current selection indica­
tor. Your page now resembles the following illustration. 
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N ext, you'll change the size of the picture in the frame. 

Sizing and scaling pictures 

There are several different ways to size pictures. The basic options for 
sizing include: 

• Fit in Frame (the picture expands or contracts to fill the frame 

• Maintain Aspect Ratio (same as Fit in Frame, except the picture's 
original height-to-width ratio is maintained) 

• By Scale Factors (the picture size is increased or decreased numeri­
cally) 

In each case, the space occupied by the picture will be increased or de­
creased by the frame's margins. 

Changing the size of a picture does not alter the original picture file. 
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Follow the steps below to change the current values in the Frame Width 
and Frame Height text boxes to 02.17, making the frame a perfect 
square. 

> Make sure the small frame containing the image is still selected (i.e., 
has handles at the frame edges). 

> From the tool option buttons, select 
ton. 

the Sizing & Scaling but-
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[ 
The Sizing & Scaling dialog box, similar to the following illustration, 
displays. (Your coordinates may be different than those in the [ 
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illustration.) 

> Press the Tab key twice to move the highlighting and the typing 
cursor (a thin bar) to the Frame Width text box. 

> If the current value is not 2.17, type: 2.17 

The current value in the text box is replaced with 2.17 

> Press the Tab key once to move the highlighting and the typing cur­
sor to the Frame Height text box. 

> If the current value is not 2.17, type: 2.17 

The current value in the text box is replaced with 2.17 
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N ext, you'll change the picture you just loaded by increasing its size and 
then cropping the picture. (Remember that changing the size of a picture 
does not alter the original picture file.) 

~ From the Picture Scaling option buttons, select the By Scale Factors 
option button. 

~ Double-click on the value inside the Pict. Width text box. 

The current value in the text box is highlighted. 

~ Type:3 
(Doubling the scale width will ensure the picture is larger than the 
frame so you can use the cropping feature in the next section.) 

~ Select the OK button. 

When the picture redraws, you will see that the image size has dou­
bled inside the frame. 

Cropping a picture 

Cropping a picture means positioning it within a frame so that only a 
portion of the picture shows. Cropping lets you display the most signifi­
cant part of the picture. 

You may find it easier to work in Normal View while cropping a picture. 

~ Change to Normal View. 

~ If necessary, use the horizo"ntal and vertical scroll bars to move the 
page so that you can see the picture in the third column. 

~ Place the cursor anywhere on the picture. 

~ Press and hold down the Alt key, and then press and hold down the 
mouse button. 

The cursor changes to a hand. ~ 

~ Move the cursor in all four directions until you are satisfied with the 
portion of the picture within the frame. (Most of the face should 
show; some hair will not show.) 
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> When the picture is positioned where you want it, release the mouse 
button and the Alt key. 

The cropped portion of the picture displays in the frame. The screen 
resembles the following illustration. Cropping and scaling instruc­
tions are stored in the chapter (CHP) file. 

Competing Technologies'll 

• DaisyWhee1~ 

• Do'M .. ril!.~ 

• Laserprinlers1[ 

• Laser printers with write.white 
~giM$ and copier options, using 
dry powder '","r~ 

Laser pinter: &till have a few areas ,ha, could b. imf<OVod. oocording 10 
Oeorge 10no,. 0 by indwllY onoly," 
He noted thaI there are no staruhrds in 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 
Note: The portions not displayed in the document are still stored in the 
original picture file. [ 
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Adding a caption to a frame 

The Anchors & Captions option allows you to place captions at a variety 
of locations around a frame. The caption is contained in a frame "tied" to 
the picture frame. Captions can contain any text you wish and can be as 
long as you like. You can also use Ventura's Table #, Figure # and Chap­
ter # counters to automatically number captions. 

Be sure the frame with the image is still selected (i.e., has handles 
on the edges). 

From the tool option buttons, select 
button. 

the Anchors & Captions 

The Anchors & Captions dialog box, similar to the following illustra­
tion, displays. 
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Caption box arrow 

Q Chapter· II 0>1 ext Attribute 

> Click on the arrow to the right of the Caption box to open the drop­
down list box. 

> Select the Below option. 

Below displays in the Caption box. 

> Click inside the Label text box. 

> Type: Fig. and press the spacebar. 

To use the automatic figure numbering feature, 

> From the Inserts options, select the Figure # option button. 

[F#] is inserted in the Label text box. 

> Press the spacebar and type: The author. 

> Select the OK button. 

The caption is added to the frame. 
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Moving a frame on a page 

As you learned earlier in the exercise, text is automatically reformatted 
when you add or delete a frame on a page. In this part of the exercise, 
you'll see how text is reformatted when you move a frame. 

You may find it easier to work in reduced view to move a frame. 

~ Change to Reduced View. 

~ Be sure the Frame Tool is enabled. 

~ Select the two-column frame (move the cursor to it and click). 

~ Press and hold down the mouse button. 

The cursor changes to + 
~ Start to drag the mouse straight up. 

As you drag, an outline of the frame follows your movements. 

[ 

[ 

[ 

[ 

~ Drag the outline until it is aligned with the top line of text Gust [ 
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below the headline "Laser Printers Arrive"). 

~ Release the mouse button. 

The frame is drawn in its new location, and the screen looks similar 
to the following illustration. 
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Anchoring a frame to text 

When you anchor a frame to nearby text, the frame and the text refer­
encing the frame remain together on the same page. This ensures that 
the frames you add to a chapter will display in the correct position on 
the page. 

Anchoring a frame to nearby text is a two-step process. (1) Attach an 
anchor reference (name) to the frame. (2) Insert an identical anchor ref­
erence in the text referring to that specific frame and then re-anchor all 
frames in the chapter. 

To anchor the frame you've been working with to nearby text, 

> Be sure the Frame Tool is enabled. 

> Be sure the large two-column frame is still selected. 

> From the tool option buttons, select 
button. 

the Anchors & Captions 

The Anchors & Captions dialog box, similar to the following illustra­
tion, displays. The typing cursor is positioned in the Anchor text box. 
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~ Delete the text: Frame 1, and type: Columbia 

~ Select the OK button. 

The anchor reference, Columbia, is attached to the frame. 

Now, insert an identical anchor reference in the text. 

~ Change to Normal View. 

~ If necessary, use the scroll bars to position the page so that you can 
see the text under the large, empty two-column frame. (Use the fol­
lowing illustration as a guide.) 

much c:l hi, g~piu~, ;ci'waxe· ..,d 
better graphics resolu~on: Jones 

oidl[ 
'The n .. t "lOp is developing generic 

;graphics drivers which tuppxt lasers ~ 
300-by-300 re,olution. Th.t', when 
You will see ahugeimplr-tondol-mallu 
l'rlnteu,bothin Fri'" and thenumberof 
)mi~ ,hipping," he ,aid, adding that it 
:wi11 be a year 10 1& months before this 
h.ppens.~ 

Jones W~ quick to point out that he 
;never sees do~-m!l.lI'ix. printers di,$l!fl~ 
!"oring. 'Multtp1e-port form, axe ,on 
~p'rlant. and an Impact pnnter is 

forth.I." H .. I,ono,ed tho! pee-
will w~t hllrd copes for 
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~ Select the Text Tool. 

~ Position the cursor to the left of the word "Speedier" in the heading 
"Speedier, Less Costly Laser ... " then click the mouse button. 

~ Select the Text menu. 

~ Select the Insert Special Item option. 

A cascading menu, similar to the following illustration, displays. 

E!tit Special Item ... Ctrl+D 

Normal 
!lold 
Italic 
Small 
SunerScript 
,SubScript 
!!nderline 
Double Underline 
Strikethru 
Qverscore 
Set Eont Attributes ... 

Change lext To ... 

~ Select the Frame Anchor option. 

Eootnote 
Index Entry ... 
J;.quation ... 
Frame Anchor ... 
!;.ross Ref... 
Marker Name ... 
:!lariable Det. .. 
lable ... 

A dialog box, similar to the following illustration, displays. The 
frame's anchor name, Columbia, was entered automatically in the 
Frame's Anchor Name text box. 
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If the text is moved (due to revisions), the frame must be moved and 
positioned above the text containing the anchor. To ensure this, 

~ Select the Relative, Above Anchor Line option button for the Frame's 
New Location. 

See: "Edit Menu" and "Frame Menu" in the Reference Guide for more 
information on the frame's new location. 

~ Select the OK button. 

Frame Anchor displays in the current selection indicator. A degree 
symbol (0) displays at the insertion point in the text to mark the posi­
tion of the frame anchor. If the text is moved, the anchored frame will 
move with the text after are-anchor. 

Note: Unless you select the Relative, Automatically at Anchor option, the 
frame will not actually move until you choose Re-Anchor Frames from 
the Edit menu. For more information about re-anchoring frames, refer to 
"Re-Anchor Frames" in the Edit Menu section of the Reference Guide. 

Adding a drawing to a frame 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 
To practice loading another picture into a frame, you'll use the 
COLUMBIA. GEM file, which is a drawing created in GEM Graph. [ 

~ Change to Reduced View. [ 

~ Select the Frame Tool. 

~ Select the large two-column frame. 

~ From the function buttons, select the Load Text/Picture button. 

The Load Text / Picture dialog box displays. 

~ Select for File Type the Line Art option button. 

The line-art options display in the Format list box so you can identify 
the file format. 

~ Because COLUMBIA. GEM is in GEM format, make sure GEM is se­
lected for the file Format. 
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>- Select the OK button. 
The Open File dialog box displays. The last directory used (\typeset) 
is still active and GEM files are shown. 

>- Select columbia.gem and then OK. 

COLUMBIA.GEM is loaded into the frame. The file name appears in 
both the Files list and the current selection indicator. Your page now 
resembles the following illustration. 

Eile ;dle.... h!p1e _ Fr""," e'lI"g" lh ~ext i'"PIlle !uble Jielp_ 

I ~ III' "TI"" 'It!tft!\ •.••....••••... 

I.I~I ij la~> 1 jjj ...< 
I~ . 

......... ~ . 
. 

Note: All features (sizing & scaling, cropping, etc.) for modifying image 
files are available for line-art files. 
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Drawing a box around a frame 

You may want to enclose text or a picture in a box to set it apart from 
the base page. 

~ Be sure the two-column frame is still selected. 

~ From the tool option buttons, select the Ruling Box Around but-
ton. 

A dialog box, similar to the following illustration, displays. 

Width box arrow 

To specify the ruling box be frame wide: 

~ Click on the arrow to the right of the Width box to open the drop­
down list box, and then select the Frame option. 

Frame displays in the Width box. 

To specify a color, and then a solid pattern for the ruling box: 

~ Select the Black option from the Color drop-down list box, and then 
the last sample pattern in the Pattern list box. 
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To specify the height of the ruling line: 

~ Click on the arrow to the right of the Style box to open the drop­
down list box, and then select the 2 point option. 

The height of the rule (2 points) displays in the dialog box im­
mediately, as shown in the following illustration. 

;m(ffffj=M"UH'H, '" ~idt~;IFrame I!I 
~tYI~:~1 ~.~. ~I ~~~~~~I !~I]·r"'I~lL-·~s-e~.-·~gD-et~· -in~e"""'··~d-.~;~""'·~·· 
~olor:.IBlack I!l 

~\r~:;;;,.,;;;:~:"7=.='~=,:,;;~~,,,;;.;;:;::.:.,;;:;:.;:;;:;:::;;;.'~;;;:;:i~;;:;::~=:~;;~,,;.,,·~~,:·~7i,,: [;;1;;;;; .. ;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;:~~~~~.l- :'~~:~dli~e ~~1~~~~~? the 

~'~In~ch=es=""'~' .:7-lHI 

n~)~f~h~;I~······················ I 

~l·~.Yfi.~~r\:~ 
cancel 

~ Select the OK button to close the Ruling Box Around dialog box. 

A ruling box is placed around the frame. The ruling box may be hid­
den by the handles on the outside edges of the selected frame. 

~ To see the ruling box, move the cursor away from the selected frame 
and click. 
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Reducing a picture within its frame 

If the top and bottom of the picture are too close to the ruling box 
around the frame, you can change the margins of the frame to allow for 
white space between the ruling line and the picture. 

> Make sure the Frame Tool is enabled. 

> Select the two-column frame again. 

> From the tool option buttons, select the Margins & Columns 
button. 

A dialog box, similar to the following illustration, displays. 

> To add white space to the top of the drawing, change the Top: (mar-

[ 

[ 

[ 

[ 

[ 

gin) value to .1 by pressing the Tab key once to highlight the current [ 
value, and then typing: .1. 

[ 
> To add white space to the bottom of the drawing, change the Bottom: 

(margin) value to .1 by pressing the Tab key two times to highlight [ 
the current value, and then typing: .1. 

[ 

[ 
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> Select the OK button. 
The margins within the frame are increased. This reduces the size of 
the picture and allows more white space between the picture and the 
frame box. 

Hiding pictures on the screen 

You've probably noticed that redrawing a page is slower when pictures 
have been added to frames. You can hide these pictures and decrease the 
time it takes to redraw the screen. This is useful when you need to make 
numerous editing changes on a page. And, because hidden pictures do 
not print, this feature can also be used to decrease the time it takes to 
print draft copies. 

While pictures are hidden, the frame and the picture it contains can still 
be moved, sized, scaled, cut, copied, and pasted. You can hide or show all 
pictures in a chapter or only selected pictures. 

To hide all pictures, 

> Make sure that no drawn frames are selected. 

> Select the View menu. 

> Select the V Show All Pictures option. 

The screen is redrawn. All pictures are replaced with screened boxes. 

Now that you've seen what hidden pictures look like, turn the pictures 
on again as follows: 

> Select the View menu. 

> Select the Show All Pictures option. 

The screen is redrawn with the pictures showing again. 
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To hide just one picture, 

~ Make sure the Frame Tool is enabled. 

~ Select the picture you wish to hide. 

~ Select V Show This Picture from the View menu. 

To show just one picture, 

~ Make sure the Frame Tool is enabled. 

~ Select the picture you wish to show. 

~ Select Show This Picture from the View menu. 
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Abandoning your changes 

This is the end of the exercise. To maintain the original format of the 
files you've been working with, follow these steps, 

> Select the File menu. 

> Select the Revert to Saved option. 

A warning box, similar to the one below, displays asking if you really 
want to abandon your changes. 

> Select the OK button. 

The screen is redrawn with the chapter in its original form. 

You can now open another chapter in place of the one on the screen. (You 
could also use the New Chapter button or the New option in the File 
menu to completely clear the screen, or use the Exit option in the File 
menu to exit Ventura Publisher.) 

83 



EXERCISE 4 GLOSSARY 

The following terms can be found in Exercise 4 . 

• :. Callout 
Text used to identify or call attention to a particular area of a picture . 

• :. Constrain 
A way to control graphics to produce a perfect circle instead of an ellipse; a square 
instead of a rectangle; or a horizontal, vertical, or 45° line. To constrain a graphic, 
hold down the Alt key when you draw or resize the graphic. 

.:. Hairlines 
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The thin lines on each ruler that follow the movement of the mouse across the page. 
Using these hairlines, you can draw and place frames and graphics to precise posi­
tions on the page. 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 



EXERCISE 4 

Using the drawing tools 

In this exercise you'll learn about: 

• Creating a new text file 

• Displaying rulers on a page 

• Using the drawing tools 

• Creating a new frame and adding a picture 

• U sing the Box Text tool 

• Drawing lines and arrows 

• Moving frames with graphic drawings 

• Drawing and shading boxes and circles 

• Activating the invisible grid 

• Changing fill attributes 

• Overlaying objects 

• Drawing perfect squares, circles and constrained lines 

• Sizing and moving objects 

Approximate time to complete: 30 minutes 

Ventura Publisher allows you to add lines, circles, and boxes without 
using an external graphics package. You can draw graphics on the base 
page to enhance your text, or draw graphics in a frame to enhance your 
pictures. 

In this exercise, you'll create a new text file and then add drawings to 
the text to practice the activities listed above. 

Before you start this exercise: 

>- Check the View menu to make sure Show Tabs & Returns is active. 
(If a check mark (v) is next to the option, then the Show option is 
currently active.) 
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~ Check the View menu to make sure Normal View is active. (If a check 
mark (v) is next to the option, then the Normal View option is cur­
rently active.) 

~ Use the View menu to turn off the column guides by selecting the 
V Show Column Guides option. 

~ If necessary, move the vertical scroll box to its top-most position and 
the horizontal scroll box to its left-most position. 

Creating a new text file 

For this part of the exercise, you'll create a new text file and then add 
drawings to the text. 

The first step in creating a new text file is to load a new style sheet. The 
style sheet used last will remain active until you load a new style sheet, 
or open a chapter that uses a new style sheet. 

~ From the function buttons, select the Load Different Style but-
ton to load a new style sheet. 

The Select Style Sheet dialog box displays. 

~ Select &ltr1-p1.sty from the files list, and then the OK button. 

The new style sheet loads. 

~ From the tool buttons, select the Text Tool to begin typing text. 

~ Place the text cursor anywhere on the page frame and then click the 
mouse button. 

The typing cursor and the End of File (0) symbol are displayed. 

(If you don't see the End of File symbol (0) on your screen, move the 
vertical scroll box to its top position and the horizontal scroll box to 
its left position. If you don't see the typing cursor on your screen, 
move the I-Beam cursor K to the left of the End of File symbol, then 
click the mouse.) 
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EXERCISE 4 - USING THE DRAWING TOOLS 

~ Type: This is a graphics drawing exercise. 

You have created a new text file. UNTITLED. TXT displays in the 
Files list, and UNTITLED.CHP displays in the title bar as the name 
of the new chapter file. 

Note: Both the text file and the chapter file remain untitled until you 
save the chapter with a new name. 

Displaying rulers on a page 

You may find it helpful to display the on-screen rulers when sizing and 
positioning pictures and graphics. 

~ Select the View menu. 

~ Select the Show Rulers option. (If a check mark (v) is next to the 
option, then the Show Rulers option is currently active.) 

The screen is redrawn with rulers across the top and down the left 
side of the page. 

Note the thin hairlines on the face of each ruler. These move as the 
cursor moves, showing the exact position of the mouse cursor on the 
screen. You can set different ruler measurement units for each of the 
rulers using the Set Rulers option in the View menu. 

~ Select the View menu. 

~ Select the Set Ruler option. 

The Set Ruler dialog box displays. 

~ For this exercise, make sure I nches is selected in both the Horizontal 
Units and Vertical Units list boxes, and then select the OK button. 
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Note: You can also adjust the rulers horizontal and vertical zero points in 
the Set Rulers dialog box. This is especially convenient when working 
with tabs, since tabs are measured from the left column edge rather 
than the page edge. 

Using the drawing tools 

Ventura's graphic tools are used to draw lines, ellipses, circles, square­
edged and rounded-edge rectangles and squares in your documents. 
There's even a tool for drawing a box in which you can type text and 
then move anywhere on the page. Once you have drawn a graphic object, 
you can assign line and fill attributes to that object. Different line and 
fill attributes can be assigned to each graphic object drawn. 

The following list describes the operations you can perform with each 
graphic tool. 

Add Box Text tool - lets you type text in a box and move it 
anywhere on the page. Box text is useful for adding callouts, 
tables, and building forms. 

Add Rectangle tool - lets you draw square-edged rectan­
gles and squares to which you can apply line and fill attri­
butes. 

Add Round Cornered Rectangle tool - lets you draw 
rounded-corner rectangles and squares to which you can 
apply line and fill attributes. 

Add CirclelEllipse tool - lets you draw circles or ellipses 
to which you can apply line and fill attributes. 

Add Line tool - lets you draw lines to which you can apply 
line attributes, such as arrows, color, and thickness. 

Frame Tool - As soon as you have drawn the graphic, the 
Frame Tool is enabled. Use the Frame Tool to cut, copy, 
paste, move, and resize graphic objects. 



EXERCISE 4 - USING THE DRAWING TOOLS 

Creating a new frame and adding a picture 

If you used any of the graphic tools now, the object you drew would be 
tied to the base page frame. Since it's usually best to tie graphics to a 
frame other than the page frame, you'll create a new frame in this part 
of the exercise. Then you'll load a line art picture into that frame, create 
a callout using the Add Box Text tool and the Add Line tool, and move the 
frame so you can see how the "tied" graphics move with the frame. 

To create a new frame: 

the Add New Frame tool. 

~ Starting one and a half inch down from the top margin and one inch 
in from the left margin, draw a frame approximately three inches 
wide and two inches deep. (Watching the hairlines on the rulers will 
help you draw the frame to these specifications.) 

The three and a half inch mark on the vertical ruler may not be 
visible on the screen; however, as you drag the Add New Frame cur­
sor down, the page will scroll down automatically. 

~ Release the mouse button. 

Handles on its edges indicate the frame is selected. 

This is a graphics dr awing exerc!se.O 
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Note that the Frame Tool is enabled. As soon as a frame is drawn, the 
Frame Tool is enabled. To load a file into a frame: 

> From the function buttons, select the Load Text/Picture button. 

The Load Text / Picture dialog box displays. 

> From the File Type options, select the Line Art option button. 

The Format list box displays the line art options. 

> Make sure the GEM option is selected for the file format. 

> Select the OK button. 

The Open File dialog box displays. The last directory opened. \type­
set, is remembered. Only .gem files display in the File Name list box. 

> Select columbia.gem 

> Select the OK button. 

columbia.gem is loaded into the frame. Your page now resembles the 
following illustration. 

This is a gra~ics drawing exerclse.tl 

The best way to call attention to a particular area of a picture is with a 
callout. Next, you will create a callout using the Add Box Text and Add 
Line tools. 
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EXERCISE 4 - USING THE DRAWING TOOLS 

Using the add box text tool 

U sing the Add Box Text tool, you can draw a box, type text in· it, and 
then move the box anywhere on the page. The Add Box Text tool is very 
useful for creating callouts to label illustrations. 

To create a callout, 

~ From the tool buttons, select the Add Box Text tool. 

~ Move the cursor to the working area of the page. 

The cursor changes to IA 

~ Drawing box text is similar to drawing a frame. Press and hold the 
mouse button and begin drawing a box approximately the same size 
and in approximately the same location as the following illustration. 

Elle Edit )flew .!:hapter Frame Earagraph 

IOIIJlIQ!Gllell ~IOOlI~lIcOLUMBIA:GEM I II 
11J1l71Q':4~I~el~lijgl"II<No Tag> I II 

This Is a graphics dr awing exercise.D 

Q 

~ Release the mouse button. 

A box text frame is inserted in the document. It's marked by handles 
on the edges to indicate it is currectly selected. Box Text displays in 
the currect selection indicator. An end of file symbol (0) displays in 
the box, as shown in the previous illustration. 
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Look at the handles on the edges of the frame containing columbia.gem. 
The light gray color of the handles indicates that the currently selected 
graphic, the box text frame, is "tied" to this frame. To illustrate this, 

~ Move the cursor away from both frames and click, then select the 
box text frame again and watch what happens. 

With the box text frame selected again, to begin typing text, 

~ From the tool buttons, select the Text Tool. 

~ Select anywhere inside the box text frame with the text cursor. 

The typing cursor (a thin vertical bar) is positioned to the left of the 
end of file symbol. 

~ Type: Tail Section 

The text is added to the box. 

Note: If you need to resize the box text frame, select the Frame Tool, 
move the cursor to one of the handles on the frame's edge, then hold 
down the mouse button as you "drag" the frame edge to a new location. 

Drawing lines with arrows 

U sing the Add Line tool, you can draw horizontal, vertical, or diagonal 
lines. Like all graphic objects, lines will be "tied" to the frame that is 
selected when they are drawn. Remember, however, that lines do not 
have to be drawn inside a frame to be tied to it. 

~ From the tool buttons, select the Frame Tool and then the 
frame containing columbia. gem (if it's not already selected). 

Handles on its edges indicate the frame is selected. 

You'll now draw a line from the box text frame to Columbia and then 
add an arrow to the end of that line to create a callout. Arrows are 
actually line attributes that you can activate and deactivate. 
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EXERCISE 4 - USING THE DRAWING TOOLS 

To draw a line, 

~ From the tool buttons, select ~ the Add Line tool. 

Move the cursor to the working area of the page. 

The cursor changes to: tJ 
~ Place the cursor at the tail section, then press and hold the mouse 

button. Drag the mouse diagonally to begin drawing a line approxi­
mately the same length and location as shown in the following 
illustration. (The line does not have to be straight.) 

A line is drawn as you move the cursor. 

~ Release the mouse button. 

Handles appear at each end of the line indicating it is selected. 

This Is a graphics dr awing exercise.D 

Note: If your line is not the way you want it when you release the mouse 
button, just select it again by moving the cursor to the handles at either 
end of the line. Then drag the cursor up or down slightly until the line is 
positioned correctly. 

..1-----------1 •• ___ Handle 
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Adjusting the attributes of lines 

You can change the appearance of the lines that you draw by using the 
Graphic buttons or Graphic menu commands. For practice, you'll add an 
arrow to the end of the line pointing to the tail section of Columbia, and 
then change the border around the box text frame. 

To activate the arrow attribute for the line, 

> The line you drew should still be selected, if not, move the cursor to 
the line and click the mouse button to select it. 

Handles appear at each end of the line, indicating it is selected. 

> From the tool option buttons, select the Set Line Attributes but-

Select end style 

ton, or select the Line Attributes option from the Graphic menu. (You 
could also use the keyboard shortcut, Ctrl+L.) 

A dialog box similar to the following illustration displays. 

Thickness list 

> From the End Style options, select the option button for the arrow 
pointing left. 

> In the Thickness list box, select the 1 pt option, and then the OK but­
ton to close the dialog box. 

An arrow is added to the end of the line, and the line thickness 
changes. (You mayor may not be able to see the difference in the line 
thickness.) 
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EXERCISE 4 - USING THE DRAWING TOOLS 

>- To see the arrow more clearly, move the cursor away from the se­
lected line and click. 

Your drawing should look similar to the following illustration. 

Elle fdlt ~Iew !;hapter F[ame Earagraph lext Graphic T!lble tlelp 

This Is a graphics drawing exercise.1J 

To change the border around the box text, 

>- Select the box text frame. (The box that contains "Tail Section.") 

Handles around the edge of a box indicate selection. 

>- From the tool option buttons, select the Set Line Attributes but-
ton, or select the Line Attributes option from the Graphic menu. 

The Line Attributes for Box Text dialog box displays. 

>- In the Thickness list box, select the None option, and then the OK 
button to close the dialog box. 

The line around the box is hidden. Only the handles are displaying. 

Since the graphics you drew (box text frame and line with arrow) are 
attached to the frame in which Columbia is loaded, the graphics will 
always stay with the frame should the frame be cut, copied, or moved. 
Ventura Publisher's frame anchoring feature (described in Exercise 3) 
could now be used to anchor the frame to the surrounding text, thereby 
anchoring the graphics to the surrounding text as well. 

>- Move the cursor inside the frame containing Columbia. 
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> Hold down the mouse button and· drag the frame an inch or two 
lower or to the right, then release the mouse button. 

The callout (box text frame and line with arrow) moved with the 
frame. 

This concludes part one of Exercise 4. Before beginning the second part 
of Exercise 4, you will need to clear the screen. 

> Select the Revert to Saved option from the File menu. 

The Save or Abandon changes message displays. 

> Select the Abandon button. 

The screen clears. 

Drawing and shading boxes 

Boxes of different sizes and shapes can be drawn with the Add Rectangle 
tools. You can choose between square corners or round corners and the 
boxes can be shaded or hollow. Using the Add Circle/Ellipse tool, circles 
and ellipses of different sizes, shapes, and shading can also be drawn. 

In this part of the exercise, you'll draw a box, and then a circle that 
overlaps the box. 

> From the tool buttons, select. the Add Rectangle tool. 

> Move the cursor into the working area of the page. 

The cursor changes to r 
> Using the rulers for reference, position the cursor in the upper left 

corner of the page approximately one inch down from the top margin 
and one inch in from the left margin. 

> Press and hold down the mouse button as you drag the cursor diago­
nally (down and to the right). Release the mouse button when you 
have drawn a box approximately one inch square. (Remember to 
watch the rulers as you draw.) 

When you release the mouse button, a gray box appears on the page~ 
Your drawing should look similar to the following illustration. 
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N ow, draw a circle, 

> From the tool buttons, select the Add Circle/Ellipse tool. 

> Move the cursor into the working area of the page. 

The cursor changes to $ 

> Position the cursor anywhere in the upper-right corner of the box. 

> Hold down the mouse button, and drag the cursor diagonally to draw 
a circle approximately the same size as the box. Then release the 
mouse hutton. (The circle should overlap the box.) 

You screen should resemble the following illustration. 
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Activating the invisible grid 

You can use Ventura Publisher's invisible grid to help you align drawings 
and frames. After the grid is activated, you will see the effect when you 
draw, move, or resize a graphic; it will "snap" (jump) to the nearest grid 
setting. To turn on the grid or change the grid increments, 

> From the tool option buttons, select the Set Grid button or the 
Grid Settings option from the Graphic menu. 

The Grid Settings dialog box displays. 

click here 

> Open the Grid Snap drop-down list box by clicking on the down arrow 
to the right of the Grid Snap box. 

> Select the On option. 

On displays in the Grid Snap box. 
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EXERCISE 4 - USING THE DRAWING TOOLS 

> Select the OK button to close the dialog box. 

The grid is now turned on. 

Changing fill attributes 

The Fill Attributes option allows you to change the fill area for graphics 
drawn with the rectangle, circle, or box text tools. Fill attributes include 
color and pattern, and also opaque and transparent qualities. 

To change fill attributes for the circle, 

> Be sure the circle is still selected. If it's not selected, click the mouse 
button anywhere inside the circle. 

> From the tool option buttons, select the Set Fill Attributes but-
ton or the Fill Attributes option from the Graphic menu. 

The Fill Attributes for Circle dialog box similar to the following 
illustration displays. 

current 
fill pattern 
for circle 

The Pattern option is used to define the shading for a graphic object. The 
fill pattern currently being used is outlined with a thin black line. 

> From the Pattern list box, select one of the lighter fill patterns avail­
able. 
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~ Select the OK button to close the dialog box. 

The shading in the circle matches the fill pattern you selected. 

To change the line attribute of the circle, 

~ From the tool option buttons, select the Set Line Attributes but-
ton or the Line Attributes option from the Graphic menu. 

The Line Attributes for Circle dialog box is displayed. 

~ From the Thickness list box, select the None option. 

~ Select the OK button to close the dialog box. 

The line around the circle is gone. Your drawing should look similar 
to the following illustration. 
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Overlaying objects 

Right now, the circle is located in front of the box, because you drew the 
circle last. You can change the order in which objects display using the 
Send to Back or Bring to Front options. 

~ Be sure the circle is still selected. If it's not selected, click the mouse 
button anywhere inside the circle. 

To send the circle to the back, 

.QB 
~ From the tool option buttons, select the Send to Back button 

or the Send to Back option from the Graphic menu. 

The circle appears to moue behind the box. 

You can also use the Bring to Front button or the Bring to Front option in 
the Graphic menu to create the same effect. 

~ From the tool option buttons, select the Bring to Front button 
or the Bring to Front option from the Graphic menu. 

The circle appears to moue in front of the box. 

Drawing perfect squares, circles and constrained lines 

Ventura Publisher allows you to draw perfect squares, circles, and con­
strained lines (that is, lines that are perfectly vertical, horizontal, or at 
45° angles). To draw a constrained square, 

~ From the tool buttons, select the Add Rectangle tool. 

~ Position the cursor to the right of the circle, as shown in the follow­
ing illustration. 

101 



EXERCISE 4 - USING THE DRAWING TOOLS 

102 

> Press and hold down the Alt key. 

> While pressing the Alt key, hold down the mouse button to draw a 
square, but this time drag the mouse straight down and not diago­
nally. 

> Release the mouse button and the Alt key. 

A perfect square is drawn. 

This is the same technique you would use to draw a constrained circle, 
only you would use the Add CirclelEllipse tool instead of the Add Rectan­
gle tool. To practice drawing a constrained horizontal line, 

> From the tool buttons, select the Add Line tool. 

> Move the cursor anywhere on the working area of the page. 

> Press and hold down the Alt key. 

> While keeping the Alt key depressed, hold down the mouse button 
and draw a horizontal line approximately 2 inches long. 

> Release the mouse button and the Alt key. 

A straight horizontal line is drawn, as shown in the following 
illustration. 
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To change the horizontal line to a 45° angle, 

> Press and hold down the Alt key. 

> While keeping the Alt key depressed, point to one of the handles on 
either end of the line, hold down the mouse button, and drag the 
handle down. 

When the cursor reaches approximately a 45° angle to the horizontal 
line, an outline of the line appears. 

> Release the mouse button and the Alt key to draw the line. 

Sizing and moving objects 

You can size and move objects, as needed. 

To size an object, 

> Move the cursor to the circle and click to select it. 

> Point to anyone of the eight handles around the circle, hold down 
the mouse button, and drag the cursor to another location. The han­
dles on the top and bottom allow you to adjust the object vertically, 
and the handles on the left and right allow you to adjust the object 
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horizontally. The handles in the corners allow you to adjust the ob­
ject both vertically and horizontally. 

The cursor changes to ~ while you are dragging the handle. 

> For more practice, select the rectangle and change its size. 

To move a box, circle, or line, all you need to do is select it (anywhere 
other thalJ. the handles), then drag the cursor to the appropriate location. 

To move an object, 

> Place the cursor anywhere inside the circle (but not on the handles). 

> Hold down the mouse button. 

The cursor changes to + 
> Drag the cursor around on the screen. 

An outline of the circle moves as you drag the cursor. 

> Release the mouse button when the circle is in the desired location. 

You can use this method to move any object including lines and frames. 
You may have noticed while you were dragging the circle around on the 
screen that it seemed to jump or "snap" to different points. The circle 
was snapping to the invisible grid which you turned on earlier in this [ 
exercise. 
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Ending Exercise 4 

Before ending this exercise, you may want to experiment with all the 
graphic tools. You may also want to select different graphic objects which 
you've drawn, size and move them, and apply some of the graphic op­
tions to change their order and attributes. 

When you've finished, 

~ Turn the rulers off by selecting tlShow Rulers in the View menu. 

>- Clear the screen by selecting Revert to Saved in the File menu. 

The Save or Abandon changes message displays. 

~ Select the Abandon button. 

The screen clears. 
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EXERCISE 5 GLOSSARY 

The following terms can be found in Exercise 5 . 

• :. Column break 
A tag that, when applied to a paragraph, forces the next paragraph to a new col­
umn. If the current page has only one column, the next paragraph is forced to the 
next page . 

• :. Indent 
The ability to move text in from the left margin. When you indent the first line of a 
paragraph, the indent length is often equal to the width of an uppercase "M" of the 
font and type size being used. The width will vary depending on the font you are 
using . 

• :. Interline spacing 
The spacing between lines in a paragraph. The Inter-Line setting in the Spacing 
option (Paragraph menu) specifies the distance from the baseline of one line of type 
to the next . 

• :. Line break 
A tag that, when applied to a paragraph, forces the next paragraph to a new line . 

• :. Page break 
A tag that, when applied to a paragraph, forces the next paragraph to the next page. 
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EXERCISE 5 

Customizing a style sheet 

In this exercise you'll learn about: 

• Changing a tag's attributes 

• Creating a new tag 

• Saving a new style sheet 

• Using a new style sheet 

• Renaming a tag 

• Removing a tag 

Approximate time to complete: 25 minutes 

Paragraph tagging is the technique that Ventura Publisher uses to apply 
(or "tag") attributes to a paragraph. A paragraph is defined as any group 
of words or numbers followed by a carriage return. A tag is the name you 
give to each set of typographic attributes applied to a particular para­
graph. Tag attributes include fonts, alignment, spacing, breaks, tab set­
tings, ruling lines, special effects, and color. A collection of tags, along 
with the current page layout and margin and column settings, makes up 
the Ventura Publisher style sheet. 

Ventura comes with many predefined style sheets in its Typeset direc­
tory. These style sheets cover a wide range of functional documents in­
cluding reports, books, and proposals. You can usually find a style sheet 
that will fit your particular application. By renaming and customizing 
the selected style sheet, you can achieve the exact design you want. 

For even greater choices, the Ventura Publisher Design Gallery provides 
additional ready-to-use style sheets that can be used as is, or with mini­
mum modification. 

To show you how easy it is to customize a style sheet, this exercise will 
let you create a letterhead template for your company by modifying the 
tags in the LTR1-P1.STY style sheet. After you complete the exercise, 
your new style sheet will look similar to the following illustration. 
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To open the practice chapter file, 

> Use the Open Chapter button to open the chapter &ltr1-p1.chp. 

> Use the horizontal scroll bar to show more of the page. 

Changing a tag's attributes 

The easiest way to create your own style sheet is to modify the tags in 
an existing style sheet and then save the modified style sheet under a 
new name. By starting with an existing chapter that uses a style sheet 
similar to the one you want to create, you can quickly see how your 
changes will look on existing text without creating a new style sheet 
from scratch. And by saving the modified style sheet under a new name, 
you can modify it as desired without affecting the original style sheet 
that you copied it from. 

You'll use the Paragraph menu, shown in the following illustration, to 
view and change attribute settings for tags in the &ltr1-p1.sty style sheet. 
Each option you select from this menu displays a dialog box. If you have 
questions on areas of a dialog box not covered in the exercise, refer to 
the Reference Guide for more information. 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 



EXERCISE 5 - l;US I UMILINl:i PI ti I Y Lt: ~nt:t: I 

Alignment ... 
.s.pacing .. . 
Breaks .. . 
Iab Settings ... 
Special Effects ... 
Attribute Qverrides ... 
Earagraph Typography ... 

Ruling Line Abo~e .. . 
Ruling Line Below .. . 
Ruling Bo~ Around .. . 

Auto-Numbering ... 
Q.efine Colors ... 

Add Ne~ Tag... Ctrl+2 
l!pdate Tag List... Ctrl+K 

The Paragraph Tool is the paragraph tagging instrument used to select 
paragraphs. When you select a paragraph, you activate the tag for that 
paragraph thereby allowing you to change the tag's attributes or assign 
another tag from the Tags list. A tags attributes can be modified using 
either the Paragraph Tool options in the Button Bar or the menu options 
in the Paragraph menu. 

As you work through the following steps, you'll learn how to modify the 
attributes for the Name tag. 

> From the tool buttons, select the Paragraph Tool. 

When the Paragraph Tool is active, you can select any paragraph by 
clicking the mouse on any part of the paragraph. 

> Move the cursor into the working area. 

The cursor changes to rg . 

> Move the cursor to the text "Ajax Corp." and click the mouse button 
to select the paragraph. 

Name, the tag name for the paragraph, displays in the current selec­
tion indicator and in the Tags list. 

You'll practice modifying the Name tag by increasing the font size from 
18 to 24 points and by adding a shaded frame wide box around the para­
graph. 
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~ From the tool option buttons, select the Font button. 

The Font dialog box, similar to the following illustration, displays. 

Custom Size 

[ 

[ 

[ 

text box [ 
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The options in the Font dialog box allow you to change the typeface, type 
size, type style (bold, italic, etc.), color, and attributes (overscore, under­
line, etc.) for the selected tag. 

To increase the type size, 

~ Select 24 in the Size list box 
(If your printer does not support 24 point type, this option won't be 
shown -- simply select another size. Some printers have custom font 
sizes. If your printer has custom font size capability, in the Custom 
Size text box, delete the 18 and enter 24.) 

~ Select the OK button. 

The type size of "Ajax Corp." changes to 24-point type. 

Note: As soon as you select the OK button, every paragraph in the chap­
ter already formatted with the Name tag will change to the new type 
size. 

To add a shaded ruling box around the paragraph "Ajax Corp.", 

~ From the tool option buttons, select 
ton. 

the Ruling Box Around but-

The Ruling Box Around dialog box displays, as shown in the follow­
ing illustration. 
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The Ruling Box Around dialog box allows you to add up to three ruling 
lines around a paragraph (see the Reference Guide), creating a box effect, 
and to specify line 'attributes for those lines such as, width, height, color, 
and pattern. 

To specify that the ruling box be frame wide, 

~ Select the down arrow to the right of the Width list box. 

The Width drop-down list box displays. 

Notice the options available to you. In addition to Frame, you could also 
specify that the box around "Ajax Corp." be Text, Margin, Column, or a 
Custom width. For this exercise, you'll specify the box be Frame wide 
which means the box width equals the width of the page frame. 

~ Select the Frame option in the Width drop-down list box. 

Frame displays in the Width list box. 

The Style drop-down list box allows you to select from a number of pre­
defined line styles. To specify the height of the ruling box around "Ajax 
Corp.", 

~ Select the down arrow to the right of the Style list box. 

The Style drop-down list box displays. 
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~ Select the 3 point option. [ 

A sample 3 point ruling line displays in the dialog box to aid in [ 
determining the proper line thickness and spacing. 

[ 

The Color list box allows you to select a color for the ruling box. To [ 
specify a color for the ruling box around "Ajax Corp.", 

~ If Black is not displaying in the Color list box, select the down arrow 
to the right of the Color list box, and then the Black option. 

Black displays in the Color list box. 

The Pattern list box allows you to select from eight pre-defined patterns 
ranging from very light to solid. The pattern currently being used is 
outlined with a thin black line. To specify a pattern for the ruling box 
around "Ajax Corp.", 

~ Select the lightest pattern in the Pattern list box. 

A sample of the patterned line displays in the dialog box to aid in 
determining the pattern. 

~ Select OK to close the Ruling Box Around dialog box. 

A shaded ruling box is drawn around ''Ajax Corp." 

You've completed the modifications to the Name tag. Each time you as­
sign the Name tag to a paragraph, the new attributes you set (the large 
type size and ruling box around the paragraph) will be assigned to that 
paragraph. 

Creating a new tag 

New tags can be added to a style sheet at any time by using the Add 
New Tag option. First, select a paragraph with attributes similar in de­
sign to the tag you want to create, then select the Add New Tag button or 
the Add New Tag menu option from the Paragraph menu. 

You'll practice creating a new tag, and then practice modifying the new 
tag by changing the paragraphs horizontal alignment from center to left, 
and then defining a thick, shaded ruling line to display over the para­
graph. 
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EXERCISE 5 - CUSTOMIZING A STYLE SHEET 

Note: Although Ventura Publisher will allow you to define up to 128 dif­
ferent tags per style sheet, most good designs use very few different 
tags. 

To create a new tag, 

> Be sure Ir'] the Paragraph Tool is selected. 

> Select the paragraph: 123 Sapporro Road 

Address, the name of the tag, is displayed In the current selection 
indicator and the Tags list. 

> Select the Add New Tag button. 

The Add New Tag dialog box, similar to the following illustration, 
displays. 

To copy the attributes 
from a tag other than 
the one selected, 
select the tag name 
from the drop-down 

Copy attributes from this tag-lt~~~~_;;,,-.-,,,,,~.-.-:.-,-~IJ.~d(jlre~~s 12'l~11+III- list box . 
•.•••••..•.•.• ,.::=:::::::::::::::::::::::::::::::::::::::::::~ 

Type new tag name here -R-ffff.fj~:H.f'ffirij··r:'··' •.••• ·.-•.• ~)iiij •.. ~~~~~~~~~n 

Address displays as the tag name to Copy From to indicate that the new 
tag will initially use the settings of the Address tag. The text cursor is 
positioned in the Name to Add text box. 

> In the Name to Add text box, type the new tag name: Street 

> Select the OK button. 

The paragraph is now assigned the tag name "Street." The new tag 
name, "Street" is displayed in the current selection indicator and is 
added to the alphabetized Tags list. 

Note: Choose tag names that make it easy to see the hierarchy between 
related tags when looking at the Tags lists. 
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Notice that the Address tag is still in the Tags list. If necessary, you 
could re-tag the street address paragraph using the Address tag after 
adding the new Street tag. 

Modifying the alignment of the new tag 

The Alignment option controls the way in which text lines up within a 
column. To change the horizontal alignment from center to left in the 
Street tag, 

~ From the tool option buttons, select. the Alignment button. 

The Alignment dialog box displays. 

~ Select the Left option from the Horz. Alignment drop-down list box. 

~ Select the OK button. 

The street address is now aligned with the left column guide; this 
type of alignment is also known as "ragged right." 

Adding a shaded ruling line 

N ext, you'll use the Ruling Line Above option to define a thick, shaded 
ruling line that will display over the paragraph. 

~ Make sure the paragraph 123 Sapporro Road is still selected. 

To specify that the ruling line be thick and shaded, 

~ From the tool option buttons, select 
ton. 

the Ruling Line Above but-

The Ruling Line Above dialog box displays, as shown in following 
illustration. 
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If the Ruling Line Above dialog box looks familiar to you, it's because all 
three ruling dialog boxes, above, below, and around are basicly laid out 
the same, only the titles of the dialog boxes are different. And like Rul­
ing Box Around, the Ruling Line Above dialog box allows you to add up 
to three ruling lines above a paragraph, and to specify line attributes for 
those lines such as, width, height, color, and pattern. 

To specify that the ruling line be frame wide, 

~ Select the Frame option from the Width drop-down list box. 

Frame displays in the Width list box. 

To specify a ruling height of one quarter of an inch, and to adjust the 
spacing so that the rule displays over the paragraph, you'll need to use 
the U ser-Defined option in the Ruling Line Above dialog box. 

~ Select the User-Defined button. 

The User-Defined Ruling Style dialog box displays, as shown in the 
following illustration. The User-Defined option is where custom rul­
ing styles are defined. 
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Enter the height 
of the first rule 
here - .25 (one 
quarter of an 

~~-inch). 

Entering a negative num­
ber here will cause the 
rule to be moved down 
over the paragraph. 

i=======i 
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~ Press the Tab key once to move the highlighting and the text cursor 
to the Height of Rule 1 text box. 

~ Type: .25 

The text in the box is replaced with .25 (inches). 

~ Highlight the current value in the Space Below Rule 3 text box by [ 
double-clicking inside the text box. ' 

A sample ruling line (one quarter of an inch) displays in the lower [ 
left corner of the dialog box to aid in determining the proper line 
thickness. [ 

~ Type: -.22 (Typing a negative value in this text box will cause the [ 
ruling line to be moved down so it will be displayed on top of the 
paragraph. [ 

The settings in your dialog box should look identical to those in the 
following illustration. [ 
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> Select the OK button to close the User-Defined Ruling Style dialog 
box. 

The Ruling Line Above dialog box displays. 

To specify a semi-transparent shaded pattern for the ruling line so the 
text underneath will show through, 

> Select the lightest pattern in the Pattern list box. 

A sample of the patterned line displays in the dialog box. 

> Select the OK button to close the Ruling Line Above dialog box. 

The shading displays over the paragraph "123 Sapporro Road." 

You've completed the modifications to the Street tag. Each time you as­
sign the Street tag to a paragraph, the new attributes you set (left hori­
zontal alignment and a shaded ruling line over the text) will be assigned 
to that paragraph. 

Modifying line breaks 

As you work through the steps in this part of the exercise, you'll learn 
how to move the next two paragraphs onto the same line as the street 
address. 

The Breaks option sets the paragraph break conditions for the selected 
tag. Mter a break, the next paragraph can begin on a new line (line 
break), at the top of a new column (column break), at the top of a new 
page or frame (page break), or at the top of the next left or right page or 
frame (page break before/untilleftlright). 

The Line Break options in the Breaks dialog box control whether space is 
added between paragraphs. You can define a line to break before, after, 
or both before and after a paragraph, or not at all. 

> Select the paragraph: Palos Verdes, CA 90274 

Address is displayed in the current selection indicator and the Tags 
list. 

117 



EXERCISE 5 - CUSTOMIZING A STYLE SHEET 

You'll practice modifying the Address tag by changing the line break 
from "Before" to "None." This modification will cause the Address para­
graph to display on the same line as the Street paragraph by eliminating 
the space before the paragraph. And because the horizontal alignment 
for the Address paragraph is still center, the two paragraphs will not 
display on top of each other. 

> From the tool option buttons, select the Breaks button. 

Line Break option 

The Breaks dialog box is displayed, as shown in the following 
illustration. 
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> From the Line Break (not Page Break) options, select the No option [ 
button to specify that there should not be a line break after this 
paragraph. [ 

> Select the OK button. [ 

Palos Verdes, Ca 90274 and 123 Sapporro Road are now positioned 
on the same line. [ 

[ 

> Select the paragraph "(555) 541-1234". [ 

Phone is displayed in the current selection indicator and the Tags 
list. [ 

You'll practice modifying the Phone tag by changing the paragraphs hori- [ 
zontal alignment from center to right, and then the line break from "Be-
fore" to "Mter." These modifications will cause the Phone paragraph to [ 
display on the same line as the Street and Address paragraphs, but align 
with the right column guide. [ 

[ 
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~ From the tool option buttons, select li~ the Alignment button. 

The Alignment dialog box displays. 

> Select the Right option from the Harz. Alignment drop-down list box. 

Right displays in the Horz. Alignment list box. 

> Select the OK button. 

The phone number is now aligned with the right column guide. 

> From the tool option buttons, select 

The Breaks dialog box displays. 

the Breaks button. 

> From the Line Break (not Page Break) options, select the After option 
button to specify that the line should break after the paragraph. 
(You're specifying the line to br.eak after instead of not at all to main­
tain the space between the Phone paragraph and the next paragraph 
down.) 

> Select the OK button. 

The phone number is now positioned on the same line with the street 
and city information. 

For more practice 

You have now performed some of the basic steps necessary to modify and 
add a new tag. For more practice, in the body of the document, you'll 
reduce the inter-line spacing and indent the first line of text. 

> Be sure the Paragraph Tool is selected. 

> Select the first paragraph in the letter starting with "It has been 
called ... " 

Body Text is displayed in the current selection indicator and the Tags 
list. 

119 



EXERCISE 5 - CUSTOMIZING A STYLE SHEET 

120 

To indent the first line of text for the selected tag, 

> From the tool option buttons, select 

The Alignment dialog box displays. 

the Alignment button. 

> Be sure Indent is selected for the First Line option, then position the 
typing cursor in the In/Outdent Width text box (if it is not already 
there). 

> Type the indent width: .1 

> Select the OK button. 

The first line of every paragraph tagged with Body Text is indented 
one-tenth of an inch. 

The Inter-Line option in the Spacing dialog box controls the space be­
tween the lines of a paragraph. To reduce in half the inter-line spacing 
for the selected tag, 

> From the tool option buttons, select 

The Spacing dialog box displays. 

the Spacing button. 

> Double-click inside the Inter-Line text box to hightlight the current 
value. 

> Type: 14 for the new inter-line spacing value. 

14 replaces 28 for the inter-line spacing value. 

> Select the OK button. 

Both paragraphs tagged with the body text tag are now single spaced, 
and the first line of each paragraph is indented. 

Note: A good rule of thumb is that Inter-Line spacing should be roughly 
1.2 times the font size. Thus, a tag which uses 12 point type should have 
14 points of inter-line spacing. 

For more information on inter-line spacing, and the other spacing op­
tions in the Spacing dialog box, refer to "Spacing" in the Paragraph 
menu section of the Reference Guide. 
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Next, you'll practice adding another new tag and then modifying its at­
tributes to indent a paragraph from both the left and right margins. 

> Select the paragraph beginning with: "Thank you for buying. 
(Use the vertical scroll bar if necessary.) 

Body Text displays in the current selection indicator and Tags list. 

> From the tool option buttons, select If*~l the Add New Tag button. 

The Add New Tag dialog box displays. 

" 

> In the Name to Add text box, type: Indent (Be sure Body Text is 
shown in the Copy From text box so the body text tag's attributes 
will be copied into your new tag.) 

> Select the OK button. 

Indent displays in the current selection indicator and Tags list. 

The In From Left and In From Right options in the Spacing dialog box are 
used to set temporary margins. In From Left is measured from the left 
column edge, and In From Right is measured from the right column edge. 

> From the tool option buttons, select the Spacing button. 

> To indent the paragraph from both the left and right margins, type 
the following measurements for the options listed below: 

In From Left: 30 points 
In From Right: 30 

> Select the OK button. 

The paragraph is indented in from both the left and right. 
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Saving a modified style sheet 

Always save modifications to existing style sheets under a new name 
unless you want those modifications to affect other chapters using the 
same style sheet. This preserves the original style sheet by saving the 
changes to a new file name. 

To save the modified (&LTR1-P1.STY) style sheet under a new file name, 

> Select the Save as New Style button. 

The Save File As dialog box displays. The appropriate subdirectory 
and files (.STY) are displayed. 

> Type a file name for the new style sheet: LTRHD 
(It is not necessary to add the extension .STY as it will automatically 
be added.) 

> Select the OK button. 

The style sheet is saved under the new name. 

Note: Remember that saving the chapter after modifying its style sheet 
or saving a modified style sheet under its original name will change the 
look of all other chapters that use the same style sheet. Therefore, if you 
want to maintain the integrity of your original style sheet, save the mod­
ified style sheet under a new name before you save the chapter. (Saving 
a chapter first will automatically save modifications to the original style 
sheet.) 

Using the new style sheet 

The steps in this section show you how to create your own personalized 
letterhead template using the style sheet you created earlier in this exer­
cise. First, you'll remove the existing text from the sample chapter, and 
then add a frame to hold the letterhead. The letterhead frame allows you 
to load a different text file for the body of each letter without having to 
recreate the letterhead every time. 
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To create your own personalized letterhead template, 

f[J 
~ From the function buttons, select • the New Chapter button. 

The following message is displayed. 

~ Since you want to create a new template chapter without saving the 
changes to the original chapter, select the Abandon button. 

The Open File dialog box displays. The appropriate subdirectory and 
files (.STY) are displayed. 

~ Select the Cancel button. 

The screen is cleared and ready for a new document. The modified 
LTRHD.STY style sheet is still active, but the text file and chapter file 
have been removed. 

~ Change to Reduced View so you can see the whole page. (If you have 
a full-page display, you can use the scroll bar to view the entire 
page.) 

~ Select the Show Column Guides and Show Ruler options from the 
View menu so you can see the page margins and use the rulers for 
drawing a frame. (If a check mark (V') is next to these options, then 
they are currently active.) 

To create a new frame to hold your company's letterhead, 
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~ Point to the upper left corner of the column and then draw a large 
frame across the top of the page similar to the following illustration. 

Now you can type your company's letterhead text into the frame. 

~ Change back to Normal View. 

~ From the tool buttons, select the Text Tool. 

~ Move the cursor inside the frame you just created and click the 
mouse button to position the typing cursor. 

The typing cursor is located to the left of the end of file symbol (0), 
indicating that you can begin typing. 

~ Type your company's name, then press the Enter (return) key. 

The text is entered into the frame as Body Text. (Body Text is the 
default paragraph tag.) 

~ Type your company's motto (if desired), then press the Enter key. 

~ Type your company's street address, then press the Enter key. 

~ Type your company's city, state, and zip, then press the Enter key. 
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>- Type your company's phone number, then press the Enter key. 

Your screen should look similar to the following illustration. 

Your Company's Nameft 

Your company's mottoft 

Street Addressft 

City, State, Zipft 

Phone Numberft 

o 

Now use the Paragraph Tool to assign tags to each paragraph. 

>- From the tool buttons, select the Paragraph Tool. 

>- Tag each of the paragraphs by selecting a paragraph and then select­
ing a tag from the Tags List as follows: (You may need to use the 
Tags list scroll bar to see some of the tag names.) 

• 
Your Company's Name - tag as Name. 
Your Company's Motto - tag as Motto . 
Street Address - tag as Street. 
City, State, Zip -tag as Address. 
Phone Number - tag as Phone. 

Your screen should look similar to the following illustration. 
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o 

Your template is now complete, and you are ready to save your work as 
a new chapter file. 

> From the function buttons, select the Save As button. 

The Save File As dialog box (with the. CHP files) is displayed. 

> Type the name of the letterhead template chapter: LTRHD (It is not 
necessary to add the extension .CHP as it will automatically be 
added.) 

> Select the OK button. 

The template is saved as a chapter file. 

When you are ready to create a letter, you can open this chapter, select 
the page frame (using the Frame tool), and load a text file containing a 
letter. (You can create the letter with your word processor, or you can 
type the text directly into a Ventura Publisher text file.) After you print 
the letter, you can save it as a chapter (using a new name), or abandon 
the changes if you don't need to keep a copy of the letter. Either way, 
your letterhead template is stored, ready for you to use again and again. 
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Renaming a tag 

The Update Tag List option provides several tools to help you manage the 
paragraph tags that are stored in the style sheets. In the last part of 
this exercise, we will examine a couple of these tools. 

Existing paragraph tags can be renamed using the Rename Tag tool in 
the Update Tag List option. When you change a tag's name, the current 
style sheet (the name that is displaying in the title bar) is the style sheet 
that will be updated. 

Note: Always save the chapter you're working with before using the Up­
date Tag List option, especially if you plan to use the Save As option to 
save the chapter. Otherwise, the following message will display. You will 
then have only the choices of saving over the existing chapter or aban­
doning your changes. 

To rename an existing paragraph tag, 

~ Select the Paragraph Tool. 

~ From the tool option buttons, select 
ton. 

the Update Tag List but-

The Update Tag List dialog box, similar to the following illustration, 
is displayed. 
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> From the Tag list, select Address for the tag name to be renamed. (It [ 
may already be selected.) 
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Note: The Body Text tag is reserved by Ventura Publisher and cannot be 
renamed. 

> Select the Rename Tag button. 

The Rename Tag dialog box, similar to the following illustration, is 
displayed. The typing cursor is positioned in the New Tag Name text 
box. 

> In the New Tag Name text box, type: City. 

> Select the OK button. 

The Address tag is renamed City and is reordered alphabetically in 
the Tag list. The Update Tag List dialog box continues to display. 
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Removing a tag 

You can also use the Update Tag List dialog box to remove a tag from 
the current style sheet. For practice, follow the steps below to remove 
the paragraph tags Change Bar and Page Break from the Itrhd.sty 
style sheet. 

~ From the tag list, select Change Bar for the tag name to be removed. 

~ Select the Delete Tag button. 

The Delete Tag dialog box, similar to the following illustration, ~s 
displayed. 

Name to .k0llvert to: 

All paragraphs tagged with the Change Bar tag must be converted to 
another tag. By default, the affected paragraphs will be converted to 
Body Text. You can change the default tag name by selecting another tag 
from the Name to Convert to drop-down list box. 

~ Select the OK button. 

"Change Bar" is removed from the list of tags. The Update Tag List 
dialog box continues to display. 

~ Repeat the process to remove the tag name Page Break. 

Remember that removing a tag from a style sheet affects all chapters 
that use the style sheet. All paragraphs previously tagged with the tag 
name you removed will be converted to Body Text (or the tag name you 
specified). 

To avoid changing the format of other documents that use the Itrhd.sty 
style sheet, use the Save As New Style option in the Update Tags List 
dialog box to save the style sheet under a new name. 
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> Select the Save As New Stylesheet button. 

The Select Style Sheet dialog box (with the .STY files), similar to the 
following illustration, is displayed. 

> Type the name: LTRHEAD 

> Select the OK button. 

The style sheet is saved under the new name. The Update Tag List 
dialog box continues to display. 

> To close the Update Tag List dialog box, select the OK button. 

Viewing tags in style sheets 

When you begin working on your own documents, you may want to use 
the prerecorded style sheets provided with Ventura Publisher to create 
your style sheet(s). Appendix L of the Reference Guide contains samples 
of the style sheets in the Typeset directory that are provided for your 
use. 

Mter you find the style sheet that best suits your needs, open the associ­
ated chapter and look at the layout and the specific tags, as described 
below. (You may want to use a combination of style sheets to create your 
own document, or, you may just want to see how a certain effect was 
accomplished.) 

As you have learned, you specify a chapter's format by using the com­
mands in the following menus: 
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• The Chapter menu contains the options used to set up the page 
layout (paper size, portrait or landscape), headers, and footers, etc., 
for the entire chapter. 

• The Frame menu contains the options used to set up the margins, 
columns, and frame ruling lines, etc., for each frame, including the 
page frame. 

• The Paragraph menu contains the options used to define the typo­
graphic characteristics (type style, justification, paragraph ruling 
lines, etc.) for each individual tag contained within a style sheet. 

The following steps describe how to examine the attributes of a style 
sheet when a chapter file is open. 

To examine the attributes for a specific paragraph tag, 

~ From the tool buttons, select the Paragraph Tool. 

~ Select the paragraph whose attributes you want to examine. 

~ Select from the following options in the Paragraph menu: 

• 

• 

Font Settings 
Alignment 
Spacing 
Breaks 
Tab Settings 
Special Effects 
Attribute Overrides 
Paragraph Typography 
Ruling Lines 

~ Note the characteristics displayed in the dialog box for the particular 
paragraph tag you selected. Many of the dialog box options show 
default values because Ventura Publisher makes "intelligent" choices 
for most settings. Usually, you only need to change one or two op­
tions in a dialog box to get the effect you want. 

~ Select the Cancel button to ensure the original settings are not 
changed. 

~ Repeat the previous steps for each option in the Paragraph menu. 
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To examine the chapter layout, 

~ Select from the following options in the Chapter menu (The Chapter 
menu does not require a specific tool be activated to access its fea­
tures.) 

• 

Page SizelLayout 
Chapter Typography 
Headers & Footers 
Footnote Settings 

~ Note the characteristics displayed in the dialog box. As with the 
Paragraph menu, many of the Chapter menu dialog boxes show de­
fault values. 

~ Select the Cancel button. 

~ Repeat the previous steps for each option in the Chapter menu. 

To examine the layout for the page frame, 

~ From the tool buttons, select the Frame Tool. 

The page frame should automatically be selected. If not, point to the 
page frame and click. 

~ Select from the following options in the Frame menu: 

Margins & Columns 
Sizing & Scaling 
Frame Typography 
Anchors & Captions 
Repeating Frame 
Vertical Rules 
Ruling Lines 
Frame Background 

~ Note the characteristics displayed in the dialog box. Like the Para­
graph and Chapter menu dialog boxes, many of the options show 
default values. 

~ Select the Cancel button. 

~ Repeat the previous steps for each option in the Frame menu. 
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Note: You can also examine the attributes of a specific frame in a chapter 
by selecting the frame and then selecting the Frame menu options. 

To save the changes made to Itrhd.chp. 

~ From the function buttons, select the Save button. 

~ Leave Itrhd.chp loaded to use for the next exercise. 
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EXERCISE 6 GLOSSARY 

The following terms can be found in Exercise 6. 

.:. Chapter file 
A combination of text and picture files, formatted with a style sheet. A chapter file 
contains pointers to each of these files, along with instructions on how to combine 
them on the computer screen or printer. All Ventura Publisher documents are saved 
as chapters. 

.:. Publication 
A collection of chapter files. You use the Manage Publication option in the File menu 
to create a publication. Once created, you can copy, renumber, or print every page in 
the publication. You can also create a table of contents or indexed for all the chap­
ters in the publication, as well as copying the publication chapters to another loca­
tion on your computer's hard disk or onto a floppy disk. 
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EXERCISE 6 

Creating a publication 

In this exercise you'll learn about: 

• Creating a publication 

• Reordering chapters within a publication 

• Opening an existing publication 

• Adding a chapter to a publication 

• Removing a chapter from a publication 

• Printing a publication 

• Copying a publication (You will need a blank formatted disk for 
this part of the exercise.) 

Approximate time to complete: 25 minutes 

A publication is a collection of chapter files that typically have a common 
ingredient. For example, a publication might contain the chapters in a 
book or a manual. The publication for this Training Guide, for instance, 
comprises the cover page and table of contents, every exercise, and the 
questionnaire and index. 

A publication can contain up to 128 chapters. Mter you create a publica­
tion, you can: 

• Generate a table of contents and index 

• Print the publication 

• Renumber the pages for the entire publication 

• Copy all files associated with a chapter or publication to another lo­
cation on your computer's hard disk or onto a floppy disk 

Note: The only way to copy a chapter or a publication to another disk or 
diskette is to use Copy All in the Multi-Chapter Operations dialog box. 
Do not use the Windows File Manager or the DOS COpy command to 
copy chapters, Ventura Publisher may not be able to find the files associ­
ated with the chapter or publication. 
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In this exercise, you'll use chapters in the Typeset directory to create a 
publication and practice using it. 

The Manage Publication option in the File menu opens a Multi-Chapter 
Operations dialog box that lets you build a list of chapters which can 
then be saved as a publication. 

~ Select Manage Publication from the File menu. 

A dialog box, similar to the one below, displays. Either the current 
chapter or the last publication opened is displayed in the publication 
list. (If you have made changes to the chapter or style sheet since it 
was last saved, a message displays asking you to save or abandon the 
changes. Select the appropriate option.) 

publ~atlon I~t~~~~~~~~~~~~~~~~~~~~~~~~~~ Add II Chapter 
Open------~------------~ 

If you want to create a publication that does not include the chapter 
already displayed, select the New button. The chapter files removed with 
the New option are not altered or deleted. 

~ Select New to remove ltrhd.chp from the publication list. 

Untitled.pub displays above the publication list. Open and Add Chap- [ 
ter are the available options. This means that you can either open an 
existing publication or add chapters to the list to create a new publi- [ 
cation. 

~ Select Add Chapter to begin creating a new publication. 

The Open File dialog box displays. Make sure the directory name is 
\ typeset. 

~ Select &book-p1.chp and then OK. 

The Multi-Chapter Operations dialog box displays. The first chapter 
is added to the publication list. 
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> Select Add Chapter to add another chapter to the new publication. 

The Open File dialog box displays. 

> Select &book-p2.chp. and then OK 

The Multi-Chapter Operations dialog box displays. The second chap­
ter is added to the publication list. 

> U sing the technique you just learned to add the first two chapters to 
the new publication, add these chapters: 

• &bro-12.chp 

• &bro-p3.chp 

Note: If you make a mistake and add a chapter that you don't want, 
select that chapter name in the publication list and then the Remove 
Chapter button. 

When you've finished adding chapters, to save the list as a new publica-
tio~ . 

> Select Save As in the Multi-Chapter Operations dialog box. 

The Save File As dialog box displays. 

> Type the publication file name: MYPUB in the File Name text box. 
(It is not necessary to add the extension .PUB as it will automati­
cally be added when the publication is saved.) 

> Select OK 

The Multi-Chapter Operations dialog box displays the name of the 
publication above the list box. (If the publication name already exists, 
you will be asked if you want to overwrite the existing file or create a 
new name for the publication. For this exercise you should copy over 
the existing file by selecting Overwrite.) 

Note: You are actually saving nothing more than a list of chapter names. 
The individual chapters and their associated text and picture files have 
already been saved. 

After saving a publication, you can see what text, picture, or style sheet 
files are associated with a chapter. 

To see all files in a chapter, 

> Select anyone of the four chapters in the publication list. 
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~ Select Open in the Multi-Chapter Operations dialog box. 

The files associated with that chapter display in the publication list. 

~ Select Close in the Multi-Chapter Operations dialog box to return to [ 
the original publication list. 

Note: If you use the Open feature before saving the publication, you will [ 
be given the choice of saving or abandoning the changes to the publica-
tion. [ 

That is all there is to creating a publication. If you were ready to exit [ 
the Multi-Chapter Operations dialog box, you would select OK now. How-
ever, for the purposes of training, keep the Multi-Chapter Operations [ 
dialog box opened. 
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EXERCISE 6 - CREATING A PUBLICATION 

Reordering chapters within a publication 

The order in which chapters are placed in the publication list determines 
the order for renumbering chapters, generating a table of contents, and 
printing a publication. If the chapters are ordered incorrectly, index en­
tries will also be incorrect if the Previous Number + 1 option has been 
selected in the Update Counters dialog box (Edit Menu). 

To practice rearranging the order of the publication list so the first chap­
ter becomes the last chapter in the list, 

~ Select the first chapter by placing the cursor over the chapter title 
and clicking the left mouse button. 

The chapter title is highlighted. 

~ Move the cursor slightly. It will change to a horizontal bar (-). 

~ Position the cursor (horizontal bar) below the last chapter title in the 
list. 

~ Click the left mouse button. 

The chapter is in the new location. Your screen should look similar to 
the following illustration. 

~ If you want more practice, continue rearranging the order of the 
chapters on your own. 

Note: In a long list, when you must use the scroll bars to display addi­
tional names, you can move the file name by more than the height of the 
publication list. To move a file name that is at the end of a long list of 
chapters to the beginning of the list, scroll to the end of the list, select 
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the file name, then scroll to the beginning of the list. Position the hori­
zontal bar cursor at the new location and click the left mouse button. 

~ Select Save to save the rearranged order of MYPUB.PUB. 

If you were ready to exit the Multi-Chapter Operations dialog box, you 
would select OK now. However, for the purposes of training, keep the 
Multi-Chapter Operations dialog box open on your screen. 

Opening an existing publication 

Just as the Open Chapter button is used to open an existing chapter, 
Open in the Multi-Chapter Operations dialog box is used to open an 
existing publication. When you open a publication, all chapter titles asso­
ciated with that publication will display in the publication list. 

To open an existing publication, 

~ None of the chapter titles in the current publication list should be 
highlighted. (If one of the titles is highlighted, click the mouse on the 
title to clear the selection.) 

~ Select Open in the Multi-Chapter Operations dialog box. 

The Open File dialog box displays a list of publication files in the 
current directory. 

~ Select &example.pub (a pre-recorded publication), then select OK. 

The list of chapter files for &example.pub displays in the publication 
list. 
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~ If you want, use Open to display the text, style sheet, (etc.) files for 
one of the chapters displayed in the publication list. Select Close 
when you have finished looking at the chapter file. 

~ Use Open to open the publication mypub.pub. (Remember to clear all 
selections before opening a publication.) 

Adding a chapter to an existing publication 

Earlier in this exercise, you used Add Chapter to create a new publica­
tion. You can also use Add Chapter to add chapters to an existing publi­
cation. 

~ Be sure the publication mypub.pub is still open. 

~ Select Add Chapter in the Multi-Chapter Operations dialog box. 

The Open File dialog box displays. 

~ Select &book-p1.chp, and then select OK to add it to the publication. 

The chapter is added to the publication list, as shown in the following 
illustration. (Notice that this is a duplicate chapter name; you will 
delete the duplicate later.) 

~ If you would like more practice adding chapters to a publication, con­
tinue using the Add Chapter button. 

~ When you have finished adding chapters, select Save to save the 
changes to the mypub.pub publication. 
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Removing a chapter from a publication 

There may be times when you want to delete a chapter from a publica­
tion list. For example, the chapter may no longer be part of the publica­
tion, or you may have replaced it with another chapter. You may want to 
print only selected chapters in the publication, or you may want to re­
move a duplicate chapter. In this part of the exercise, you'll remove the 
duplicate chapter (added on the previous page) from the mypub.pub pub­
lication list. 

~ Select the second occurrence of the chapter &book-p1.chp in the pub­
lication list (if it's not already selected). 

~ Select Remove Chapter in the Multi-Chapter Operations dialog box. 

The chapter name is deleted from the publication list, as shown in the 
following illustration. 

Printing a publication 

Printing a publication is similar to printing a chapter. Just as the con­
tents of the chapter must be displayed in order to be printed, a 
publication's chapter titles must be displayed before the publication can 
be printed. 

To print the publication mypub.pub, 

~ None of the chapter titles should be highlighted. (If one is high­
lighted the Print option will not be available. Click the mouse on any 
highlighted title to clear the selection.) 
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> Select Print in the Multi-Chapter Operations dialog box. 

The Print dialog box, similar to the following illustration, displays. 

~p.pi~i: I-I' __ =-, 

[J print to . File 

> To print the MYPUB publication, select the appropriate settings in 
the Print dialog box, and then select OK. (The print options may 
already be set correctly.) 

The publication prints, starting with the first chapter in the list. 
When that chapter finishes printing, the next chapter prints, and so 
on. 

> Keep the Multi-Chapter Operations dialog box open. In the next part 
of the exercise, you'll use the Copy All button to copy a chapter and a 
publication to a diskette. 

Copying chapters and publications 

When you want to copy a chapter or publication to another subdirectory 
or drive (e.g., floppy disk), use the Copy All button in the Multi-Chapter 
Operations dialog box to copy all the text files, picture files, style sheets, 
and width tables associated with the chapter or publication. 
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Copy All 

Chapters (and publications) point to a number of different files in differ­
ent subdirectories. With the Copy All option, the references to the new 
drives and/or subdirectories in the chapter (.CHP) and publication 
(.PUB) files are automatically updated as the files are copied. Always 
use the Ventura Publisher Copy All option to copy chapters and 
publications. Do not use the Windows File Manager or the DOS 
COpy command. 

Follow the steps below to copy a chapter to a floppy disk. (If you don't 
have a floppy disk, just read through the steps so you become familiar 
with the procedure.) 

Copying a chapter to a diskette 

To copy &book-p1.chp to a diskette, 
[ 

~ Be sure the publication mypub.pub is open. If it is not, 
open mypub.pub. [ 

~ Select the chapter to copy, &book-p1.chp. [ 

~ Select the Copy All button. [ 

The Copy All dialog box is displayed, as shown in the following [ 
illustration. 

[ 

[ 

[ 

[ 



EXERCISE 6 - CREATING A PUBLICATION 

Source File -11------'---

Destination Directories --li--- e.UB&CHPs: IC:\MYPUB 
~==============~ ~TXs &W'IDs~ IC:\MYPUB 
~==============~ I.extJiles: I C:\MYPUB 
~==============~ !iJaphicFi.le~:1 C:\MYPUB 
~==============~. 

lMGs&VPO$: I C:\MYPUB 
~~~~~~~~~~ 

komrnand: 

The Source File is the name of the file to be copied and cannot be edited. 

The Destination Directories text boxes show the disk drive and subdirec­
tory to which each file type will be copied and can be edited. 

To specify a destination for the copy of the chapter, 

> Highlight the entry PUB & CHPs by double-clicking inside the text 
box. 

> Type: A:\ (Make sure you type \, not I.) 

> Select the Make all Directories as PUB & CHPs command at the bot­
tom of the dialog box. 

All other directories are changed to A: \ as displayed in the following 
illustration. 
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Note: Normally, you would copy all of the file types to the same drive 
and directory. However, you do have the option of copying to different 
drives and directories. To do so, in each text box you would enter the 
disk drive name, followed by a colon, followed by the subdirectory where 
you want to place that file type. Remember to include the backslash. 

> Insert a floppy disk in the A: drive. 

> Select OK to begin copying the chapter. 

Messages display telling you what files are being copied. When the 
copy process completes, the Multi-Chapter Operations dialog box dis­
plays again. 

Note: You may see a message telling you that a file already exists. To 
copy over an existing file, select Overwrite. 

Copying a publication to a diskette 

To copy mypub.pub to a diskette, 

> Be sure the publication mypub.pub is open. If it is not, 
open mypub.pub 

> Be sure that no chapter names are selected. (If a chapter is selected, 
click the mouse on the highlighted selection to clear the selection.) 

> Select the Copy All button. 

The Copy All dialog box, similar to the following illustration, is dis­
played. 
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Source File -111--;---

Destination DirectoriM 

Destination Directories -B~~~ 

The Source File line shows the name of the publication to be copied. The 
destination directory for the PUB & CHPs text box should be the A:\ 
drive. 

~ If not, delete the entry in the PUB & CHPs text box and type: A:\, 
then select the Make all Directories as PUB & CHPs command button. 

~ Be sure there is a floppy disk in the A: drive. 

~ Select OK to begin copying the publication. 

Messages display telling you what files are being copied. When the 
copy process is complete, the Multi-Chapter Operations dialog box 
displays again. 

Note: You may see a message telling you that a file already exists. To 
copy over an existing file, select Overwrite. 

~ To exit the Multi-Chapter Operations dialog box, select OK. 

The main screen of Ventura Publisher displays. 

Adding page numbers to a publication 

Refer to "Headers & Footers" in the Chapter Menu section of the Refer­
ence Guide for information on adding page numbers to a publication. 

This concludes Exercise 6. You may continue with Exercise 7, or if you 
would like to quit now, select Exit from the File menu. 
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EXERCISE 7 GLOSSARY 

The following terms can be found in Exercise 7 . 

• :. Generated tag 
A tag created automatically for text which Ventura Publisher generates. Generated 
tag names begin with Z_ (i.e., Z_TOC TITLE, Z_TOC LVL 1). 

.:. Justified alignment 
Text that aligns evenly with both the right and left margins. 

.:. Leaders 
Characters placed in the blank space between items in a list. 
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Exercise 7 

Making a table of contents and index 

In this exercise you'll learn about: 

• Making a table of contents 

• Making an index 

Approximate time to complete: 

• Making a table of contents: 25 minutes 

• Making an index: 25 minutes 

Making a table of contents 

Ventura Publisher generates the table of contents file by making a copy 
of each paragraph (with its associated chapter and page number) identi­
fied by a tag name in the Generate Table of Contents dialog box. For 
example, you can specify that a table of contents be generated containing 
only paragraphs tagged with chapter title, major heading, and minor 
heading tag names for every chapter in the publication. 

Before you begin, you should compile a list of the tags you want to use to 
make the table of contents. All the chapters in the publication should use 
the same tag names (if not the same style sheet). To create this list, open 
a chapter in the publication (using Open Chapter in the File menu or the 
Open Chapter button), look at the Tags list, and write down the tags you 
want to include in the table of contents. If your publication uses more 
than one style sheet, you may need to open each chapter to prepare a list 
of the appropriate tags. 

For this part of the exercise, you will make a table of contents for two 
existing chapters: &book-p1.chp and &book-p2.chp. Although these chap­
ters use different style sheets, most of the tag names are the same. 
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Compiling a list of tags 

Follow the steps below to open &book-p1.chp and decide which tags to 
use to create the table of contents. 

~ From the function buttons, select 

The Open File dialog box displays. 

the Open Chapter button. 

~ Select &book-p1.chp and then the OK button. 

~ From the tool buttons, select the Paragraph Tool. 

~ Open the Tags list by selecting the down-arrow to the right of the 
list. 

Notice that the Tags list includes the following tags: 

• Chapter # 

• Chapter Title 

• Major heading 

These are the tags you'll use to make a table of contents. These same tag 
names appear in &book-p2.chp. (You may check this, if you like, by open­
ing the chapter.) 

Creating a publication 

Before you can create a table of contents, you must first create a publica­
tion, even if that publication contains only one chapter. 

~ Select Manage Publication from the File menu. 

The Multi-Chapter Operations dialog box displays. 

~ Select New to clear the publication list. 

Untitled.pub displays above the publication list. 

~ Select Add Chapter to begin creating a new publication. 

The Open File dialog box displays. 
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EXERCISE 7 - MAKING A TABLE OF CONTENTS AND INDEX 

~ Select &book-p1.chp and then OK. 

&book-p1.chp is added to the publication list. 

~ Select Add Chapter to add &book-p2.chp to the publication list. 

Both chapters are added to the publication list, as shown in the fol­
lowing illustration. 

A publication must be saved in order to create a table of contents. To 
save the new publication, 

~ Select Save As in the Multi-Chapter Operations dialog box. 

The Save File As dialog box displays. 

~ Type the name of the publication: BOOK 
(It is not necessary to add the extension .PUB as it will automati­
cally be added when the publication is saved.) 

~ Select OK 

"BOOKPUB" (or the new title you entered) displays as the title of the 
publication in the Multi-Chapter Operations dialog box. Your screen 
should look similar to the following illustration. 
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Note: If someone has previously performed the steps in this exercise on 
your computer, you'll see messages throughout the exercise telling you 
that a file by that name already exists. You can select Overwrite to store 
your version over the one that already exists, or if you do not want to 
overwrite existing files you can select New Name and enter a different 
name. If you are entering new names, be sure to make a note of the new 
names you have entered, as you will need them later in the exercise. 

Generating the table of contents 

N ow you're ready to generate a table of contents. 

~ None of the chapter names in the publication list should be high­
lighted. (If one of the names is highlighted, click the mouse on the 
name to clear the selection.) 

~ Select Make TOe in the Multi-Chapter Operations dialog box. 

The Generate Table of Contents dialog box, similar to the following 
illustration, displays. 
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EM 
Toctile: IC:\TVPESET\BOOKTOC.GEN 

ntleSirillg: ·.1 Table of Contents 

LeYell'F
I ==========~ 

LeYel2;1 
F==========~ 

level.;!::::1 ==========~ 
level!:·.1 
level.\i::=1 ==========~ 

l.eYeI§:1 
~================~ LeYell:.1 
F=================~ leyeI§!: I 
~================~ levellt,1 

Levet 1jcFI ===========: 
Insert':QT1l9Telct Qr<l!) (;.,) QCh<lpter I 

Q Pagel QrelctAtbilWt~ 

Note: If someone has previously performed the steps in this exercise, the 
information in the dialog box will already be filled in. Use the Del key or 
Backspace key to erase the entries and re-enter the information as de­
scribed in the following steps. 

The file name in the TOC File: text box has been automatically entered. 
Notice that the current publication name, BOOK, has been changed to 
BOOKTOC.GEN. The file name was assigned automatically by Ventura 
Publisher because this is a generated file. (When you work on your own 
documents, you will notice that the last three letters of the file name will 
change to TOC, if your file names are eight characters long.) The exten­
sion .GEN is added, indicating it is an automatically generated file. 

Note: You may use the text cursor to change the file name as desired. 
However, do not change the .GEN extension. 

The Title String: text box displays the title that will appear at the top of 
the first page of the table of contents. You may use the text cursor to 
change the title as desired. 

There are ten levels available for structuring a table of contents. As you 
work through the following steps, you will use Levels 1, 2, and 3 to 
practice making a table of contents. 

The Inserts at the bottom of the dialog box are used to format the table 
of contents, as follows: 

• To insert the tag name, select the Tag Text option button. 

• To insert a tab character, select the Tab (-,) option button. 

• To insert a chapter number, select the Chapter # option button. 

• To insert a page number, select the Page # option button. 

• To specify text attributes, select the Text Attribute option button. 
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To specify the first level of the table of contents, [ 

~ Place the text cursor in the Level 1 text box, if it is not already there. [ 

~ From the Inserts options, select the Tag Text option button. [ 

The words [*tag name] are added to the Level 1 text box. [ 

~ Use the Backspace key to delete the closing bracket and the words [ 
tag name]. (Do not delete [*). 

Your screen should look similar to the following illustration. [ 

~ Type the first tag name and the closing bracket: Chapter #] 

Your screen should look similar to the following illustration. 
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> To enter a tab, from the Inserts, select the Tab (---,) option button. 

A tab symbol ( ---, ) is added to the text box. 

> To have Ventura automatically generate the chapter number, from 
the Inserts, select the Chapter # option button. 

[C#J is added to the text box. 

> Type: - (a dash) to separate the chapter number from the page num­
ber. 

> To have Ventura also generate the page number, from the Inserts, 
select the Page # option button. 

[P#J is added to the text box. 

Note: To apply text attributes (such as bold) to items in the table of 
contents, use the Text Attribute option button. For more information about 
entering attributes, see "Text Attributes" in Appendix D of the Reference 
Guide. 

> Press the Tab key once to move the text cursor to the Level 2 text 
box. 

> U sing the following illustration as a guide, enter the appropriate in­
formation for levels two and three on your own for the following tag 
names: 

• Chapter Title 

• Major heading 

When all the entries have been completed, your screen should look 
similar to the following illustration. 
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~ Use the Backspace and Arrow keys to make necessary changes, then 
select the OK button at the bottom of the dialog box to begin generat­
ing the table of contents. 

Messages display telling you that the table of contents is being gener­
ated. When completed, the Multi-Chapter Operations dialog box dis­
plays again. 

Upon completion, Ventura Publisher automatically creates a new text 
file called BOOKTOC.GEN that contains the text extracted from the 
publication's chapter files. This text is automatically tagged with gener­
ated tags called Z_tags that correspond to each level entered in the Gen­
erate Table of Contents dialog box. 

~ Select OK to close the Multi-Chapter Operations dialog box. 

If the message Save or Abandon changes to this publication appears, 
select Save. 

~ Select the New Chapter button to clear the screen. 

The Select Style Sheet dialog box displays. 

~ Select default.sty from the Typeset directory (you'll have to use the 
scroll bar to find it), and then select OK. 

Ventura's default style sheet loads. The screen clears. 
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After generating the table of contents 

After a table of contents has been generated, it can be loaded and for­
matted the same as any other text file. Follow the steps below to load 
and format the table of contents file. 

>- From the tool buttons, select liS,) the Frame Tool to begin loading 
the table of contents file. 

Handles along the outside edge of the page frame indicate selection. 

The Load Text / Picture dialog box displays. 

~ From the File Type options, select the Text option button. 

~ Because the file was automatically generated by Ventura Publisher, 
in the Format list box, select the Generated option. 

~ Select the OK button. 

The Open File dialog box displays. 

~ From the File Name box, select the table of contents file: booktoc.gen 

~ Select OK 

The generated table of contents file is loaded into the blank page 
frame. The file is not formatted and looks similar to the following 
illustration. 
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Table of Content.s~ 

Chapterl.1-11 

The Adventure Beglns.1-1 n 

ChicagotoTokyo.1-2~ 

11 :31 P.M. Tuesday, March4th.1-21 

Chapterl·1-11 

The Adventure Beglns.1-1 n 

ChicagotoTokyo.1-1n 

11:31 P.M. Tuesday,March4th.1-20 

• 

Ventura Publisher created the table of contents file by making a copy of 
each paragraph (with its associated chapter and page number) identified 
by a tag name in the Generate Table of Contents dialog box. Each para­
graph in the table of contents file has been automatically tagged with a 
generated tag, (for example, Z_TOC TITLE, Z_TOC LVL 1, Z_TOC LVL 
2). The initial tag attributes for these generated tags are taken from the 
current defined attributes of Body Text. However, generated tags can be 
modified like any other tag. 

To see which tags have been applied to the paragraph in the table of 
contents file, 

~ From the tool buttons, select the Paragraph Tool. 

~ Select one of the paragraphs. 

The generated paragraph tag name is displayed in the current selec­
tion indicator and the Tags list. You will have to scroll to the end of 
the Tags list to see the Z_TOC ... tags. 

Note: If your generated tags are not displaying in the Tags list, they are 
probably hidden. To display generated tags in the Tags list, select the Set 
Preferences option from the Edit menu. Then change the Generated Tags 
option to Shown and select OK. 

~ Continue selecting paragraphs to see which tags have been assigned. 
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Formatting the table of contents 

You modify the attributes of a Z_tag the same way you modify the attri­
butes of all other tags. The next set of steps will take you through modi­
fying the generated Z_tags in the table of contents file. 

~ Select the paragraph: Table of Contents 

Z_ TOe TITLE appears in the current selection indicator and Tags list. 

Make changes to this tag as follows: 

~ From the tool option buttons, select the Font button. 

The Font dialog box, similar to the following illustration, displays. 

~ Change the Size to 18 and the Style to Bold, and select OK. 

~ From the tool option buttons, select the Alignment button. 

The Alignment dialog box, similar to the following illustration, dis­
plays. 
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~ Change the horizontal alignment by selecting the Right option from 
the Harz. Alignment drop-down list box. 

~ Select the OK button. 

The paragraph moves to the right column edge. The text is also larger 
and bolder. 

To add a ruling line below the paragraph, 

~ From the tool option buttons, select 
ton. 

the Ruling Line Below but-

The Ruling Line Below dialog box, similar to the following illustra­
tion displays. 

~ Select the Column option from the Width drop-down list box. 
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> Select the 4 point option from the Style drop-down list box. 

> Select the OK button. 

Your screen should look similar to the following illustration. 

;Ch.pterl-1-11 

rI'heAdventure Begins-1-1~ 

;Chlc.gotoTckyc-I-2~ 

11:31 P.M. Tuesd'y,M.rch4th-I-2i 

Ch.pterl-1-1 i 

!heAdventure Begins-I-Ill 

:Chlc.gctcTckyc.I-I~ 

11:31 P.M.Tuesday,M.rch4th-I-20 

> Select the first occurrence of the text Chapter 1 

• 

Z_ TOe LVL 1 displays in the current selection indicator and Tags list. 

Make changes to this tag as follows: 

> From the tool option buttons, select 

The Font dialog box displays. 

> Change the Style to Bold, and select OK. 

> From the tool option buttons, select 

the Font button. 

the Alignment button. 

> Select the Left option from the Harz. Alignment drop-down list box, 
and then select OK to close the dialog box. 

Note: You are changing the horizontal alignment from justified to left 
because you will be adding a tab setting next, and tab settings will not 
function within justified text. 
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The ruler and tab buttons on the button bar make setting tabs in your 
documents convenient and fast. You click a tab button in the button bar 
to select an alignment. Then you click where you want the tab stop on 
the ruler. 

If the ruler is not currently displayed, 

~ Select the Show Rulers option from the View menu. 

Left aligned tab stops 
ruler. 

are preset every half inch in the horizontal 

[ 

[ 

[ 

The placement of tabs is measured relative to the left column edge [ 
rather than the page edge. To set a right tab stop 6-1/4 inches over from 
the left column edge, [ 

[ 
~ Select the Right tab button. (You'll find the tab buttons just 

right of the tool buttons. [ 

~ Position the mouse cursor in the lower half of the ruler under the [ 
6-1/4 inch ruler mark. 

~ Click the mouse button. 

A right tab stop is set at the 6-1/4 inch ruler mark. 

N ext, you'll need to clear the preset tab stops from the ruler. 

~ Position the mouse cursor in the lower half of the ruler over the 
preset tab stop at the 1/2 inch ruler mark. 

~ Press and hold the mouse button to select the marker. Then drag the 
marker down out of the ruler. 

The tab stop is cleared from the ruler. 

~ Continue dragging the remainder of the preset tab markers down out 
of the ruler. Stop when you reach the tab stop you set at the 6-114 
inch ruler mark. 
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~ Add a ruling line below the paragraph by selecting 
Line Below button. 

the Ruling 

The Ruling Line Below dialog box, similar to the following illustra­
tion, displays. 

~11;12~.!~~~nt;il·~··········· ....... ···1 

Fu~t~m~f1'iJnl;~ 
1\·····?()K···.·.···· •• ·.I!iCancef·1 

~ Make the following changes to the options in the Ruling Line Below 
dialog box. 

• Select the Column option from the Width drop-down list box. 

• Set the Space Above Rule 1 in the User-Defined Ruling Style 
dialog box to .014 inches. 

• Set the Height of Rule 1 to .009 inches. 

~ Select OK to exit the User-Defined Ruling Style dialog box, and then 
again to exit the Ruling Line Below dialog box. 

To change the indent level of the Z_TOC LVL 2 tag, 

~ Select the first occurrence of the text The Adventure Begins 

Z_ TOC LVL 2 displays in the current selection indicator and Tags list. 

~ From the tool option buttons, select 

The Alignment dialog box displays. 

the Alignment button. 
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~ Change the horizontal alignment from justified to left by selecting 
the Left option from the Harz. Alignment drop-down list box, and then 
select OK. 

The horizontal ruler can also be used to quickly change the margins 
(in-from-Ieft and in-from-right), or set a first line indent/outdent for the 
selected paragraph. 

The Right Margin marker affects all lines in a paragraph. 

The Left Margin marker is split, allowing for independent setting of 
the left margin. You drag the lower half of the arrow (the top half will 
move with it) to change the in-from-Ieft setting for all lines in a para­
graph. You drag the top half of the arrow (the bottom half will remain 
behind at the left margin) to set a first line indent/outdent in the para­
graph. 

To indent the selected paragraph in from the left column edge 112 inch, 

~ Position the mouse cursor in the lower half of the ruler over the 
left indent marker. 

~ Press and hold the mouse button to select the marker. Then drag the 
marker over to the 1/2 inch ruler mark, and release the mouse but­
ton. 

The new indent setting is reflected in both occurrences of "The Adven­
ture Begins." 

To set a right tab stop at 6-114 inches for this paragraph, 

~ Select the Right tab button. 

~ Position the mouse cursor in the lower half of the ruler under the 
6-1/4 inch ruler mark. 

~ Click the mouse button. 

A right tab stop is set at the 6-1/4 inch ruler mark. 

N ext, you'll need to clear the preset tab stops from the ruler. 

~ Drag all of the preset tab stop markers down out of the ruler. Stop 
when you reach the tab stop you set at the 6-1/4 inch ruler mark. 
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You can fill the space created by tabs with any character. These fill char­
acters are called leaders (pronounced leed-ers). 

~ Select the Tab Settings button to begin adding dot leaders. 

The Tab Settings dialog box, similar to the following illustration, dis­
plays. 

~ Make the following changes in the Tab Settings dialog box. 

• Make sure the Tab Number is set to 1. 

• From the Tab Options, select the Leadered check box. 

• Select the ... option button for Leader Char. (This means that 
periods will be inserted for the leader character.) 

• Select the 1 option button for Leader Spacing. (This means that 
one space will be inserted between each period.) 

~ Select OK 

To add another half-inch indent level and dot leaders to the tag Z_TOC 
LVL3, 

~ Select the first occurrence of the text Chicago to Tokyo 

Z_ TOC LVL 3 displays in the current selection indicator and Tags list. 

~ From the tool option buttons, select 

The Alignment dialog box displays. 

the Alignment button. 
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~ Select the Left option from the Harz. Alignment drop-down list box, 
and then select OK. 

To set a right tab stop at 6-1/4 inches for this paragraph, 

~ Select the Right tab button. 

~ Position the mouse cursor in the lower half of the ruler under the 
6 1/4 inch ruler mark. 

~ Click the mouse button. 

A right tab stop is set at the 6-1/4 inch ruler mark. 

N ext, you'll need to clear the preset tab stops from the ruler. 

~ Drag all of the preset tab stop markers down out of the ruler. Stop 
when you reach the tab stop you set at the 6-1/4 inch ruler mark. 

To indent the selected paragraph in from the left column edge 1 inch, 

~ Position the mouse cursor in the lower half of the ruler over the 
left indent marker. 

~ Press and hold the mouse button to select the marker. Then drag the 
marker over to the 1 inch ruler mark, and release the mouse button. 

The new indent setting is reflected in all occurrences of the tag 
Z_TOC LVL 3. 

To add dot leaders to the tag Z _ TOC LVL3, 

~ From the tool option buttons, select 

The Tab Settings dialog box displays. 

the Tab Settings button. 
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> Make the following changes to the options in the Tab Settings dialog 
box. 

• Make sure the Tab Number is set to 1. 

• Select the Leadered check box for Tab Options. 

• Select the ... option button for Leader Char: (if it's not already 
selected). 

• Select the 1 option button for Leader Spacing. 

> Select the OK button. 

The changes to the document are now complete. Your document should 
look similar to the following illustration. 

Table of Contentsj{ ! 

Chapter 1" 

The Adventure Begins. t ................................................ I-I~ 

Chicago to Tokyo. t . .•....•......•...•••...•.•...•.•....•••..••.. 1-2t 

II :31 P.M. Tuesday. March 4th. too . . oo • oo • oo • oo • oo • oo .............. 1-2~ 

Chapter 1 .. 

The Adventure Begins. t ................................................ I-It 

Chicago to Tokyo . t . ............................. oo .............. I-I~ 

11:31 P.M.Tu 4th. t' •• .. ••••..••••.••••... • •..••••• 1-20 
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Saving the table of contents file 

To save the table of contents style sheet and chapter file, 

~ From the function buttons, select the Save As New Style but-
ton and save the style sheet using the new name: BOOKTOC.STY. 
(The extension .STY will automatically be added.) 

~ From the function buttons, select the Save As button and save 
the chapter using the new name: BOOKTOC.CHP. (The extension 
.CHP will automatically be added.) 

~ Select Manage Publication from the File menu and then add the chap­
ter BOOKTOC.CHP to the beginning of the publication BOOK.PUB. 
Mter you add the table of contents chapter to the publication list, 
move the chapter name to the top of the list. (To see how to move a 
chapter to the top of a long Ilst, review Exercise 6.) 

~ Select Save in the Multi-Chapter Operations dialog box to save the 
publication under the same name. 

~ While in the Multi-Chapter Operations dialog box, print the publica­
tion, if desired. Remember that if one of the chapters is selected, the 
print option will not be enabled. 

~ To exit the Multi-Chapter Operations dialog box, select OK. 
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Creating an index 

Ventura Publisher can automatically generate an index using index ref­
erences that you insert within the text of the chapter(s). The location of 
these inserted index references are marked in the text with degree sym­
bols (0), that display when the Show Tabs & Returns option is active. The 
degree symbol does not print when you print the document. 

When generating an index, the index references and associated page 
numbers are automatically copied into a new text file and alphabetized. 
You can then load and format the index file just like any other text file. 

In this part of the exercise, you will create an index for the BOOK.PUB 
publication you created in part one of this exercise. (If you did not com­
plete part one, you can create the publication later in the exercise.) 

Note: If someone has previously performed the steps in this exercise on 
your computer, you'll see messages throughout the exercise telling you 
that a file by that name already exists. You can select Overwrite to store 
your version over the one that already exists, or select New Name and 
enter a different name. 

Inserting index references in your document 

The first step in creating an index is to enter the index references into 
the text. (You can also create index entries while using a word processor. 
See "Other inserted text" in Appendix D of the Reference Guide.) 

Note: When working on your own documents, you may want to first print 
the chapter, then use a highlighting pen to mark the index entries you 
intend to make. 

Follow the steps below to open the chapter &BOOK-Pl.CHP and activate 
Show Tabs & Returns. 

~ Use the Open Chapter button to open &book-p1.chp. 

~ Select the Show Tabs & Returns option in the View menu. (If there is 
a check mark in front of the option, then the Show option is cur­
rently active.) 

~ Select the V Show All Pictures option in the View menu to hide all 
pictures in the chapter. This will increase the screen drawing speed. 
(If you don't see a check mark in front of the option, then the pic­
tures are already hidden.) 
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~ Use the scroll bars to adjust the text on the screen so you can see 
more of the page, similar to the following illustration. 

Chapter 1<][ 

The Adventure BeginsIJI 

~s trip really began In September last year when Gerry won fir st 
.1. prize In a raffle at the fashion show which Rush-Presbyterian-SI. 

Luke's Medical Center holds every year. The t>rlze was two round 
trip Uckets to Hong Kon!! on United Airlines, and ten nights in the 
Hong Kong Hyatt Hote1.IAnalyzing our good fortune, we conc luded 
that we wanted to do more than spend ten days In Hong Kong and 
return, but at the same time, United, having Just gotten Its routes and 
equipment from Pan American, had not yet received authcd ty to fly 
to other destinations or between points in the Far East.U 

To insert the first index entry, 

~ From the tool buttons, select the Text Tool. 

~ Place the text cursor in front of the word Rush-Presbyterian (on 
the second line of the first paragraph). 

As you insert index entries, you will want to place the entry as close as 
possible to the information being indexed. This makes it easier to find 
the entry later, if you need to change it. 

Note: If someone has previously performed the steps in this exercise and 
you have the cursor placed on an index reference, you'll see the words 
Index Entry displayed in the current selection indicator. You can move the 
cursor to the left and continue with the exercise, or you can make a new 
copy of the text file BOOK.TXT. This file is located on the Ventura Pub­
lisher disk labeled: Examples. 

~ Select the Ins Special Item option from the Text menu. 

The Insert Special Item cascading menu displays, similar to the fol­
lowing illustration. 
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E.!Iit Special Item ... Ctrl .. D 

Normal 
Hold 
Italic 
Small 
Su)!erScript 
~ubScript 

!!nderline 
Double Underline 
Stri.kethru 
Q.verscore 
Set Eont Attributes ... 

Change lext To ... 

> Select Index Entry. 

footnote 
Index Entry ... 
!;quation ... 
Frame Anchor ... 
~ross Ref ... 
Marker Name ... 
~ariable Def. .. 
lable ... 

The Insert/Edit Index Entry dialog box, similar to the following 
illustration, displays. 

As you can see in the following illustration, you can select from three 
types of entries: 

• Index 

• See 
• See Also 
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Index entries are alphabetized according to the primary entry with the 
secondary entries generating the page numbers. If no secondary entry is 
identified in the InsertlEdit Index Entry dialog box, the primary entry 
will generate the page number. An example of a primary entry could be 
"Printers," with secondary entries of "installation," "capabilities," and 
"maintenance." The page number will follow the secondary entry. 

Printers 
capabilities, 10-9 
installation, 10-1 
maintenance, 10-15 

See and See Also are used to reference other index entries. If selected 
for Type of Entry, the word See or words See Also will precede the sec­
ondary entry when the index is generated. Therefore, a page number will 
not be generated for these types of entries. Examples of these entries are 
as follows. 

Leading 
defined, 1-5 
See also Inter-line spacing 
See also Spacing 

Left Justify text 
See Alignment 

Special sort keys can be defined to be sure that certain entries, such as 
those beginning with numbers or articles (e.g., a, an, the), are located in 
a logical place in the index. For example, a sort key of "three" would 
ensure an entry starting with the number 3 would be sorted as a "t" 
rather than being placed at the beginning of the index with the number 
3. 

Binders 
spiral, 15 
a-ring, 16 

Note: Be sure that references to the same item or concept are entered in 
exactly the same way. For example, if you use both "Printer" and "Print­
ers" to refer to printers, you will have two separate entries in the index 
instead of one. 

~ Be sure Index is selected for Type of Entry. 

~ Press the Tab key once to move the cursor to the Primary Entry text 
box. 

~ In the Primary Entry text box, type: Medical Centers 
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> Press the Tab key twice to move the cursor to the Secondary Entry 
text box. 

> In the Secondary Entry text box, type: Rush-Presbyterian 

Your screen should look similar to the following illustration. 

> Select OK 

!'ypeofEf\trV: II ndell I ~ I 
~==~~~~~~~ 

PrimarY tnt.v: 1M edical Centers 

Primarl'iortKeV: I 
~==============~ Se~ondaI'YE~try: I Rush-Presbyterian 

SeCOnclarl'SQlt.tSey:\\..." ====,.....,...,..."....,.,.",.....,...,..,.....,...,..==,.....,...,..~ 

The dialog box closes. Index Entry is displayed in the current selec­
tion indicator. A degree symbol (0) is placed in front of the word Rush, 
indicating there is an index reference at this position in the text. 

To practice entering another index reference, 

> Place the cursor in front of the word prize (on the third line of the 
first paragraph). 

> Select the Ins Special Item option from the Text menu. 

The Insert Special Item cascading menu displays. 

> Select I ndex Entry 

The Insert / Edit Index Entry dialog box displays. 

> Type for the Primary Entry: Prize 

> Press the Tab key twice to move the cursor to the Secondary Entry 
text box. 

> Type for the Secondary Entry: Tickets 

Your screen should look similar to the following illustration. 
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~ Select OK 

Index Entry is displayed in the current selection indicator. The index 
reference symbol (0) displays in the text. 

To practice entering a "See" reference, 

~ Place the cursor in front of the word: tickets (on the fourth line of 
the first paragraph). 

~ Select the Ins Special Item option in the Text menu. 

~ Select I ndex Entry 

The Insert / Edit Index Entry dialog box displays. 

~ Select the See option from the Type of Entry drop-down list box. 

~ Press the Tab key once to move the cursor to the Primary Entry text 
box. 

~ Type for the Primary Entry: Tickets 

~ Press the Tab key twice to move the cursor to the Secondary Entry 
text box. 

~ Type for the Secondary Entry: Prize 

Your screen should look similar to the following illustration. 
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~ Select OK 

Index-See is displayed in the current selection indicator. The index 
reference symbol (0) displays in the text. 

~ Select the Save button to save the changes (the index entries) 
to the chapter. 

Note: Any changes to text in a chapter are automatically updated in the 
publication as well. 

Generating an index 

Before you can generate an index, you must save the chapter(s) you 
want to index as a publication. Even if you want to index only one chap­
ter, it must still be included iri-a pUblication. 

For this part of the exercise, you will be generating an index for the 
publication you created while making a table of contents. (If you did not 
complete that exercise, use the chapter &BOOK-Pl.CHP to create a pub­
lication. See Exercise 6 if you need to review the steps for creating a 
publication. After creating the publication, continue with the following 
steps.) 

Open the publication BOOK.PUB as follows: 

~ Select Manage Publication from the File menu. 

The Multi-Chapter Operations dialog box displays. 

~ Use Open to open the publication book.pub (if it is not currently 
open). 

book. pub opens displaying its contents in the publication list. Your 
screen should look similar to the following illustration. 
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~ Select the Make Index button in the Multi-Chapter Operations dialog 
box. 

The Generate Index dialog box, similar to the following illustration, 
displays. Most of the dialog box is automatically filled out and usu­
ally does not need to be changed. 

The Index File name has been entered automatically by Ventura Pub­
lisher because this is a generated file. It includes the current publication 
name, BOOK, but is changed to BOOKIDX. (When working on your own 
documents, you will notice that the last three letters of the file name will 
change to lOX, if your file names are eight characters long.) The exten­
sion .GEN is added, indicating it is an automatically generated file. 

Note: You may use the text cursor to change the file name as desired, 
however, do not change the .GEN extension. 

Title String - displays the title that will appear at the top of the first page 
of the index. You may use the text cursor to change the title as desired. 
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Letter Headings - places the appropriate letter at the beginning of each 
section of the index. When Letter Headings is on, an A will be inserted 
at the beginning of the list of entries beginning with A, a B in front of 
entries beginning with B, and so on. 

The rest of the dialog box is automatically filled out as shown in the 
previous illustration and usually does not need to be changed. These 
entries are described below: 

Before #s - identifies character(s) placed before the chapter and page 
numbers. The default is one horizontal tab. For the index in this guide, 
the tab was replaced with a comma followed by a space. 

For Each # - identifies how the chapter and page numbers will appear in 
the index. The default lists entries on consecutive pages, with the first 
and last chapter and page number separated by a dash. (For example, 
an index entry Installation 5-14 - 5-17 shows that the topic begins on 
page 5-14 and ends on page 5-17.) If you want to list every occurrence of 
an index reference, separated with commas, the entry for this option 
would be [C#]-[P#], [C#]-[P#]. 

Between #s - identifies the punctuation between each chapter/page num­
ber reference. The default is a comma, followed by a space. 

After #s - identifies punctuation after chapter/page numbers. The default 
is no punctuation at all. 

See - defines the text that will be placed before a cross reference entry. 
Usually the word "See" is used. 

See Also - defines the text that will be placed before a secondary cross 
reference entry. Usually the words "See Also" are used. 

For more information about changing the default settings in the Gener­
ate Index dialog box, refer to "Index generation" under Manage Publica­
tion in the File Menu section of the Reference Guide. 

You use the inserts listed at the bottom of the dialog box to format an 
index, as follows: 

• To insert a tab character, select the Tab (-,) option button. 

• To insert a chapter number, select the Chapter # option button. 

• To insert a page number, select the Page # option button. 

• To specify text attributes, select the Text Attribute option button. 
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To change the characters that will be placed before the chapter and page 
numbers in the. index, 

> Place the text cursor on the Before #5 line (if it is not already there). 

> Press the Del key to delete the tab symbol (-,). 

> Type a comma and a space (, ). 

Your screen should look similar to the following illustration. 

Generate Index' , '" 

> Select OK in the Generate Index dialog box to begin generating the 
index. 

Messages display telling you the index is being generated. When com­
pleted, the Multi-Chapter Operations dialog box displays again. 

Upon completion, Ventura Publisher automatically creates a new text 
file called BOOKIDX.GEN that contains the text extracted from the 
publication's chapter files. This text is automatically tagged with gener­
ated tags called Z_tags that correspond to each level entered in the Gen­
erate Table of Contents dialog box. 

> To exit the Multi-Chapter Operations dialog box, select OK. 

If the message Save or Abandon changes to this publication displays, 
select Save. 
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After generating the index 

After an index has been generated, it can be loaded and formatted the 
same as any other text file. 

To load and format the index file, 

~ Select New in the File menu to clear the screen. 

The Select Style Sheet dialog box displays. 

~ Select the prerecorded style sheet default.sty and select OK. 

The screen clears. The new style sheet is loaded. 

Handles along the outside edge of the page frame indicate selection 

~ From the function buttons, select the Load Text/Picture button. 

The Load Text / Picture dialog box displays. 

~ Make sure for File Type, the Text option button is selected. 

~ Because the file was automatically generated by Ventura Publisher, 
make sure for Format, the Generated option is selected. 

~ Select OK 

The Open File dialog box displays. 

~ From the File Name list box, select the index file: bookidx.gen 

~ Select OK 

The generated index file is loaded into the blank page. The file is not 
formatted and looks similar to the following illustration. 
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Index'll 

Medic.l Centers+, 
-oR u.sh -Presbyter! .n,l-l 'II 

Prize+, 
-lI'ickets,I-I'll 

Tickets+' 
<SeePrizeD 

The index file was created by making a copy of each index reference 
(with its associated page and chapter number) that you identified in the 
practice chapter &book-p1.chp. Each paragraph in the generated index 
file has been automatically tagged with a generated tag called a Z_tag, 
(for example, Z_INDEX TITLE, Z_INDEX MAIN, Z_INDEX LTR). The 
initial tag attributes for these generated tags are taken from the current 
defined attributes of Body Text. However, generated tags can be modi­
fied like any other tag. 

To see which tags have been applied to the paragraphs in the index file, 

~ From the tool buttons, select the Paragraph Tool. 

~ Select one of the paragraphs. 

The generated paragraph tag is displayed in the current selection in­
dicator and Tags list. 

Note: If your generated tags are not displaying in the Tags list, they are 
probably hidden. To display them in the Tags list, set the Generated Tags 
option to Shown in the Set Preferences option dialog box. (Edit menu). 

~ Continue selecting paragraphs to see which tags have been assigned. 
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Formatting the index 

The next set of steps will take you through changing tags. 

~ Use the scroll bars to adjust the text on the screen, so you can see 
more of the page. 

You modify the attributes of a Z_tag the same way you modify the attri­
butes of all other tags. Use the following steps to change the title to 
boldface, make the type size larger, and center the heading. 

~ Select the title: Index 

Z_INDEX TITLE displays in the current selection indicator and Tags 
list. 

~ From the tool option buttons, select 

The Font dialog box displays. 

the Font button. 

~ Change the Size to 14 points and the Style to Bold. 

~ Select OK 

The new font setting is reflected in the title. 

~ From the tool option buttons, select the Alignment button. 

The Alignment dialog box, similar to the following illustration dis­
plays. 
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> To center the title, select the Center option from the Harz. Alignment 
drop-down list box. 

> Select OK 

The title is centered on the page. 

> Select the paragraph: M 

Z_INDEX LTR displays in the current selection indicator and Tags 
list. 

> From the tool option buttons, select 

The Font dialog box displays. 

> Change the Style to Bold and select OK. 

the Font button. 

The new font setting is reflected in the index letter. 

> Select the paragraph that begins with Medical Centers. 

Z_INDEX MAIN is displayed in the current selection indicator and 
Tags list. 
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Make the following changes to this tag: 

~ From the tool option buttons, select I["j the Alignment button. 
(You are changing the horizontal alignment from Justified to Left be­
cause you will be adding a tab setting next.) 

The Alignment dialog box displays. 

~ Select the Left option from the Horz. Alignment drop-down list box, 
and then select OK. 

Use the horizontal ruler to adjust the first preset tab stop at 1/2 inch 
ruler mark. If the ruler is not currently displayed, 

~ Select the Show Rulers option from the View menu. 

~ Position the mouse cursor in the lower half of the ruler over the 
preset tab stop at the 1/2 inch ruler mark. 

~ Press and hold the mouse button to select the tab stop. Then drag 
the tab stop left to the 114 inch ruler mark, and release the mouse 
button. 

The new tab setting is reflected in all occurrences of the tag Z_INDEX 
MAIN. 

The changes to the document are now complete. Your document should 
look similar to the following illustration. 
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Index1\ 

Prize+l 
+ Tickets. 1-11 

TJl 

,Tlcket.sO) 
,+ See PrizeCl 

Saving the index file 

To save the index style sheet and chapter file, 

> From the function buttons, select the Save as New Style but-
ton and save the style sheet using the name: BOOKIDX.STY (The 
extension .STY will automatically be added.) 

> From the function buttons, select the Save As button and save 
the chapter using the name: BOOKIDX.CHP (The extension .CHP 
will automatically be added.) 

> Select the Manage Publication option from the File menu and then 
add BOOKIDX.CHP to the end of the publication BOOK.PUB. (If you 
need a reminder of the steps, review Exercise 6.) 

> Use Save in the Multi-Chapter Operations dialog box to save the 
publication under the same name. 

> While in the Multi-Chapter Operations dialog box, print the publica­
tion, if desired. Remember that if one of the chapters is selected, the 
print option will not be enabled. 

> To exit the Multi-Chapter Operations dialog box, select OK. 
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Editing and deleting index references 

Although there is no practice exercise for editing or deleting index refer­
ences, the steps below are provided for your information. 

~ Open the chapter containing the index references you want to 
change. 

~ Make sure Show Tabs & Returns in the View menu is activated. 

~ From the tool buttons, select the Text Tool. 

~ Be sure Index Entry is displayed in the current selection indicator by 
placing the typing cursor to the left of the degree symbol (0) in the 
text. The degree symbol indicates where the index entry is located. 
(You can use the left and right arrow keys to help place the cursor.) 

To delete an index entry, 

~ Press the Del key. 

The degree symbol and index entry are deleted from the chapter file. 

To edit an index entry, 

~ Be sure Index Entry is displayed in the current selection indicator by 
placing the typing cursor where the index entry is located. 

~ Select Edit Special Item from the Text menu, or use the keyboard 
shortcut Ctrl+D. 

~ Select Index Entry 

The Insert / Edit Index Entry dialog box displays showing the infor­
mation you entered when the entry was created. 

~ Make any necessary corrections. 

~ Select OK 

The index will have to be re-generated for the changes to be incorpo­
rated. 

This concludes Exercise 7. 
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EXERCISE 8 GLOSSARY 

The following terms can be found in Exercise 8. 

.:. Cross reference 
Any reference to a page, chapter, figure, table, caption, variable text, or section num­
ber. Ventura Publisher's cross referencing feature creates and updates these refer­
ences so that you don't need to keep track of where pictures and text have moved in 
your document. 

.:. Marker 
The location in your chapter where you designate (or "mark") the text you want to 
reference. 
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EXERCISE 8 

Cross referencing 

Cross references 

In this exercise you'll learn about: 

• Inserting a marker 

• Inserting a cross reference 

• Cross referencing frames 

• Generating and updating cross references 

Approximate time to complete: 25 minutes. 

A cross reference is a pointer in your text to a particular page, figure, 
table, chapter, caption, variable text, or section number. These references 
can be generated automatically by using the cross reference feature. 
Then, each time you edit and renumber your document, the references 
are automatically updated. 

You can place cross references anywhere in a document. For example, in 
a newsletter where articles are continued on another page, you can in­
sert the page number on the original page where the continuation occurs 
(continued on page ... ), as well as on the continuation page (continued 
from page ... ). 

Figure 1-1 
Japanese Sales 

linters gain more atlenuon 
rices, higher speeds and 
u t, high-end dot-m atrix 
:arting to lose some of their 

SpccJicI; len eo:ltfy h:lCF 
'Iinkn are aaopg lAc 

-.,..~·---tCF .6o:lmen 

The laser printer :vides sharper 
graphic images, J ones note , nd the 
laser now has the wealth of so 1\ 
support dot-matrix printers have always 
enjoyed. So, if a user moves to a laser 
prin ter from a dot-matrix printer "he can 
run much of his graphics software and 

quickest, most cost-efficient way of 
doing that is through a low-cost dot­
matrix printer-.vithout having to wait 
~li ~ 
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Cross referencing your document is basically a three-step process. 

1. Mark the location of the text or illustration you want to cross refer­
ence. You can mark a place in the text using marker names or use a 
frame anchor for a marker. 

2. Insert a cross reference symbol in the text exactly where you want the 
reference to appear. 

3. Create a publication with the chapter or chapters. The cross reference 
(inserted in the second step) automatically generates the cross refer­
ence when the publication is renumbered. 

Getting started 

For this exercise, you'll use the example chapter &BOOK-P1.CHP to 
learn how to create cross references. 

Note: Before you continue, if someone has already performed this exer­
cise on your computer, you'll need to copy the text file BOOK.TXT from 
the Examples disk in your Ventura Publisher software package to the 
Typeset directory. 

~ Open the practice chapter file &book-p1.chp, in the \typeset directory. 

In the first part of this exercise, you'll create a cross reference on page 1 
of the chapter that will refer to text on page 3. 

The first step in creating a cross reference is to mark the text you want 
to reference. In the practice chapter, the text to be referenced is a hotel 
name, Imperial Hotel, on page 3 of the chapter. 

~ Press the End key or go to page 3. 

~ Use the scroll bars to display the top left side of the page, as shown 
in the following illustration. 
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Elle Edit 'llew !;hapter Frame 

The Adventure Begins+ 3D 

...................................... 

a rather large bus departed promptly and c anied us on our hour and 
fifteen minute, 66 kilometer trip Into the center of the city and the 
Imperial Hotel. Much of the super highway into town is screened by 
neise abating walls. Traffic moves steadily at about SO miles an hour 
and we observed nospeec1ing. The new Imperial Hotel is every bit as 
good as Its reputation--.somewhatmore elegant than the Ritz Carlton. 
Our room in the new tower looks exactly like the picture in the travel 
folder s. It's not exceptionally large. Ithas a bay window overlooking 
the Ginza with the ocean in the background, very nice furniture, and 
a well-appointed onyx and plastic bathroom.~ 

"Extras" abound: Toothbrushes, terryc loth bathrobes, kimonos, 
slippers, coffee making equipment, etc. There are eleven separate 
restaurants in the hotel, all-as we have found by inspection (reading 
the menus that is) very expensive. To settle later c1iscussion by the 
way, the price of our room Is 34,000 Yen per day plus 10% gratuities 

the whole thin .0 

In the text, a marker and cross references are indicated by a degree 
symbol (0). You may find it helpful to activate (check mark) Show Tabs & 
Returns (View menu) so you can see the symbols. 

Inserting markers 

Markers and cross references can be inserted in any order. However, in 
this exercise, you'll insert the marker first, and then insert the cross 
reference. 

Although you can place a marker anywhere on a page, it is best to place 
markers where you can easily find them. It's helpful to adopt a consis­
tent approach. 

Now you're ready to mark the location of the text that you will be refer­
encing. You will be inserting the marker right after the word Hotel in 
the name Imperial Hotel. 

To insert a marker, 

~ From the tool buttons, select the Text Tool. 

~ Locate the text "Imperial Hotel" beginning the third line of the first 
paragraph. 
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> Click to mark the insertion point so that it's after the name "Imperial 
Hotel," as illustrated below: 

Imperial HoteL! ------ Insertion point 

> Select Ins Special Item in the Text menu. 

The Insert Special Items cascading menu is displayed, as illustrated 
below. 

E!lit Special Item ... Ctrl+D 

Normal 
Bold 
Italic 
Small 
Su)!erScript 
~ubScript 

!!nderline 
Double Underline 
Strikethru 
.Qverscore 
Set ,Eont Attributes ... 

Change Iext To ... 

> Select Marker Name 

; I 

,Eootnote 
Index Entry ... 
fquation ... 
Frame Anchor ... 
~ross Ref ... 
Marker Name ... 
~ariable Def... 
Iable ... 

[ 
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[ 

[ 

[ 

[ 

[ 

[ 

[ 

The Insert / Edit Marker Name dialog box is displayed, as illustrated [ 
below. 
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[ 

[ 

The marker name you select should be brief but should also remind you [ 
of its purpose. When you are creating your own documents, you might 
find it helpful to make a list of the markers placed in your document. [ 
Otherwise, you'll need to display the InsertlEdit Marker Name dialog 
box for each marker if you can't remember the marker name. [ 

> Type the marker name: hotel (Remember this marker name, you'll [ 
need it later.) 
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~ Select OK 

A degree symbol (0) is entered in the text to indicate the marker loca­
tion and Marker Name is displayed in the current selection indicator. 
The following illustration is enlarged so you can see the marker loca­
tion. 

Degree symbol 

a rather large bus depart 
fifteen minute, 66 kilo 
Imperial Hotel. 'Much 0 

noise abating walls. Tra 
and we observed no spe 

(If you cannot see the degree symbol, activate Show Tabs & Returns in 
the View menu, or select Enlarged View in the View menu.) 

Inserting a cross reference 

N ow you're ready to insert the cross reference that will refer to the 
marker location you just entered. 

In preparation, you'll add this sentence to page 1: "See details about the 
Imperial Hotel on page." 

~ Press Home to go to page 1. 

~ If necessary, use the scroll bars to display the top of the page, as 
shown in the following illustration. 
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Chapter 1 <j[ 

The Adventure Begins1 

~s trip really began in Septemt:er last year when Gerry won fir st 
.I. prize in a raffle at the fashion show which Rush-Presbyteri an-St. 

Luke's Medical Center holds every year. The prize was two round 
trip tickets to Hong Kong on United Airlines, and ten nights in the 
Hong Kong Hyatt HoteL Analyzing our good fortune, we concluded 
that we wanted to do more than spend ten days in Hong Kong and 
return, but at the same time, United,having Just gotten its routes and 
equipment from Pan American, had not yet received authcdty to fly 
to other destinations or between points in the Far East.~ 

Locate the text "Hong Kong Hyatt Hotel" beginning the fifth line of 
the first paragraph. 

Click the mouse to mark the insertion point after the space that fol­
lows the period, as illustrated below: 

Hong Kong Hyatt Hotel. I ... t ---
Insertion point 

Type: 
See details about the Imperial Hotel on page (space) • (space) 

You are typing the space before the period to separate the word page 
from the cross reference page number that will be generated later. 
You are typing a space after the period to separate the new sentence 
from the remainder of the paragraph. 

The cross reference page number will appear in the text exactly where 
you insert the cross reference, so you must be precise. Like the marker, 
the cross reference is indicated by a degree symbol (0). 
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EXERCISE 8 - CROSS REFERENCING 

To insert the cross reference, 

>- Press the left arrow key twice to mark the insertion point after the 
space that follows the word "page," as illustrated below: 

... Hotel. See details about the Imperial Hotel on page \. 

Insertion point / 

>- Select Ins Special Item in the Text menu. 

The Insert Special Item cascading menu displays. 

>- Select Cross Ref 

The Insert / Edit Reference dialog box displays, as illustrated below. 

The At the Name text box is where you enter the name of the marker. 

>- In the At The Name text box, type: hotel (Remember, this is the 
name of the marker you inserted on page 3.) 

The Refer To drop-down list box is where you select the type of reference 
you want to create. It lets you refer to any of the following: 

P# -the page number of the referenced item 
C# -the chapter number of the referenced item 
F# -the figure number for the referenced frame 
T# -the table number for the referenced frame 
S* -the section number that precedes the referenced item 
C* -generated caption text in the frame 
V* -text defined for a referenced variable (This feature is described in 

Exercise 9.) 
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When you select one of the # options above (e.g., P#), you can specify the 
format you want for the number by using the Format drop-down list box. 
Default uses the currently defined numbering for each type of counter as 
specified in the Update Counters dialog box. Refer to the Reference 
Guide for more information about the Insert Reference and Update 
Counters dialog boxes. 

~ Leave the other selections in the dialog box set at the default set­
tings, which are Refer To: P# and Format: Default. 

~ Select OK 

A degree symbol is entered in the text to indicate the cross reference 
location, and the word Reference is displayed in the current selection [ 
indicator. 

You will not see the actual cross reference until you create a publication [ 
and use the Manage Publication Renumber option. You'll do this later in [ 
this exercise. 

In the next part of the exercise, you'll create a cross reference to the [ 
figure number in the frame caption on page 1. 

r 
L 

Cross referencing frames [ 

When referencing figures or tables in frames, the frame anchor name is [ 
used instead of a marker. The Anchors & Captions option in the Frame 
menu is used to assign frame anchor names. [ 

Page 1 of BOOK-P1.CHP should still be displayed on your screen. You [ 
should be able to see a frame at the bottom of the page, as shown in the 
following illustration. This is the frame you will reference. If you cannot [ 
see the frame, use the scroll bars to adjust the page until you can. 
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EXERCISE 8 - CROSS REFERENCING 

Figtiri>i'····This·picture·ha:slieryiitiietodowitii·itiisS!ool.·yOu·might···· 
/Nant to plac e a more appropriate picture in this frame.a 

a: between points in the Far East.1 
On February I Oth, Unite~ .cquire~ this autha:ity, an~ on Febfuary 

11th Debbie began putting our trip together. We left on M.rch 2n~ 
&n~ returned on March Uith: We entere~ seven countries, travele~ 
over 2S,OOO miles on four airlines, ma~e over SOC Kodachrome 

To assign a frame anchor name, 

~ the Frame Tool. 

~ Select the frame holding the picture of the nozzle. 

nozzle.gem is displayed in the current selection indicator. 

~ From the tool option buttons, select 
button. 

the Anchors & Captions 

The Anchors & Captions dialog box displays, as shown in the follow­
ing illustration. 

Notice the frame already has an anchor name: Map. If it did not, you 
would enter a name in the Anchor text box. Remember, the anchor name 
is Map. You'll need it later. 
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> Close the Anchors & Captions dialog box by selecting OK. 

> Go to page 3. Use the scroll bars to display the top of the page, as [ 
shown in the following illustration. 

The Adventure Begins. 3D 

........................ . ................... . 

a rather large bus departed promptly and carried us on our hour and 
fifteen minute, 66 kilometer trip Into the center of the city and the 
Imperial Hotel Much of the super highway into town is screened by 
noise abating waIls. Traffic moves steadily at about 50 ml ies an hour 
and we observed no speeding. The new Imperial Hotelis every bit as 
good as its reputaU on-somewhatmoreelegantthan the Ritz Carlton. 
Our room in the new tower looks exactly like the picture In the travel 
folders. It's not exceptionally large. It has a bay window overlooking 
the Ointa with the ocean in the background, very nice furniture, and 
a well-appcdnted onyx and plastic bathroom.n 
"Extras" abound: Toothbrushes, terrycloth bathrobes, kimonos, 

slippers, coffee making equipment, e\c. There are eleven separate 
restaurant.sin the hotel, all-as wehave found by inspectioo (reading 
the menus that is) very expensive. To settle later discussion by the 
way, the price of our room is 34 ,000 Yen per day plus I 0% gratuities 
and 10% on the wh .0 
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In preparation for creating this cross reference, you'll add the words "See [ 
figure" to the end of the first paragraph on page 3. 

> From the tool buttons, select the Text Tool. 

> Click the mouse to mark the insertion point after the period that 
ends the first paragraph, as illustrated below: 

... a well-appointed onyx and plastic bathroom.1 - Insertion point 

Paragraph End is displayed in the current selection indicator. 

> Type: (space) See Figure 1-. 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

You are typing the space to separate the new text from the existing [ 
paragraph. 

[ 

Now you're ready to insert the cross reference. Remember, the figure [ 
number will appear in the document exactly where you insert the cross 
reference, so you must be precise. [ 

[ 

[ 
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EXERCISE 8 - CROSS REFERENCING 

> Press the left arrow key once to move the insertion point after the 
text "1-" as illustrated below: 

Figure 1-1. ---- Insertion point 

> Select Ins Special Item from the Text menu. 

The Insert Special Item cascading meny is displayed. 

> Select Cross Ref 

The Insert / Edit Reference dialog box is displayed. 

> In the At The Name text box, type: Map (Remember this was the 
frame's anchor name.) 

> In the Refer To drop-down list box, select the F# option because you'll 
be referencing a figure number instead of a page number. 

> Leave the Format set at Default and then select OK. 

A degree symbol is inserted in the text to indicate the cross reference 
location, and the word Reference is displayed in the current selection 
indicator. 

You are now ready to automatically generate the cross references, but 
first save the chapter under the name CRS-REF, as follows: 

> From the function buttons, select 

> Type the name: CRS-REF 

> Select OK 

The chapter is saved using the new name. 
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Generating and updating cross references 

Page numbers, figure numbers, and other references are automatically 
inserted in a document at the cross reference locations when you select 
Renumber in the Manage Publication dialog box (File menu). Should you 
edit the document, you can select Renumber again to update the cross 
references automatically. Cross references can span any number of chap­
ters in a publication. 

Before you can generate or update cross references, you must create a 
publication by following the steps below. (These are abbreviated steps; if 
you need more practice creating a publication, see Exercise 7, or refer to 
the Reference Guide.) 

To create a publication, 

~ Select Manage Publication from the File menu. 

The Multi-Chapter Operations dialog box is displayed. CRS-REF.CHP 
has already been added to the publication list. 

~ Select Save As in the Multi-Chapter Operations dialog box. 

The Save File As dialog box is displayed. 

~ Type the publication name: CRS-REF and then select OK. 

Notice that the Renumber button in the Multi-Chapter Operations dialog 
box is now available. This option is used to both generate new references 
and update existing references. 

~ Select the Renumber button. 

The following message is displayed. 

~ Select Renumber 

The program begins renumbering the publication and inserting the 
cross references. 
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Figure number 

EXERCISE 8 - CROSS REt-I::HI::N(';INl:l 

~ After the publication has been renumbered, select OK to close the 
Multi-Chapter Operations dialog box. 

Examine the CRS-REF.CHP file. As you can see in the following illustra­
tion, the correct page and figure numbers have been inserted at the cross 
reference locations. 

Elle fdlt '{lew !;hapter Frame Earagraph Iext !J.raphlc TAble Help 

The Adventur. Begins. 3D 

~ Save the chapter file so you can refer to it later when creating cross 
references for your own chapters. 

Note: There is no exercise for editing a cross reference. If you wish to 
change the name of the marker or frame to which a cross reference re­
fers, you can do so using the Edit Special Item option in the Text menu, or 
the keyboard shortcut Ctrl+D. For information on editing cross refer­
ences, refer to "Edit special item" (Text Menu) in the Reference Guide. 

This concludes Exercise 8. 
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EXERCISE 9 GLOSSARY 

The following terms can be found in Exercise 9 . 

• :. Cross references 
Any reference to a page, chapter, figure, table, caption, variable text, or section num­
ber. Ventura Publisher's cross referencing feature creates and updates these refer­
ences so that you don't need to keep track of where pictures and text have moved in 
your document . 

• :. Variable definition 
The text that is inserted at cross reference locations in your chapters. Sample vari­
able definitions include the current date or the name of a customer or product. 
When you renumber your publication, the variable text is inserted at all the cross 
reference locations you specified in your chapters. 
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EXERCISE 9 

Inserting variable text 

In this exercise you'll learn about: 

• Inserting variable definitions 

• Inserting variable cross references 

• Generating and updating variable text 

• Editing variable text 

Approximate time to complete: 25 minutes. 

You can use the cross reference feature (described in Exercise 8) to insert 
variable text into your document at cross reference locations. This fea­
ture is useful for inserting such items as the current date, the current 
revision number, the name of a customer, or the name of a product. 

To insert variable text, you insert a variable definition and then insert 
cross references in the document where you want the variable text to 
appear. If you place the variable definition at the beginning of your docu­
ment, you can always locate it easily. Note that the variable definition 
must precede the cross references for which it will be used. The variable 
text is automatically inserted into the document when you use the Re­
number option in the Multi-Chapter Operations dialog box (File menu). 

For example, a Will can be set up with cross references at each location 
where a person's name should appear. The name itself will only be typed 
once as a variable definition at the beginning of the document. The name 
is then inserted automatically at all cross references when the Renumber 
feature is used. To place a new name in the will, the variable definition 
can be changed and the Renumber feature used again. 

To practice inserting variable text, you'll create a new chapter by typing 
a few lines of text into a blank text screen. You'll start by loading a style 
sheet and saving it using a new name. 

In preparation for this exercise, 

> From the function buttons, select 
clear the screen. 

The Select Style Sheet dialog box displays. 

the New Chapter button to 
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~ If the style sheet (&BOOK-P1.STY) is not already loaded, select 
&book-p1.sty in the \typeset directory and then OK. If the style sheet 
(&BOOK-P1.STY) is already loaded, select the Cancel button to close 
the Select Style Sheet dialog box. 

~ Turn on the Show Tabs & Returns option in the View menu (if it is 
not already on). 

~ Use the Save as New Style button to save &book-p1.sty under 
the new style sheet name: variable.sty. 

You should now have a blank screen with variable.sty in the title bar. 
The chapter is UNTITLED. 

~ Be sure the Text Tool is selected, and then click the mouse 
button in the blank screen. 

The text cursor will begin blinking next to the end of file symbol (0), 
which indicates that you may begin entering text. 

~ Type the following text exactly as it appears in the illustration below, 
including the space between the two commas and the extra para­
graph symbols. (To insert paragraph symbols, simply press the Re­
turn key.) Do not insert any extra paragraph symbols, and let Ven­
tura Publisher hyphenate the text as required. 

Amended Answer of Defendant, fjf 

COMES NOW Defendant, , a Texas 
Corporation having its principal of­
fice and place of business in the 
State of Texas, and in reply to 
Plaintiff's Original Petition on file 
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EXERCISE 9 -INSERTING VARIABLE TEXT 

Inserting variable definitions 

The variable definition, indicated by a degree symbol (0), should be 
placed at the beginning of the document. This makes it easy to locate the 
definition when editing the document. 

To enter a variable definition, 

>- Click your text cursor at the beginning of the document-to the left 
of the A in Amended. 

>- Select Insert Special Item in the Text menu. 

The special items cascading menu is displayed, as illustrated below. 

E!!.it Special Item ... Ctrl+D 

Normal 
Ilold 
Italic 
Small 
SUl!erScript 
liubScript 
!!nderline 
Double Underline 
Stri.kethru 
Q.verscore 
Set font Attributes ... 

Change lext To ... 

>- Select Variable Def 

footnote 
Index Entry ... 
.Equation ... 
Frame Anchor ... 
!;.ross Ref ... 
Marker Name .. . 
~ariable Def .. . 
lable ... 

The Insert / Edit Variable Definition dialog box 1,S displayed as 
illustrated below. 

>- Type in the Variable Name text box: Defendant 

Note: A variable definition name should be brief, but should also remind 
you of its purpose. If your documents contain many variable definitions, 
you might find it helpful to make a list of the names. Otherwise, you'll 
need to display the Variable Definition dialog box for each variable if you 
forget the names. 
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~ Press the Tab key once, then type in the Substitute Text text box: 
Alpha Corporation. (This is the variable text that will be inserted 
into your document.) 

~ Select OK 

The degree symbol (0) appears at the beginning of your document and 
Variable Oef. is displayed in the current selection indicator, as shown 
in the following illustration. 

Amended Answerof Defendant,U 

n 
n 
COMES NOW Defendant" a Tellas Corporation having its princi­

pal office and place of business in the State ofTellas, and in reply to 
Plaintiff's Original Petition on fileD 

Inserting cross references 

Now, you're ready to enter the cross references. Each cross reference 
marks a location in the text where variable text will be inserted, so you 
must be precise in inserting references. You may need to insert spaces or 
use the Enter key to allow room for the variable text in your documents. 
(The text you typed already contains spaces and paragraph symbols to 
allow enough room.) 
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EXERCISE 9 -INSERTING VARIABLE TEXT 

To add the first cross reference, 

> Click your text cursor on the second paragraph symbol after the 
word Defendant, as illustrated below. 

Amended Answer of Defendant, ~ 

insertion point _I ~ 
Paragraph End displays in the current selection indicator. 

> Select Insert Special Item from the Text menu. 

The special items cascading menu is displayed. 

> Select Cross Ref 

The Insert / Edit Reference dialog box is displayed, as shown in the 
following illustration. 

> In the At The Name text box, type: Defendant (This is the name you 
gave to the variable definition at the beginning of the document.) 
Remember, the name you enter here must be identical to the vari­
able definition name. 

> At the selection, Refer To, use your mouse to select V* in the drop­
down list box. V* indicates that you want variable text to be inserted 
at this cross reference. 

> Select OK 

The degree symbol appears at the insertion point to indicate the cross 
reference location and Reference is displayed in the current selection 
indicator. 
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Note: The degree symbol is sometimes obscured by capital letters or the 
paragraph symbol. If you're uncertain that the reference was entered, 
use your left and right arrow keys to find the insertion point and look for 
the word Reference in the current selection indicator. 

To insert another cross reference, 

~ Click to mark the insertion point between the two commas after the 
words, COMES NOW Defendant. Be sure the insertion point is im­
mediately to the left of the second comma so that a space will pre­
cede the inserted text, as illustrated below. 

COMES NOW Defendant, I, a ... _------ insertion point 

~ Select Insert Special Item in the Text menu. 

~ Select Cross Ref 

The Insert / Edit Reference dialog box is displayed. [ 

~ In the At The Name text box, type the variable name: Defendant, [ 
select V* from the Refer To drop-down list box, and select OK. 

The degree symbol appears at the insertion point to indicate the cross [ 
reference location, and Reference is displayed in the current selection 
indicator. Your screen should now look similar to the following [ 
illustration. 

Amended AnswerofDefendant.'1 

~ 
n 
COMES NOW Defendant,: a 'lexas Corporation having its princi­

pal office and place of business In the State of Texas, and in reply to 
Plainti ff's Original Petition on fileD 
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EXERCISE 9 -INSERTING VARIABLE TEXT 

Note: If you are going to be inserting the same cross reference in many 
locations, you may want to copy it. To do this, simply highlight the de­
gree symbol, then hold down the Shift key and press Delete. Move the 
cursor to the location where the reference should be placed, and press 
Insert. 

~ Save the chapter under the title VARIABLE.CHP. 

Generating and updating variable text 

The variable text you defined is automatically inserted into the docu­
ment when you use the Renumber option in the Multi-Chapter dialog box 
(File menu). 

Before you can use the Renumber option, you must first create a publica­
tion by following the steps below. (These are abbreviated steps. If you 
need more practice creating a publication, see Exercise 7, or refer to the 
Reference Guide.) 

~ Select Manage Publication from the File menu. 

The Multi-Chapter Operations dialog box displays. VARIABLE.CHP 
has already been added to the publication list. 

~ Select Save As in the Multi-Chapter Operations dialog box to save 
the chapter as a new publication. 

~ Type the publication name: VARIABLE in the Save File As dialog 
box, then select OK. 

Notice that the Renumber button in the Multi-Chapter Operations dialog 
box is now available. This option renumbers the publication and inserts 
the variable text you defined. 

~ Select the Renumber button. 

The following message is displayed: 
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~ Select Renumber 

The program begins renumbering the publication. 

~ Mter the publication is renumbered, select OK to close the Multi­
Chapter Operations dialog box. 

The variable text, Alpha Corporation, is inserted in your chapter. Your 
screen should look similar to the following illustration. 

Amended AnswerofDefendant,'1 
Alpha Corporation! 

i 
COMES NOW Defendant,Alpha Corporation, a Tex.s Corporation 

having its principal office and pl.ce ofbusiness in the State of Texas, 
and in reply to Plaintiff's Original Petition on fileD 

~ Save the chapter so you can refer to it later when creating your own 
variable insertions. 

~ For practice, enter one or two additional cross references and then 
use the Renumber option to insert the variable text at each location. 

Editing variable text 

Ventura Publisher's variable insertion feature is particularly useful 
when you know you will be revising the same elements in a document 
over and over. With variable insertion, you can change the text in the 
variable definition at the beginning of the document, then use the Re­
number option to insert the new text. Follow the steps below to insert a 
different Defendant name into the document you just created. 

~ Click the text cursor at the beginning of the document, immediately 
to the left of the A in Amended. 

Variable Def. should be displayed in the current selection indicator. If 
it is not, press the left arrow key to display it. 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 

[ 



EXERCISE 9 - INSERTING VARIABLE TEXT 

> Select Edit Special Item from the Text menu. (You can also use the 
keyboard shortcut Ctrl+D.) 

The Insert / Edit Variable Definition dialog box is displayed as shown 
in the following illustration. 

> Press the Tab key once to highlight: Alpha Corporation. 

> Type the new Substitute Text: Omega Corporation. 

> Select OK 

That's all there is to editing variable text. Now Renumber the chapter to 
replace the names. (You already created a publication for the chapter.) 

> Select Manage Publication in the File menu. 

> When the Save or Abandon message appears, select Save 

The Multi-Chapter Operations dialog box is displayed. The same pub­
lication you used before, C:\typeset\variable.pub, should still be dis­
played above the publication list of the Multi-Chapter Operations dia­
log box. If it isn't, use Open to display it. 

> Select the Renumber option. 

The message "Do you want to renumber. .." displays. 

> Select Renumber 

The program begins renumbering the publication and substituting the 
new text. 

> Mter the publication is renumbered, select OK 

The name Omega Corporation replaces the name Alpha Corporation 
throughout the document as you can see in the following illustration. 
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Amended AnswerofDefendant,'1 
Omega Ccrpoutioni 
n 
COMES NOW Defendant, Omega Ccrpontion, • Tex.s Ccrpor.­

tion having its principal office .nd piace of business in the State of 
Tex.s, and in reply to Plaintiff's Original Petition on fileD 

Note: To delete inserted text, place the cursor to the left of the reference 
symbol (0). The word "Reference" should display in the current selection 
indicator. If it does not display, press the left or right arrow key until it 
does. Then press the Del key to delete the reference symbol. The entire 
text string (everything in the InsertlEdit Variable Definition and In­
sertlEdit Reference dialog boxes) will be deleted when the reference is 
deleted. 

> For practice, replace the variable definition with a company name of 
your own choosing, and then save the chapter. 

This concludes Exercise 9. 
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Notes: 
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EXERCISE 10 GLOSSARY 

The following terms can be found in Exercise 10. 

.:. Cell 
Each area or block of information in a table. 

.:. Table 
Any text formatted in a rowand/or column arrangement. For example, most 
database programs organize data in rows and columns. 
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EXERCISE 10 

Creating a table 

In this exercise you'll learn about: 

• Inserting a table 

• Adding table information 

• Adding a column or row 

• Shading cells 

• Cutting columns or rows 

• Pasting columns or rows 

• Changing the width of a column 

• Changing ruling lines 

• Joining cells 

• Editing table settings 

• Helpful hints 

Approximate time to complete: 40 minutes. 

Ventura Publisher's table feature allows you to easily create tables con­
taining text or numerical data. Each separate area or block of informa­
tion in a table is called a cell. 

A cell in a table will automatically expand vertically to accommodate the 
text or numbers you type in it. Attributes and tags can be assigned to 
the contents of a cell in the same way they are assigned to paragraphs in 
your documents. This means that you have total control over the way 
your table appears. For tables containing numbers, you can align the 
cell's contents to the left, right, center, or at the decimal point. 
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The following illustration shows the parts of a table. 

/ 
Rows • 

~ 

Text or numbers 

Text or numbers 

Shading or coloring 
can be added 

It 

\ 
Cell 
(shading or color­
ing can be added) 

Columns 

/~ 
Cells can be jOine~e headers or 
other effects 

~ 
Text can be Cells will 

automatically 
tagged accommodate the 

text you enter 

Text or numbers Text or numbers 

'\ 
\ 
Rulmglmes 
can be on or off, 
thick or thin 

To practice working with tables, you'll create a new chapter using the 
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[ 

default style sheet. [ 
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The table you will create is a time sheet (illustrated below) showing the 
names of three people and the number of hours they worked Monday 
through Wednesday. 

Employee Days of the Week 
Name 

Monday Tuesday Wednesday 

Kathleen 8 8 8 

Barbara 8 8 8 

Fred 8 8 8 
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To set up the page for the table, first you'll clear the screen, then you'll 
load the default style sheet. 

~ From the function buttons, select 
clear the screen. 

The Select Style Sheet dialog box displays. 

~ Select default.sty from the \typeset directory and then OK. 

>- From the function buttons, select 1.11 the Save as New Style but­
ton and save default.sty under the new style sheet name: table.sty. 

Inserting a table 

In this exercise, you will use the Table Tool and the Add New Table but­
ton to create a table. (You can also use either the Table Tool and the 
Insert New Table option in the Table menu or the Text Tool and the Ins 
Special Item option in the Text menu to create tables. Refer to "Table 
Tool" in the Toolbox section of the Reference Guide for more information. 

To create a table, 

~ From the tool buttons, select 
sor to the base page. 

The cursor changes to + 

the Table Tool and move the cur-

~ Click the mouse button anywhere on the page. 

The words Before Para display in the current selection indicator, and 
a small bar appears above the end of file symbol. If you cannot see 
the text cursor, move the vertical scroll box to its top position and the 
horizontal scroll box to its left position. 

~ From the tool option buttons, select the Add New Table button. 

The' Insert / Edit Table dialog box displays with default values, as 
shown in the following illustration. 
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Between Columns 

Make the following changes to the InsertlEdit Table dialog box: 

> Press the Del key to delete the current value in the Rows text box. 

> Type the number: 4 in the Rows text box (for three employee cells 
and a header cell). 

4 replaces 3 for the number of rows in the table. 

> Press the tab key to move the text cursor to the Columns text box, 
and type the number: 4 (three day cells and a header cell). 

4 replaces 3 for the number of columns in the table. 

> Press the tab key to move to the Header Rows text box, and type the 
number: 1. (This selection means that if the table needs to expand 
onto the next page, the header row will be repeated on the next 
page.) 

1 replaces 0 for the number of header rows. 

> Double-click the mouse inside the Between Columns text box (you'll 
find this option in the Spacing area of the dialog box). Replace the 
current value with the number: 10. (This means that there will be a 
10 point margin on the left side of each column.) 

These are the only changes you'll need to make for this exercise. For 
more information about the other options in the InsertlEdit Table dialog 
box, refer to the "Table Menu" section of the Reference Guide. 
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>- To close the Insert/Edit Table dialog box, select the OK button. 
Your screen should look similar to the following illustration. 

'I 'I! 'Il 'Il 

'I 'Il 'Il 'I 

'I 'Il 'Il 'Il 

'I 'Il 'Il 'Il 

When you first create a table, every cell in the table is the same width 
and height. You can change the width of any column after the table is 
created. The height of each row adjusts automatically as you enter addi­
tional text. 

Adding the table information 

N ow you're ready to· enter information into the table. 

The first thing you'll do is enter the table information, and then you'll 
change the tag attributes. This can be done in either order when work­
ing on your own documents. However, you may find it easier to enter the 
text first so that when you change the tags, you immediately see what 
effect the changes have on the text. 

>- From the tool buttons, select the Text Tool, and then point to 
the first cell in the second column and click. This cell is also referred 
to as row 1, column 2. 

Paragraph End displays in the current selection indicator, as shown in 
the following illustration. 
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'I --~ 'II 'II 

'II 'I[ 'II 'II 

'I[ 'II 'II 'II 

'I 'II 'II 'II 

> Type the word: Monday 

> Press the right arrow key to position the text cursor in the next cell. 

> Type:Tuesday 

> Press the right arrow key and then type: Wednesday in row 1, col­
umn4. 

If necessary, the table automatically scrolls to the right as you type 
the text. 

> Press the right arrow key to position the text cursor in row 2, col­
umn 1. 

If necessary, the table automatically scrolls to the left. 

> Type: Kathleen 

> Press the down arrow key to position the text cursor in row 3, col­
umn 1, and type: Barbara 

> Type: Fred in row 4, column 1. 
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> When you have finished typing the names, use either the mouse 

(click inside the cell) or the arrow keys to position the text cursor in [ 
row 2, column 2 (under Monday). 
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>- Type the hours for each employee, as shown in the following illustra­
tion. (Each employee worked 8 hours on each day.) You can type the 
hours by column (using the down arrow key), by row (using the right 
arrow key), or randomly (using the mouse cursor). 

, Mondayt Tuesdayt Wednesday'l 

Kathleen'l 8'1 8'1 8'1 

Barbara'l 8'1 8'1 8,/ 

Fred'l 8'1 8'1' 8'1 

N ow that you've typed the table information, you're ready to change the 
tag attributes. 

>- From the tool buttons, select. the Paragraph Tool. 

>- Select any paragraph in the header row (row 1). Note that each cell 
is initially tagged: Table Text. 

The tag name Table Text displays in the current selection indicator 
and the Tags list, as shown in the following illustration. 
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'I IImlIiII Tuesday'J 

Kathleen'J 8'1 8'1 

Barbara'J 8'11 8'11 

Fred,/ 8'11 8'1 

~ From the tool option buttons, select 

The Add New Tag dialog box displays. 

Wednesday'J 

8'1 

8'11 

8'~ 

the Add New Tag button. 

~ In the Name to Add text box, type: Header, and then select OK to 
close the dialog box. 

Header displays in the current selection indicator and Tags list. 

~ Using the Paragraph Tool's Font and Alignment buttons, 
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change the Style to Bold and the Harz. Alignment to Center. [ 
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Note: If you need more practice changing tags, see Exercise 5 in this 
guide. 

~ Tag the other header paragraphs (Tuesday and Wednesday) with the 
Header tag. Remember that you can hold down the Shift key to select 
multiple paragraphs.) 

To tag the employee's hours in each cell, 

~ Select one of the hour cells. 

Table Text displays in the current selection indicator and Tags list. 
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>- From the tool option buttons, select the Add New Tag button, 
and type the name: Table Items in the Name to Add text box. 

>- Select OK to close the dialog box. 

>- From the tool option buttons, select 
change the Horz. Alignment to Center. 

the Alignment button and 

>- Tag the other hour cells with the Table Items tag. 

All of the hours are centered, as shown in the following illustration. 

'I Monday' Tu.sda~ Wednesda~ 

Kathleenll 8'1 8'1 8'11 

Barbara\! 8'1 8'1 8'11 

Fred,/ 8,/ 8,/ 811 

o 

>- From the function buttons, select the Save As button to save 
the table for future reference using the name TABLEl.CHP. 

You have finished creating a table. In the next part of the exercise, you'll 
learn some of Ventura Publisher's table editing features. 
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Adding a column or row 

Follow the steps below to add a new column to your table. 

> From the tool buttons, select the Table Tool. 

The cursor changes to + [ 
> Position the cursor over the lower right corner of row 2, column 4, [ 

and click the mouse. (Use the following illustration as a guide.) 

R2C4 .. R2C4 displays in the current selection indicator. This indicates [ 
that the action you take will affect Row 2, Column 4 through Row 2 
Column 4 (in other words, Column 4). Your screen may have a differ- [ 
ent row number depending on where you clicked the mouse. 

Click here 

Kathleen, 8'1 

Barbara1[ 8, 

Fred' 8'1 

[] 

[i'l2t 

> From the tool option buttons, select 

The following message displays. 

Tue!dal1l Wedn~ 

81[ 

81[ 

8'1 8'11 

the I nsert Column button. 
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EXERCISE 10 - CREATING A TABLE 

~ Select the Insert button. 

A fifth column is added to the table, as shown in the following 
illustration. 

, MondaY'( Tuesda>1[ 

Kathleen'll 8'11 8'11 

Barbara'll 8'11 8'i1 

Fred'll 8'11 8'i1 

o 

To add a row instead of a column, select 
instead of the Insert Column button. 

Shading cells 

Wednesda>1[ 'I[ 

8'1[ 'II 

8'1[ 'II 

8'11 'II 

the Insert Row button 

There may be times when you want to shade cells within a table. To add 
shading to cells, 

Select the cells you want to shade, as follows: 

~ Position the cursor in the top left corner of the new column. 
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> Press and hold the mouse button as you drag the cursor through the 
column to the bottom right corner, and then release the mouse but­
ton. 

The cursor changes to ~ while you are dragging it, and a light out­
line follows your cursors movements. When you release the mouse but­
ton, the gray outline remains around the column, as shown in the 
following illustration. 

~ MOIulaY'll TuesdaY'll WednesdaY'l I, 
Kathleen~ 8, 8, 8'11 i, 
Barbara~ 8, 8'1 8, i~ 
Fred'll 8"1 8'1 8"1 I, 

! 

[J 

> From the tool option buttons, select the Set Tint button. 

The Table Cell Tint dialog box displays, as shown in the following 
illustration. 
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> Select Black for the Color, and then one of the lighter patterns from 

fueP~emli~bo~ [ 
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224 [ 



EXERCISE 10 - CREATING A TABLE 

> Select OK to close the dialog box. 

The column is shaded. Your screen should look similar to the follow­
ing illustration. 

;;; '::;;' ,.;;': 

'I MondaY'll Tuesda)1J WednesdaY'll :: 
::: 

:,: /:. 

.:'. Kathleen'll 8'11 8'11 811 .:,:.< 
:". ;,: 

Barbara'll 8'11 8'11 8'11 'II;;, 
: 

:':;. .:;:; 
Fred'll 8'11 8'11 8'11 :1 :,:, :::;: :;>; 

o 

Cutting columns or rows 

To cut a column or row, highlight the cells you want to cut, and then 
press the Delete key. Follow the steps below to cut the shaded column. 

> Be sure the Table Tool and shaded column are still selected. 

> From the function buttons, select 
the Del key). 

The following message displays. 

the Cut Item button (or press 
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~ Select the Column(s) button. 

The shaded column is cut from the table and stored temporarily in 
the Clipboard. The table automatically re-adjusts to the width of the 
column set for the page. 

To cut a row instead of a column, follow the same steps (select the row to 
be cut, select the Cut Item button (or press the Del key), and then select 
Row(s) instead of Column(s) when the previous message displays. 

Pasting columns or rows 

Although the column is cut from the table, it is still in memory (pasted 
to the Clipboard). Follow the steps below to paste the shaded column in 
front of the Monday column. 

~ Be sure the Table Tool is still selected. 

~ As shown in the following illustration, select the line separating the 
first and second columns by positioning the mouse cursor on the line, 
and then holding down the mouse button while dragging the mouse 
down slightly. (This is tricky, if you don't get it the first time, try 
again.) 

OJ Monday", Tuesda~ Wedn~ 

Kathleen'll 8,/ 8,/ 8~ 

Barbara'll 8,/ 8'11 8~ 

Fred~ 8,/ 8,/ 8'11 
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> From the function buttons, select 
press the Ins key). 

The following message appears. 

Ar8Yau sure you want to 
pastel column(slin hont 

EXERCISE 10 - CREATING A TABLE 

the Paste Item button (or 

of COlUMNU2in yotlrtable? 

> Select the Paste button. 

The shaded column is now between the first and second columns, as 
shown in the following illustration . 

. ; 
file Edit ~Iew thapter Frame Earagraph leld Graphic TlIble J:ielp 

;: , 
>; Manday<IJ Tuesday<IJ Wednesdaytl 

Kathleen, 811 811 811 

~;;; 
Barbara'll ~.~> :,( 

:: 8'1 8'11 811 
):: 

Fred'l r. 8'11 8'11 8,/ 
I:::: 

o 

FAlei 

Changing the width of a column 

There are two ways to change the width of any column. The first is an 
interactive method in which you drag the right column boundary with 
the mouse to the new location. This method is useful when exact mea­
surements are not required. The second method, which is more precise, 
allows you to define the exact width of any column in a table using the 
Adjust Column Width button. Refer to "Adjust Column Width" in the 
Table Menu section of the Reference Guide for more information about 
the second method. 
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Note: Remember that row size is automatically increased vertically to 
accommodate the text as you type. 

To change the width of a column by using the interactive method, 

> Be sure the Table Tool is selected. 

> Hold down the Alt key. 

> Move the cursor to the middle of the shaded column, press and hold 
down the mouse button as you drag the right column boundary to 
the new location. 

An outline appears showing the new dimensions of the column. 

> Release the Alt key and the mouse button when the column is twice 
the width of the others. You may repeat this process if necessary. 

The table automatically re-adjusts to the width of the column set for 
the page. Your screen should look similar to the following illustration. 

'/ .. , ;i; ;. MorulaY'll TuesdaY'll WainesdaY1l 
; ·.:i 

.;; ii··· Kathleenll 811 811 811 

B arb arall T/ .:;< 
8'11 811 811 

i: .... ·• 

I~ :)::: /; ;:. 
Fredll 

I;; .; •. ; .... ' ,:: 811 811 811 

o 

The same interactive method can be used to narrow a column. 

Now to delete the shaded column: 

> Be sure the shaded column is still selected. 
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EXERCISE 10 - CREATING A TABLE 

~ From the function buttons, select 
the Del key). 

A VP Alert message displays. 

~ Select the Column(s) button to cut the shaded column. 

Changing ruling lines 

You may want to highlight portions of your table by changing the style of 
its ruling lines. There are several default ruling line buttons available 
for your use: 

Hidden Line Style (no line) 

Single Line Style (a thin, single line) 

Double Line Style (a thin, double line) 

Thick Line Style (a thick, single line) 

This exercise uses the default settings for the ruling lines in the table. 
(You can change the attributes of these lines or add more ruling line tags 
for the table. Refer to "Ruling Lines" in the Table Menu section of the 
Reference Guide for more information.) 

To change the ruling line around a cell, 

~ Be sure the Table Tool is still selected. 

~ Position the cursor at the top left corner of the cell whose ruling line 
you want to change. 

~ Hold down the mouse button as you drag the cursor diagonally 
through the entire cell to the bottom right corner. Then release the 
mouse button. 

A light, thick outline around the cell shows it is selected. 
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, Monday'l Tue!1laY'l WednesdaY'l 

Kathleen, 8'1 8'1 8'1 

Barbara, 8, 8, 8'1 

Fred' 8, 8, 8'11 

o 

~ From the tool option buttons, select the Thick Line Style but-
ton, or one of the other ruling line buttons. 

The ruling line is now a thick line. (To see the ruling line, move the 
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cursor away from the cell and click.) [ 
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Note: Either the Default Line Attributes button, or the Normal Rules 
option in the Table menu can be used to return the ruling line to the 
default ruling line specified in the InsertlEdit Table dialog box. 

Joining cells 

You can join cells to create a heading cell over two or more columns. 
Follow the steps below to add two new headings to your table. 

~ Be sure the Table Tool is still selected. 

~ Select the ruling line at the top of the table. 

ROCO .. ROCl displays in the current selection indicator. The exact 
numbers displayed will depend on what part of the line you select. 

~ From the tool option buttons, select 

The following message displays. 

the Insert Row button. 
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~ Select the Insert button. 

A new row is inserted into the table above the days of the week. 

~ Use your mouse to select the last three cells in the row above the 
days of the week, as shown in the following illustration. 

file Edit 'ilew thapter Frame Earagraph lex! Graphic TAble Help 

, 
Monday'J TuemaY'J WOOnemaY'J 

Kathleen\! 8, 8, 8'1 

Barbara\! 8, s,- 8'1 

~ 
(" 

Fred\! 8'i1 8'1 811 ~ .. 
FIt C 

~ From the tool option buttons, select the Join Cells button. 

The three cells are combined, as shown in the following illustration. 
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'II 

Monday'll Tuesda)1[ 

Kathleen~ 8'1 8'1 

Barbara~ 8'1 8'1 

> From the tool buttons, select the Text Tool. 

> Click inside the joined cells, and then type the new heading: Days of 
the Week 

> Click inside the first cell in the row and type the heading: 
Employee Name 

Your screen should look similar to the following illustration. 

Employee Nameh DaysoflheW~ 

Monday'll Tuesda)1[ WednesdaY'll 

Kathleen~ 8'11 8'11 

Barbara~ 8'1 
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>- From the function buttons, select [WI the Save button to save the 
table using the same name: TABLELCHP. 

Editing table settings 

Now that you have completed the table, you can edit all of the table 
settings using the Edit Table Settings button, except the number of rows 
and columns. (You must use the Insert Row or Insert Column buttons to 
insert a new row or column. Use the Cut Item button or the Delete key to 
delete a row or column.) 

To edit your table, 

~ Select any line in the table. 

> the Edit Table Settings but-

The Insert / Edit Table dialog box displays. 

> Change some of the options and then select the OK button to see the 
results. 

~ Save the chapter file so you can refer to it later when creating your 
own tables. 
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Helpful hints 

Tables can be copied to the Clipboard and placed anywhere in your docu­
ment. Refer to "Table Tool" in the The Basics section of the Reference 
Guide for more information. Another way to copy a table is to place it in 
a frame, and then copy the frame. 

This concludes Exercise 10. 



QUESTIONNAIRE 

QUESTIONNAIRE 
Ventura Publisher 
Windows Edition 

Please take the time to fill in this questionnaire and mail it to the address shown on the back. 

Very Neither Very 
Much Agree nor Much 
Agree Agree Disagree Disagree Disagree 

1. The materials were 
easy to understand. ( ) ( ) ( ) ( ) ( ). 

2. The directions were clear 
and easy to follow. ( ) ( ) ( ) ( ) ( ) 

3. There was enough practice 
to allow you to start using 
Ventura Publisher 
on your job. ( ) ( ) ( ) ( ) ( ) 

4. The materials were logically 
organized. ( ) ( ) ( ) ( ) ( ) 

Comments: 

5. Did you feel that any sections of the training guide contained confusing explanations or meaningless exercises? 

Introduction 
Exercise 1 - Learning the basics 
Exercise 2 - Editing text 
Exercise 3 - Frames & pictures 
Exercise 4 - Using the drawing tools 
Exercise 5 - Customizing a style sheet 
Exercise 6 - Creating a publication 
Exercise 7 - Making a table of contents and index 
Exercise 8 - Cross referencing 
Exercise 9 - Inserting variable text 
Exercise 10 - Creating a table 

Comments: -----------------------------------------------------------------------
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6. Would you like the Training Guide to provide more information or more practice in any of the following areas? 

Loading files 
Applyin9 style sheets 
Customizing style sheets 
Frames & pictures 
Editing text 
Paragraph tagging 
Using the drawing tools 
Ventura Publisher concepts and terms 
Combining chapters into publications 
Generating a table of contents 
Generating an index 
Cross referencing 
Inserting variable text 
Creating tables 

Comments:---------------------------------------

7. How do you think the Training Guide could be changed to be more helpful to you? 

8. YourName---------------------------------------

CompanyName---------------------------------------------­

Street 

City, State, Zip Code: ----------------------------------

Thank you for taking the time to complete this questionnaire. Please mail it to: 
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Ventura Software Incorporated 
Product Education 
15175 Innovation Drive 
San Diego, CA 92128 
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A 

Abandoning changes, 53 
add box text tool, 91 
adding page numbers to a 

publication, 147 
Mter #s, index, 177 
after generating the index, 179 
Alignment option, 114 
anchor 

attaching a frame to text, 73 
Anchors & Captions option, 73 
applying a different style sheet, 32 
Applying style sheets, 26 
ASCII files, 3, 38 
attributes 

changing tag, 108 
codes, 4 
line, 94, 95, 100 
typographic, 3, 4, 38 

B 

Backspace key, 34 
backup copies 

extension, 38 
saving, 38 

Before #s, index, 177 
Between #s, index, 177 
Body text, 28 
box 

adding around text, 110 
drawing, 96 
drawing around a frame, 78 
grid settings for, 98 
shading, 99 

Breaks option, 117 
Bring to Front option, 101 

Buttons 
Cut Item, 43 
Open Chapter, 41 
Paste Item, 47 
Undo, 44 

By Scale Factors option, 67 

c 
Callout 

defined, 84 
cancel a menu, 14 
Caption 

defined, 60 
Caption file 

defined, 40 
captions 

adding to pictures, 70 
autonumbering, 70 

Cell 
defined,212 
using in tables, 213 

Chapter 
defined, 10 

Chapter file 
defined, 134 

chapter files 
combining into publications, 7 
defined, 5 
opening, 38, 62 
opening (recalling), 41 
printing, 35 
saving, 34, 126 

Chapter menu, 132 
CHP extension, 8, 34 
clearing the screen, 36, 105, 123 
Clipboard 

defined, 40 
Column 

Index 

INDEX -1 



INDEX 

deleting, 225 
pasting, 226 

Column break 
defined, 106 

. column guides 
showing, 64 

Constrain 
defined, 84 

Copy All option, 143 
copying 

chapters, 143 
publications, 143 
text, 48 

creating 
a new tag, 112 
a publication, 135 
a table of contents, 149 
an index, 169 

Cropping 
defined, 60 

cropping an image, 69 
Cross reference 

defined, 186 
Cross references 

creating, 188 
defined, 200 
defining, 187 
generating, 198 
inserting, 192 
inserting markers, 189 
See also Markers 
using frames, 194 

Ctrl (control) key, 14 
current page indicator, 19 
current selection indicator, 19, 25, 109 
cursor 

mouse, 20 
Custom size fonts, 110 
customizing a style sheet, 107 
cut 

text, 47 
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D 

degree symbol, 173, 185 
delete 

a block of text, 43 
a frame, 63 
a single text character, 43 
index references, 185 

Dialog box 
items, 216 

directories 
default, 24 

displaying rulers, 87 
document 

steps for laying out, 5, 37 
drawing 

a frame, 64 
boxes, 96 
graphics, 85 
objects, 88 

drawing tool 
grid settings for, 98 

drawing tools 
options, 88 
using, 85 

E 

editing 
index references, 185 
text, 41 
using Spell Checker, 49 

End key, 33 
end of file symbol, 91, 124 
Enter key, 36 
examining 

attributes, 131 
chapter layout, 132 
layout for the page frame, 132 

Exercises 
tables, 214 
updating variable references, 207 
variable insertion, 201 

exiting Ventura Publisher, 37 
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F 

file 
adding a drawing to a frame, 76 
backup copies, 38 
creating a new text file, 86 
extensions, using, 8, 38 
loading a generated file, 157 
loading into a frame, 66 

file list, 16 
Files list, 25 
Fill Attibutes option, 99 
Fill attributes 

changing, 99 
first line indent, 120 
Fit in Frame option, 67 
For Each #, index, 177 
frame 

current selection indicator, empty, 65 
defined, 4 
deleting, 63 
drawing (creating), 64 
moving on a page, 72 
page, 21 
putting a box around, 78 
selected, 21 

Frame menu, 132 
Frames 

cross referencing, 194 
Frames & pictures, 61 
Free frame 

defined, 60 

G 

GEN extension, 8, 153, 176 
Generated tag 

defined, 148 
generating an index, 175 
Glossary terms 

callout, 84 
caption, 60 
caption file, 40 
cell, 212 

chapter, 10 
chapter file, 134 
Clipboard, 40 
column break, 106 
constrain, 84 
cropping, 60 
cross reference, 186 
cross references, 200 
free frame, 60 
generated tags, 148 
hairlines, 84 
interline spacing, 10 
justified text, 148 
leaders, 148 
line break, 106 
marker, 186 
page break, 106 
page frame, 10 
point, 10 
publication, 134 
ruling line, 10 
scaling, 60 
style sheet, 10 
table, 212 
tag, 10 
text files, 40 
typeface, 10 
undo, 40 
variable definition, 200 

Go To option, 33 
graphic drawing tools 

options, 88 
Graphic menu, 94 
graphics 

defined, 5 
greeked text, 31 

H 

Hairlines 
defined, 84 

help menu, 13 
Hide Pictures option, 81 
Home key, 33 

INDEX 
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I 

I-beam cursor, 43 
image 

cropping, 69 
defined, 5 
loading into a frame, 66 
scaling, 67 
sizing, 67 

In/Outdent Width option, 120 
indenting 

first line of a paragraph, 120 
from both margins, 121 
set in ruler, 164 

index 
after #s, 177 
after generating the, 179 
before #s, 177 
between #s, 177 
creating, 169 
degree symbol, 173, 185 
deleting references, 185 
editing references, 185 
for each #, 177 
index entry, defined, 172 
index file name, 176 
inserting index references, 169 
letter headings, 177 
make index, 176 
see, 177 
see also, 178 
setting tab with ruler, 183 
title string, 176 
type of entry, 172 
using see, 172 
using see also, 172 
Z tags, 180 

Index File name, index, 176 
InsertlEdit Index option, 171 
Installation, 2 
Interline spacing 

defined, 10 

INDEX - 4 

J 

Justified text 
defined, 148 

K 

keyboard shortcuts, 14,49 

L 

Leaders 
defined, 148 

Letter Headings, index, 177 
line art 

defined, 4 
loading a file, 76 

line attributes, 94, 95, 100, 114 
Line break 

defined, 106 
line breaks 

adding, 45 
using option, 118 
using returns, 45 

Load TextJPicture button, 21 
Load TextJPicture option, 21 
loading different style sheets, 26 

M 

main screen, 12 
Maintain Aspect Ratio option, 67 
Make Index option, 176 
Make TOe option, 152 
Making 

a publication, 135 
a table of contents, 149 
an index, 169 

Margins 
set in ruler, 164 
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Marker 
defined, 186 

Markers 
See also Cross references 
inserting, 189 

menu 
gray and black options within, 14 

menu bar, 13 
mouse 

using, 20, 227 
moving 

between pages, 33 
frames with graphic objects, 95 
text, 46 

Multi-Chapter 
add chapter, 136 
copying, 143 
creating a index, 169 
open chapter, 136 

N 

New Chapter button, 86 
New option, 36 

o 
objects 

overlaying, 101 
OK button, 38 
On-line help, 13 
Open File dialog box 

defined, 23 
scroll bar, 23 

overwrite, 152 

p 

Page break 
defined, 106 

Page frame 
defined, 10 

paragraph 

INDEX 

adding and deleting (paragraph) 
symbols, 45 

defined, 28 
indenting, 120, 121 
symbol, 28 

Paragraph menu, 108, 131 
paragraph symbol, 42 
paste 

text, 47 
Pattern option, 99 
Pg Dn key, 33 
Pg Up key, 33 
pictures 

cropping, 69 
defined, 4 
hiding on the screen, 81 
reducing within a frame, 80 
sizing and scaling, 67 

Point 
defined, 10 

printing 
a chapter, 35 
a publication, 142 

PUB extension, 8 
publication 

adding a chapter, 141 
adding page numbers, 147 
combining chapter files into, 7 
copying, 143, 146 
creating, 135 
creating an index, 169 
defined, 134 
making a TOC, 149 
moving chapters, 139 
printing, 142 
recalling (opening), 140 
removing a chapter, 142 
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save as new, 137 
putting the pieces together, 5 

Q 

quitting Ventura Publisher, 37 

R 

reduced view, 31 
References 

creating cross, 187 
creating variable, 201 
updating variable, 207 

Reordering chapters within a 
publication, 139 
Replace and Search 

changing text, 54 
Return key, 34 
Returns 

adding, 45 
deleting, 45 
displaying, 42 
not creating a new paragraph, 45 

Row 
deleting, 225 

Rulers 
clearing preset tabs, 162 
clearing tabs from, 162 
set the unit of measure, 87 
setting first-line indent, 164 
setting left margin, 164 
setting right margin, 164 
setting tabs, 162 

Ruling Box Around option, 110 
Ruling line 

defined, 10 
Ruling Line Above option, 114 
Ruling lines 

changing, 229 

INDEX - 6 

s 
save 

a chapter, 34, 126 
Save as New Style option, 122 
Scaling 

defined, 60 
screen 

clearing, 36, 105, 123 
scroll 

arrows and bars, 17 
Search and Replace 

automatic, 56 
changing text, 54 
pausing, 56 
tags, 55 
text, 55 

Send to Back option, 101 
Set Preferences option, 31 
Set Ruler option, 87 
shading boxes, 99 
Show Column Guides option, 64, 86, 123 
Show Pictures option, 81 
Show Rulers option, 87 
Show Tabs & Returns option, 42, 85 
sizing and scaling pictures, 67 
Sort Key option, 172 
spacing, 120 

changing spacing measurements, 120, 121 
inter-line settings, 120 

Spell Checker 
using, 49 

starting Ventura Publisher, 12 
STY extension, 8, 122, 123 
style sheet 

applying, 26 
changing within a document, 32 
customizing, 107 
defined, 3, 10 
saving a new, 122 
viewing tags, 130 
working with, 86, 122 
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T 

Table 
defined, 212 

Table of contents, 149 
after generating the, 157 
make TOe, 152 
overwrite, 152 
saving, 156 
tab setting, with dot leaders, 166 
Z tags, 158 

Tables 
adding a column, 222 
changing ruling lines, 229 
changing tag attributes, 219 
creating, 214 
deleting column/row, 225 
dialog box items, 216 
editing, 222 
pasting column, 226 
using, 213 
using mouse, 227 

Tabs 
displaying, 42 
set in ruler, 162 
setting tabs with the ruler, 183 
Tab Settings option, 166 
tab symbol, 42 

Tag 
defined, 10 

Tagging 
defined, 4 
multiple blocks of text (paragraphs), 33 
text, 28 . 

Tags 
assigning to text, 28, 125 
attributes, 108 
changing, 219 
creating a new tag, 112 
defined, 26 

text 
adding, 44 
changing, 54 
copying, 48 
deleting, 43 

moving, 46 
reformatting, 32 
searching and replacing, 54 

text files 
adding attributes to, 4, 38 
defined, 3,40 
editing, 41 
loading, 21 
not displayed on screen, 25 

Title String, index, 176 
Tool buttons, 38 
TXT extension, 8, 86 
Typeface 

defined, 10 
TYPESET directory, 2 
typing cursor, 92 

u 
Undo 

defined, 40 
Undo option, 44 
Using the drawing tools, 85 

v 
Variable insertion 

inserting different name, 208 
using, 201 

Variable references 
inserting cross for position, 204 
inserting definitions, 203 

View menu, 85, 86 
viewing 

tags in style sheets, 130 
VPO extension, 8 
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w [ 

word processing packages, 3 [ 
WYSIWYG, 3 
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Z tags, 158, 180 
zoom control buttons, 33 [ 
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